Information Technology
NVEQF Level 1
Students Handbook
Class IX

CENTRAL BOARD OF SECONDARY EDUCATION
Shiksha Kendra, 2, Community Centre, Preet Vihar, Delhi-110301
भारत का संविधान

उद्देश्य

हम भारत के लोग भारत को एक जीवन, सम्पत्ति, समाज और राजनीतिक न्याय, विचार, संस्कृति, विश्वास, धर्म

और उपासना की स्वतंत्रता,

प्रतिष्ठा और अवसर की समस्त;

प्राचीन काल से ही तथा उन लोगों में या योजना की गरिमा और राष्ट्र की एकता और अखंडता सुनिश्चित करने वाली बंधुता बढ़ाने के लिए दीर्घकालिक होकर अपनी इस संविधान सम्पत्ति में आज तक हृदय 26 नवम्बर, 1949 ई. को एतद्वारा इस संविधान को अंगीकृत, अधिनियमित और आवर्धित करना है।

1. संविधान (न्यायिकाय संरचना) अधिनियम, 1976 की धारा 2 द्वारा (3.1.1977) से “संविधान राष्ट्रकर्तव्य गणतंत्र” के स्थापन पर प्रतिष्ठापित।

2. संविधान (न्यायिकाय संरचना) अधिनियम, 1976 की धारा 2 द्वारा (3.1.1977 से), ”राष्ट्र की एकता” के स्थापन पर प्रतिष्ठापित।

भाग 4 के

gूल कार्यक्रम

51 के. गूल कार्यक्रम – भारत के प्रवृत्तियों का गूल कार्यक्रम होना कि वह –

(४) संविधान का पालन करने और उसके आदर्श, सत्यांग, राष्ट्रवाद और राष्ट्रगृह का आदर करने;

(५) विचारधारा के लिए हमारे राष्ट्रीय आदर्शों को प्रतिष्ठा करने वाले संस्था और उनका आदर करने;

(६) भारत की प्रभुता, एकता और अखंडता की खातरी करने और उसे अभिव्यक्ति रखने;

(७) देश की खातरी करने और आदर्श विश्वास धारण करने पर राष्ट्र के संस्था करने;

(८) भारत के सभी लोगों में समस्तता के साथ मानों भावना का निर्माण करने जो धर्म, मानव और प्रवृत्ति, या जन्म पर आधारित सभी निर्माण से परे हो, ऐसी धारणाओं का त्याग करने जो रितव्य नये समाज के बिरुद्ध हैं;

(९) हमारी सामाजिक संस्कृति की गौरवगाँठी परंपरा का महत्व समझने और उसका परिवर्तन करने;

(१०) प्राकृतिक पर्यावरण की जिसके अत्यंत वन, झील, नदी, और वन जीवन रहे, खातरी करने और उसका संरक्षण करने लिए प्राविष्ट विजय के प्रति दयामान रखने;

(११) बैकाण्ड की दृष्टिकोण, मानववाद और ज्ञानांक तथा सुधार की भावना के प्रवृत्ति करने;

(१२) सार्वजनिक संस्कृति को सुनिश्चित रखने और हिस्सा से दूर रहने;

(१३) व्यवस्थापन के साथ समाधान गतिविधियों के सभी क्षेत्रों में उत्कृष्ट की ओर बढ़ने का सत्ता प्रवाह करने जिससे राष्ट्र निरंतर बढ़ते हुए प्रवाह और उपलब्धि की नई उंचाइयों को छू ले।
THE CONSTITUTION OF INDIA

PREAMBLE

WE, THE PEOPLE OF INDIA, having solemnly resolved to constitute India into a SOVEREIGN SOCIALIST SECULAR DEMOCRATIC REPUBLIC and to secure to all its citizens:

JUSTICE, Social Economic and political;

LIBERTY of thought, expression, belief, faith and worship;

EQUALITY of status and of opportunity; and to promote among them all;

FRATERNITY assuring the dignity of the individual and the [unity and integrity of the Nation];

IN OUR CONSTITUENT ASSEMBLY this twenty-sixth day of November, 1949, do HEREBY ADOPT ENACT AND GIVE TO OURSELVES THIS CONSTITUTION.

1. Subs, by the Constitution (Forty-Second Amendment) Act. 1976, sec. 2, for "Sovereign Democratic Republic (w.e.f. 3.1.1977)

2. Subs, by the Constitution (Forty-Second Amendment) Act. 1976, sec. 2, for "unity of the Nation (w.e.f. 3.1.1977)

THE CONSTITUTION OF INDIA

Chapter IV A

Fundamental Duties

ARTICLE 51A

Fundamental Duties - It shall be the duty of every citizen of India-

(a) to abide by the Constitution and respect its ideals and institutions, the National Flag and the National Anthem;

(b) to cherish and follow the noble ideals which inspired our national struggle for freedom;

(c) to uphold and protect the sovereignty, unity and integrity of India;

(d) to defend the country and render national service when called upon to do so;

(e) to promote harmony and the spirit of common brotherhood amongst all the people of India transcending religious, linguistic and regional or sectional diversities; to renounce practices derogatory to the dignity of women;

(f) to value and preserve the rich heritage of our composite culture;

(g) to protect and improve the natural environment including forests, lakes, rivers, wild life and to have compassion for living creatures;

(h) to develop the scientific temper, humanism and the spirit of inquiry and reform;

(i) to safeguard public property and to abjure violence;

(j) to strive towards excellence in all spheres of individual and collective activity so that the nation constantly rises to higher levels of endeavour and achievement.
The National Curriculum Framework, 2005, recommends that children’s life at school must be linked to their life outside the school. This principle makes a departure from the legacy of bookish learning which continues to shape our system and causes a gap between the school, home, community and the workplace.

The student Handbook on “IT” is a part of the qualification package developed for the implementation of National Vocational Education Qualification Framework (NVEQF), an initiative of Ministry of Human Resource Development (MHRD), Government of India to set common principles and guidelines for a nationally recognized qualification system covering Schools, Vocational Education and Training Institutions, Technical Education Institutions, Colleges and Universities. It is envisaged that the NVEQF will promote transparency of qualifications, cross-sectoral learning, student-centred learning and facilitate learner’s mobility between different qualifications, thus encouraging lifelong learning.

This student handbook, was developed by PSSCIVE Bhopal with the help of group of experts. The IT-ITeS Skill Council approved by the National Skill Development Corporation (NSDC). The National Occupation Standards are a set of competency standards and guidelines endorsed by the representatives of IT Industry for recognizing and assessing skills and knowledge needed to perform effectively in the workplace.

This student handbook attempts to bring about necessary flexibility in offering of courses, necessary for breaking the sharp boundaries between different subject areas. The handbook attempts to enhance these endeavour by giving higher priority and space to opportunities for contemplation and wondering, discussion in small groups and activities requiring hands-on-experience.

Any suggestions, feedback from the readers for improvement in the future editions of the volume shall be heartily welcomed.

Sh. Vineet Joshi, IAS
Chairman, CBSE
Acknowledgements

Advisors
1. Sh. Vineet Joshi, IAS, Chairman, CBSE.
2. Prof. R.B. Shivagunde, Joint Director, PSSCIVE, Bhopal
3. Sh. M.V.V. Prasada Rao, Director (Vocational and Edusat), CBSE.

Editing & Coordination
1. Dr. Biswajit Saha, Additional Director, (Voc. Education) CBSE.
2. Ms. Swati Gupta, Deputy Director, (Voc. Education), CBSE.

Produced by
1. Pandit Sunderlal Sharma Central Institute of Vocational Education, Bhopal
About Your Workbook

This workbook is to assist you with completing the Unit of Competency IT101-NQ2012: Functional English (Basic). You should work through the workbook in the classroom, at the workplace or in your own time under the guidance and supervision of your teacher or trainer.

This workbook contains sessions which will help you to acquire relevant knowledge and skills (soft and hard) on various aspects of the unit of competency. Each session is small enough to be easily tackled and digested by you before you move on to the next session. Animated pictures and photographs have been included to bring about visual appeal and to make the text lively and interactive for you. You can also try to create your own illustrations using your imagination or taking the help of your teacher. Let us now see what the sections in the sessions have for you.

Section 1: Introduction
This section introduces you to the topic of the Unit. It also tells you what you will learn through the various sessions covered in the Unit.

Section 2: Relevant Knowledge
This section provides you with the relevant information on the topic (s) covered in the session. The knowledge developed through this section will enable you to perform certain activities. You should read through the information to develop an understanding on the various aspects of the topic before you complete the exercise (s).

Section 3: Exercise
Each session has exercises, which you should complete on time. You will perform the activities in the classroom, at home or at the workplace. The activities included in this section will help you to develop necessary knowledge, skills and attitude that you need for becoming competent in performing the tasks at workplace. The activities should be done under the supervision of your teacher or trainer who will guide you in completing the tasks and also provide feedback to you for improving your performance. To achieve this, prepare a timetable in consultation with your teacher or trainer and strictly adhere to the stipulated norms or standards. Do not hesitate to ask your teacher or trainer to explain anything that you do not understand.

Section 4: Assessment
The review questions included in this section will help you to check your progress. You must be able to answer all the questions before you proceed to the next session.

At the end of the Unit, there is a list of learning resources which include books, journals, newsletters, websites, etc. to support your further learning.
Contents

Unit 1: Functional English (Basic) ................................................................. 1
   Session 1: Introducing Oneself ................................................................. 2
   Session 2: Greeting Others ................................................................. 4
   Session 3: Talking About One’s Family .............................................. 7
   Session 4: Telling the Time ................................................................. 9
   Session 5: Framing Questions ............................................................. 9
   Session 6: Describing Someone .......................................................... 15
   Session 7: Describing the Weather .................................................. 18
   Session 8: Framing Complete Sentences ....................................... 19
   Session 9: Expressing Likes and Dislikes ......................................... 23
   Session 10: Expressing Strengths and Weaknesses ......................... 26
   Session 11: Talking about Aspirations ........................................... 26
   Session 12: Talking about Values .................................................... 28
   Session 13: Quantifiers .................................................................... 29
   Session 14: Inviting Someone ............................................................ 33
   Session 15: Shopping for Necessities ............................................. 35
   Session 16: Asking the Price ............................................................... 38
   Session 17: Negotiation ................................................................... 41
   Session 18: Confusing Words ............................................................ 45

Unit 2: Fundamentals of Computer ............................................................. 55
   Session 1: Introduction to Computers ............................................. 56
   Session 2: Parts of a Computer System .......................................... 63
   Session 3: Computer Fundamentals ................................................ 66
Session 4: Types of Computers ................................................................. 72
Session 5: Using a Computer ................................................................. 78
Session 6: Computer Operating Systems ............................................. 82
Session 7: Performing Basic File Operations ...................................... 88
Session 8: The Internet ................................................................. 95
Session 9: The World Wide Web ........................................................ 102
Session 10: Digital Technology and Media Devices ..................... 115
Session 11: Computer Security and Privacy .................................... 127

Unit 3: Mastering Typing .................................................................. 157
Session 1: Getting Started with Touch Typing ................................. 158
Session 2: User Experience ......................................................... 162
Session 3: Begin Lessons ............................................................ 163
Session 4: Viewing Statistics ....................................................... 167
Session 5: Working with Lesson Editor .......................................... 169

Unit 4: Word Processing ................................................................. 179
Session 1: Getting Started with a Word Processor ......................... 180
Session 2: Edit and Save a Document ........................................... 183
Session 3: Identify Elements of User Interface .............................. 185
Session 4: Format a Document – Bold, Italics and Underline .......... 188
Session 5: Check Spelling ............................................................. 190
Session 6: Checking Grammar and Using Thesaurus .................... 193
Session 7: Copy - Paste and Cut - Paste ........................................ 197
Session 8: Find and Replace Text ................................................ 199
Session 9: Creat List of Items Using Bullets and Numbering ........ 201
Session 10: Format Font Style ...................................................................................... 203
Session 11: Aligning the Text .................................................................................. 208
Session 12: Views of a Document ........................................................................... 210
Session 13: Print a Document .................................................................................. 212
Session 14: Create a Table ..................................................................................... 214
Session 15: Format a Table ..................................................................................... 216
Session 16: Convert Text to Table and Table to Text ........................................... 219
Session 17: Add Borders to Pages, Paragraphs and Text ....................................... 222
Session 18: Add Shadings to Pages, Paragraphs and Text ....................................... 224
Session 19: Preview a Document, Adjust its Margins and Orientation .................... 226
Session 20: Align Text Using Tabs ........................................................................... 229

Unit 5: Spreadsheet .................................................................................................. 231
Session 1: Introduction to Spreadsheets ................................................................... 232
Session 2: Open, Save and Close Spreadsheet ........................................................ 235
Session 3: Enter Data in Spreadsheet ....................................................................... 238
Session 4: Basic Calculations – Addition ................................................................. 240
Session 5: Basic Calculations – Subtraction .............................................................. 242
Session 6: Basic Calculations – Multiplication .......................................................... 245
Session 7: Basic Calculations – Division ................................................................. 246
Session 8: Insert Column and Row ......................................................................... 248
Session 9: Format Cell and its Contents .................................................................. 250
Session 10: Stock Register ...................................................................................... 256
Session 11: Customizing the Interface ..................................................................... 257
Session 12: Use Currency Symbols ........................................................................ 260
Session 13: Format Cell Contents – Font Style and Size ........................................ 263
Session 14: Delete – Columns and Rows ................................................................. 267
Session 15: Spell Check .......................................................................................... 269
Session 16: Border the Cells .................................................................................. 271
Session 17: Colour the Cells ................................................................................... 273
Session 18: Managing Worksheets in a Workbook .................................................. 275
Session 19: Print a Worksheet ................................................................................. 278

Unit 6: Digital Presentation ...................................................................................... 281
Session 1: Introduction to Digital Presentation .......................................................... 282
Session 2: Create, Save and Close Presentation .......................................................... 287
Session 3: Create a Simple Presentation .................................................................... 290
Session 4: View a Presentation – Slide Show View .................................................... 293
Session 5: Edit Text - Font Size, Style and Colour ..................................................... 295
Session 6: Edit Text in a Presentation ....................................................................... 296
Session 7: Insert Image in a Presentation ................................................................. 297
Session 8: Add Shapes in a Presentation .................................................................... 300
Session 9: Presentation Themes ................................................................................ 304
Session 10: Change Design of a Presentation ............................................................ 306
Session 11: Arrange, Delete and Add Slides ............................................................... 308
Session 12: Print a Presentation ................................................................................. 310

Unit 7: Email Messaging ......................................................................................... 313
Session 1: Introduction to E-mail ............................................................................. 314
Session 2: Creating an E-mail Account with Gmail.com ............................................ 317
Session 3: Creating an E-mail Account with Outlook.com ........................................ 320
Session 4: Link Email Address to Email Application ............................................... 322
Session 5: Writing an Email Message ...................................................................... 325
Session 6: Receive and Respond to Email Messages .......................................................... 327
Session 7: Using Email Ribbon ...................................................................................... 328
Session 8: Format and Spell Check an Email Message ................................................... 330
Session 9: Attach a File to Email Message ..................................................................... 332
Session 10: Using Help .................................................................................................. 335
Session 11: Print Email Message ................................................................................... 339
Session 12: Adding and Modifying a Contact ................................................................. 340
UNIT 1

Functional English (Basic)
SESSION 1: INTRODUCING ONESELF

Relevant Knowledge

Read the following phrases loudly:

1. “I would like to introduce myself. I am...”
2. “Hi/Hello, I am...”
3. “Hi/Hello! My name is...”
4. “Hi/Hello! My name is...but you can call me...”
5. “I live at...”
6. “I am from...”
7. “I am working as a...”
8. “I am a...”
9. “I studied at...”
10. “I am/came here to...”
11. “My hobbies are...”
12. “I like...”

Exercise

Read aloud the following sentences:

1. My name is _______________(include your name). And you are?
2. I am a doctor. I work at Safdarjung Hospital.
3. It is a pleasure to meet you.
4. Her name is Nisha. And the two men she is talking to is Manoj and Rahul.
5. She is a doctor. She works at Safdarjung Hospital.

Read this:

1. I have a dog.
2. Do you have a dog?
3. We have a dog.
4. He has a dog.
Assessment

Fill in the blanks with the correct option.

1. Hi! I ___________ Priya.
   a. is  
   b. am  
   c. are  

2. ___________ am 21 years old.
   a. He  
   b. I  
   c. She  

3. I ___________ in Delhi.
   a. live  
   b. lives  

4. There ___________ six members in my family.
   a. is  
   b. are  
   c. was  

5. My parents ___________ me very much.
   a. loves  
   b. love  

6. My brothers ___________ working.
   a. is  
   b. am  
   c. are  

7. My father ___________ a farmer.
   a. is  
   b. am  
   c. are  

8. My mother ___________ a housewife.
   a. are  
   b. is  
   c. am  

9. I _______________ one sister.
   a. has  
   b. have  
   c. having  

10. She _______________ a student.
    a. is  
    b. am  
    c. are  

SESSON 2: GREETING OTHERS

Relevant Knowledge

Every interaction starts with some form of greeting. The way we greet, the tone and the language changes according to our familiarity with the person being greeted. Given below are some of the statements we generally make whenever we greet someone:

**Greeting a friend**
1. Hello! How are you doing?
2. It has been a long time since we last met!
3. Hello! How are you doing now?
4. How’s life?

**Greeting an acquaintance**
1. Hello! How are you?
2. Hello! How have you been?
3. Good morning/afternoon/evening! All’s well?

**Greeting a stranger**
1. Hello!
2. Good morning/afternoon/evening!
3. How do you do?
4. My name is Aarti. May I know your name?

Look at the following sentences

I greet you every day. You greet me every day. He greets me every day.

We greet you good morning. You all greet us good morning. They greet us good morning.

Do you see any change in the two sets of sentence?

There is a rule which is the reason behind the change:

For any subject (name of a person, place or thing) that is in the third person and singular (Ram, Rita, he, she, it, Delhi, bus, chair, etc), the verb will take an “s” or “es” after it.
Examples
1. Ram meets new people every day.
2. He works as a sales person.
3. Delhi gets rain in the month of July and August.
4. The bus goes to Munirka.
5. The chair makes a noise when you sit on it.

For every other subject - first and second person, singular or plural, and third person plural (Ram and Rita, they, Delhi and Bombay, buses, chairs, etc) - the rule will not apply.

Examples
1. I meet new people every day.
2. We meet new people every day.
3. You meet new people every day.
4. You all meet new people every day.
5. Ram and Rita meet new people every day.

Activity: Role Play

Objective: This activity will be facilitated by your teacher or trainer. At the end of this activity, you will be able to greet friends, neighbours and strangers confidently. The following 3 situations may be used for a role play:

Situation 1: You have met a friend after a long time. The last time you saw him was in school. How would you greet each other?

Situation 2: You meet your local grocer while you are taking your morning walk. You ask him if his shop will be open today.

Situation 3: You see a person come down the stairs of your building. You have not seen him before, but you guess that the person may be your new neighbour. You want to greet him and introduce yourself.

Practice making simple sentences using the Third Person Singular rule. For example:
- I/You take English classes.
- S/he takes English classes.
Assessment

A. Fill in the blanks with the correct option.

1. Hello, Sir! How _____________ you?
   (a) is  (b) are  (c) am

2. One of the best ways to greet a stranger _____________ a simple “Hello!”
   (a) is  (b) are  (c) has

3. Both Meena and Reena _____________ people nicely.
   (a) greets  (b) greet  (c) greeting

4. One of those girls who _____________ at the office said “Hi” to me.
   (a) works  (b) work  (c) working

5. If it is morning, you can _____________ “Good morning” as a form of greeting.
   (a) says  (b) say  (c) saying

6. One of my favourite ways of greeting people _____________ “What’s up?”
   (a) is  (b) are  (c) being

7. The Japanese way of saying goodbye _____________ “Sayonara”.
   (a) is  (b) are  (c) being

8. “Bon jour” _____________ what the French _____________ to greet someone.
   (a) is, says  (b) are, say  (c) is, say

9. No form of greeting _____________ as popular as “Hello!”
   (a) is  (b) are  (c) has

10. Neither Preety nor Kirti _____________ Ritu when they meet her.
    (a) wishes  (b) wish  (c) wishing

B. Tick the correct sentence

1. I wish my neighbour every morning.
2. He wish me back.
3. I ask him how he is doing.
4. He say that he is doing well.
5. Then we goes to the Mother Dairy booth to buy milk.
6. We talk about the day’s news.
7. We walk back and says “bye” to each other.

SESSION 3: TALKING ABOUT ONE’S FAMILY

Relevant Knowledge

Our family is made up of relations and these are some of our relations: Father, Mother, Sister, Brother, Grandfather, Grandmother, Uncle, Aunt, and Cousin.

Exercise

Practice making simple sentences using the third person singular rule. For example:

1. I have a brother and a sister.
2. My parents work at the same office.
3. My grandmother and grandfather live with us.
4. My Aunt teaches at a school.

Assessment

Fill in the blanks with the correct option:

1. Saumya ____________ a Punjabi.
   a. is
   b. are
2. She ____________ in Ambala.
   a. lives
   b. live
3. Her father and her mother ____________ teachers.
   a. is
   b. are
4. Her grandmother _______________ with them.
   a. live           b. lives
5. Her sister _______________ to college
   a. go             b. goes
6. Her brother _______________ a carpenter.
   a. am             b. is
7. He _______________ in Delhi.
   a. work           b. works
8. Saumya _______________ to join the Army.
   a. wants          b. want
9. Her father _______________ in the army for 3 years.
   a. are            b. was
10. Saumya _____________ to her brother every week.
    a. speak          b. speaks
SESSION 4: TELLING THE TIME

Relevant Knowledge
Read and understand:
Quarter to three (2:45) Quarter past two (2:15) Five to four (3:55) Half past four (4:30)
Twenty five to two (1:35).

Exercise
Write the time.

(a) ______________ (b) ______________ (c) ______________
(d) ______________ (e) ______________ (f) ______________

SESSION 5: FRAMING QUESTIONS

Relevant Knowledge
While framing questions, the sentences should begin with the question words (see list of
Question Words) given below:
Examples:

**Which** student was absent yesterday?
**Is** he present today?
Did he bring his leave report today?

Read aloud the following sentences:

1. I am Mina.
2. My name is Mina.
3. I am from Delhi.
4. I am here to meet a friend.
5. I came by bus.
6. Yes, I am an Indian.
7. No, I will not shop with my friend.
8. Yes, I have called her up.

Study the list of “Question Words” given below:

<table>
<thead>
<tr>
<th>Word</th>
<th>Examples</th>
</tr>
</thead>
</table>
| What | 1. What are you doing tonight?  
2. What are we having for dinner? |
| When | 1. When is the match starting?  
2. When are we leaving? |
| Where | 1. Where is my diary?  
2. Where will the World Cup be held this year? |
| Which | 1. Which one is your book?  
2. Which color should we buy? |
| Who | 1. Who is that girl?  
2. Who stole the cell-phone? |
| Whom | 1. With whom did you go to see the movie?  
2. Whom did you meet at the party? |
| Whose | 1. Whose towel is this?  
2. Whose dog is barking this late at night? |
<table>
<thead>
<tr>
<th>Word</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Why</td>
<td>1. Why didn’t you do your homework?</td>
</tr>
<tr>
<td></td>
<td>2. Why are we visiting her?</td>
</tr>
<tr>
<td>Study the list of</td>
<td>1. How are we going to tell him about the situation?</td>
</tr>
<tr>
<td>How</td>
<td>2. How is the book that you are reading?</td>
</tr>
<tr>
<td>Are</td>
<td>1. Are you Akanksha’s sister?</td>
</tr>
<tr>
<td></td>
<td>2. Are you going to see him again?</td>
</tr>
<tr>
<td>Is</td>
<td>1. Is she doing her homework?</td>
</tr>
<tr>
<td></td>
<td>2. Is Manisha ill?</td>
</tr>
<tr>
<td>Am</td>
<td>1. Am I really going to take that chance?</td>
</tr>
<tr>
<td></td>
<td>2. Am I happy?</td>
</tr>
<tr>
<td>Have</td>
<td>1. Have you seen the new movie?</td>
</tr>
<tr>
<td></td>
<td>2. Have I done the right thing?</td>
</tr>
<tr>
<td>Has</td>
<td>1. Has she completed her shift?</td>
</tr>
<tr>
<td></td>
<td>2. Has it started boiling?</td>
</tr>
<tr>
<td>Do</td>
<td>1. Do we need to confirm the time and place?</td>
</tr>
<tr>
<td></td>
<td>2. Do you have to go to the bank today?</td>
</tr>
<tr>
<td>Does</td>
<td>1. Does he ever knock before entering a room?</td>
</tr>
<tr>
<td></td>
<td>2. Does the cat often steal from your kitchen?</td>
</tr>
<tr>
<td>Can/Could</td>
<td>1. Can I go to the mall?</td>
</tr>
<tr>
<td></td>
<td>2. Could you give me that magazine?</td>
</tr>
<tr>
<td></td>
<td>3. Can you play chess?</td>
</tr>
<tr>
<td>Will/ Would</td>
<td>1. Will you be there on my wedding?</td>
</tr>
<tr>
<td></td>
<td>2. Will my book be published?</td>
</tr>
<tr>
<td></td>
<td>3. Would you sing if they ask you to?</td>
</tr>
<tr>
<td>Shall/Should</td>
<td>1. Shall we go now?</td>
</tr>
<tr>
<td></td>
<td>2. Shall I do the job for you?</td>
</tr>
<tr>
<td></td>
<td>3. Should you leave early to reach on time?</td>
</tr>
<tr>
<td>May</td>
<td>1. May I come in?</td>
</tr>
<tr>
<td></td>
<td>2. May I go out for a moment?</td>
</tr>
</tbody>
</table>
Read the following sentences:

1. Oh I am late already...what is the time?
2. Excuse me...can you please tell me the time?
3. Hey! What time does the movie start?
4. When do we have to meet Mr D’Souza?
5. What time is the appointment?
6. When is he going to come?

Questions usually start with words like what, when, how, where, why, is, can, do, did, will, would, could, etc. And that they are always placed at the beginning of the sentence. So we cannot say:

1. The time is like what?
2. You can please tell me the time?
3. The movie starts what time?
4. The appointment is what time?
5. He is going to come when?

If the question pertains to asking for time, they will typically begin with: When... or What time... or Can you tell me...

Read this:

If the question pertains to asking for time, they will typically begin with: When or What time... or Can you tell me... Example:

1. What time is it?
2. Where is the time? X

Exercise

A. Frame a question for the following situations:
   1. You want to ask a person his/her name.
   2. You want to ask a person where he/she lives.
   3. You want to ask what he/she is doing presently.
   4. You want to ask why he/she is here.
5. You want to ask how he/she goes to office.
6. You want to ask when he/she is going back.

B. Identify the errors and correct the questions given below:
1. Can you do the work for me?
2. When do you want this book?
3. I can find the class where?
4. You will meet me at the station?
5. You can get the file?
6. Why are you so sad?
7. You are why so happy?
8. Do you work at the mall?
9. Where do you live?
10. What is the price of the book?
11. You do want some help?
12. Did you see the movie?
13. When did the movie start?
14. You will do me a favour?

Make simple questions using what you have learned and practiced. For example:
1. When do I have to come?
2. What time does the class start?
3. Can you tell me the reporting time for the flight?

Assessment
A. Tick the correct question from the options given below the statement:
1. It is the name of a person.
   a) Is it the name of a person?
   b) The name of a person is it?
2. The person is male.
   a) Is the person male?
   b) The person is male?
3. He is Indian.
   a) Is he Indian?
   b) He is Indian?

4. He is an actor.
   a) An actor he is?
   b) Is he an actor?

5. He is married.
   a) Is he married?
   b) Married he is?

6. He has two children.
   a) How many children does he have?
   b) How many he has children?

7. He has a son and a daughter.
   a) How many sons and daughters does he have?
   b) Sons and daughters how many he has?

8. He lives in Mumbai.
   a) Where does he live?
   b) In Mumbai he lives?

9. He was brought up in Delhi.
   a) He was brought up in Delhi?
   b) Where was he brought up?

B. **Tick the correctly framed question from the option.**

1. a. Is we on time?
   b. Are we on time?

2. a. When is the time by your watch?
   b. What is the time by your watch?
3. a. When does the train leave?
   b. What does the train leave?
4. a. At what time is the meeting?
   b. At when time is the meeting?
5. a. On time are we?
   b. Are we on time?
6. a. Could you tell me the time please?
   b. You could please tell me the time?
7. a. When wake up do you?
   b. When do you wake up?
8. a. Are you come on time?
   b. Will you come on time?
9. a. Is your flight on time?
   b. Your flight is on time?
10. a. When are you planning to leave for Bangalore?
    b. Are you when planning to leave for Bangalore?

SESSION 6: DESCRIBING SOMEONE

Relevant Knowledge
Read aloud the following sentences:
1. Dev Kumar is my favourite film star.
2. He is tall, dark, and handsome.
3. The clothes he wears are so fashionable.
4. His style of dressing very soon sets a trend that all follow.
5. I loved his latest movie Kab Tak.
6. In the movie, he plays the role of a thief superbly.
7. He wears dark clothes when he goes to burgle people’s homes at night.
8. He is almost never caught. He manages to escape every time.
9. Once, hearing some noise, the owner of the house switches on the lights.
10. Dev Kumar quickly puts on his ghost mask and the owner gets so scared that he jumps off the balcony!
11. Then Dev Kumar silently leaves the place but not without his booty.

An adjective describes a noun - a person, thing or place.

Example: Delhi is very hot in summer. (describing noun summer)
An adverb describes an adjective, a verb, or another adverb.

Example: Delhi is very hot in summer. (describing adjective hot)
The temperature quickly rises to over 40°C. (describing verb rises)
It almost never comes below 40°C in the month of June. (describing the adverb never)

Adjectives describe a noun/ pronoun:
1. This tea is sweet.
2. I am angry right now.

In the above sentences, the words “sweet” and “angry” describe the noun “tea” and the pronoun “I” respectively. Therefore, the words “sweet” and “angry” are adjectives. More examples are given below:
1. It looks like we have a clear sky today.
2. She looks happy, doesn’t she?

Adverbs describe adjectives, verbs, or other adverbs.
1. This tea is very sweet.
2. She gets angry quickly.
3. He was smiling rather sadly.

In the first example, the adverb “very” describes the adjective “sweet”. In the second example, the adverb “quickly” describes the verb “gets”. In the third example, the adverb “rather” describes the adverb “sadly”.
More examples are given below:
1. She is so excited about the party.
2. We arranged the place nicely.
3. Spring gets over too soon.

**Assessment**

Read the passage and identify whether the words in bold are adjectives or adverbs.

There is this girl called Helen in our class. If you want to know how she looks, then here are the details: she is quite tall, she has dark skin, and her hair is long and shiny. Oh! She also has dimples (which we don’t get to see often as she doesn’t smile much!).

She doesn’t talk much or take an active part in any group programs. No wonder why she stays alone most of the time. But she looks very nice when she smiles. As I have already said, she has dimples which we don’t see often (as she doesn’t smile much). I think it was the smile that made me strong enough to talk to her one day.

“Hey Helen!” I said to her (I was really afraid she might not want to talk to me).

“Hi!” said Helen.

“Would you like to have lunch with me?”

“That’s nice of you. But I do not eat meat. I hope you haven’t brought meat?” “Uh...yes... sorry!”

So, now I have one more thing to tell you about Helen. She is a vegetarian.

Write whether the words give below (as used in the passage) are adjectives or adverbs:

1. Quite ____________________________________
2. Tall ____________________________________
3. Dark ____________________________________
4. Long ____________________________________
5. Shiny ____________________________________
6. Much ____________________________________
SESSION 7: DESCRIBING THE WEATHER

Relevant Knowledge

Read and understand the following sentences:

1. It is very hot today.
2. It is very cold today.
3. It is raining today.
4. Today the weather is pleasant - it is neither too hot nor too cold.

Read aloud the weather and climate descriptions given below:

<table>
<thead>
<tr>
<th>Day’s Weather</th>
<th>City’s climate</th>
</tr>
</thead>
<tbody>
<tr>
<td>It is quite cold today.</td>
<td>It is very hot in summers.</td>
</tr>
<tr>
<td>It is very chilly today.</td>
<td>It is very cold in winters.</td>
</tr>
<tr>
<td>It is so hot today.</td>
<td>It gets very less rainfall.</td>
</tr>
<tr>
<td>It is quite warm today.</td>
<td>It gets a lot of rain in the monsoon season.</td>
</tr>
<tr>
<td>It seems it is going to rain.</td>
<td>It is neither too hot nor too cold.</td>
</tr>
</tbody>
</table>
Day’s Weather | City’s climate
---|---
What a downpour! | It is very cold in winters but pleasant in summers.
Haven’t seen such rains for quite some time. | It is very hot in summers but cool in winters.
We are going to have a shower. | It rains almost throughout the year.
It is very pleasant today. | It is very hot during the day but cooler at nights.
It is neither too cold nor too hot. | It is hot and humid in summer.
The skies look clear. No chances of rain. | It is hot and dry in summer.
Lovely day, isn’t it? |  
Looks like it isn’t going to stop raining today! |  
I think the skies are going to clear up later. |  

**SESSION 8: FRAMING COMPLETE SENTENCES**
Read the conversation given below:

A: Hi! How are you doing? B: I am fine...what’s up?
A: Nothing new. I was just going across to the shop to get a magazine. I am going to stay indoors and read all day today. B: Yeah...I know. It is too hot to go out to play.
A: But you know, I think it is going to rain later in the day...do you see the dark clouds?
B: That would indeed be a welcome relief.
A: Yes, a cool shower would be great!
B: As it is so hot, why don’t we go for a swim today?
A: Mmm...it may rain in the evening...how about a dance in the rain instead?

A complete sentence should have a subject and a verb; otherwise, it is just a fragment of a sentence.
Information Technology – Class IX

Read the following sentences:

- Is a cold day.
  ("Is a cold day" does not have the subject "/t"). The complete sentence would be "It is a cold day".
- The sky clear.
  ("The sky clear" does not have the verb ";'s"). The complete sentence would be "The sky is clear".

You can also mention that typically, a sentence in English has the order SVO (Subject - Verb - Object). For example: The rain (subject) brought (verb) welcome relief from the heat (object).

Exercise

Correct these simple sentences using what you have learnt.

1. It was freezing cold yesterday.
2. Going to rain very soon.
3. It is so hot and humid.
4. The rain has only increased the humidity.
5. A nice breeze blowing.
6. Lovely weather this.

Relevant Knowledge

A complete sentence is one that has a subject and a verb. For example, the sentence “I a good dancer” is not a complete sentence as it does not have a verb. Now, if we added the verb “am” to this sentence, it would be complete: I am a good dancer.

Similarly, the sentence “Am a good dancer” is not complete as a subject is missing. Therefore, we should add a subject to complete the fragment. For example:

I am a good dancer.

Examples:

We have an English class today. I go to office every weekday. She likes oranges.
Every sentence must have a subject, a verb and although it is not necessary, an object. And the sentence must make complete sense. For example,

1. I eat: Subject + Verb
2. I eat vegetables: Subject + Verb + Object

In order for a sentence to be meaningful, a sentence must have its parts in the above orders. For example:

1. I eat vegetables - is a sentence
2. I vegetables eat - is not a sentence
3. I like dancing.
4. I am here.
5. You go to school.
6. She has a nice smile.

**Exercise**

Tick the sentences that are meaningful and correct:

1. I very happy.
2. She is very happy.
3. He goes to school.
4. He does not go to school.
5. I oranges like.
6. Oranges I like
7. She and Meeta to theatre.
8. Meeta is going to the theatre.
9. You do your homework well.
10. Do your homework well.
11. I dancing like.
12. I here am.
13. You go school to.
14. She has a smile nice.
Assessment

Tick the option which is a complete sentence.

1. (a) Today a fine day.
   (b) Today is a fine day.
   (c) A fine day.
2. (a) It is bright and sunny.
   (b) It bright and sunny.
   (c) It bright sunny
3. (a) It rained yesterday.
   (b) It raining yesterday.
   (c) Yesterday it raining.
4. (a) It was very cold.
   (b) It very cold.
   (c) It cold
5. (a) It is not cold today.
   (b) It not cold today.
   (c) It cold not today
6. (a) We on a picnic today.
   (b) We could go on a picnic today.
   (c) Could go on a picnic today.
7. (a) The sky seems clear and bright.
   (b) The sky clear and bright.
   (c) The seems clear and bright
8. (a) Thank God it is not raining.
   (b) Thank God it not raining.
   (c) Thank it raining not
9. (a) Should we umbrellas just in case it rains?
   (b) Should take umbrellas just in case it rains?
   (c) Should we take umbrellas just in case it rains?
10. (a) It will not rain today.
(b) It not will rain today.
(c) It not rain today

11. (a) I am person hardworking.
(b) I am a hardworking person.
(c) I hardworking.

12. (a) I am not lazy.
(b) I lazy am not.
(c) I not am lazy.

13. (a) I work team in well.
(b) I work well in a team.
(c) I team work well.

14. (a) I have good skills communication.
(b) I good communication skills.
(c) I have good communication skills.

15. (a) I don’t give up easily.
(b) I don’t give easily up.
(c) I give up easily don’t.

16. (a) I get angry quickly.
(b) I quickly angry get.
(c) I angry get quickly.

SESSION 9: EXPRESSING LIKES AND DISLIKES

Relevant Knowledge
Understand the meaning of words like “favourite”, “pastime”, “hobby”, “passion”, “passionate” and “fond” with the help of the following table.
Read aloud the following sentences:

1. Premchand is my favourite writer.
2. His novel, Gaban, is my favourite book.
3. I like the ghazals of Ustaad Amir Ali. The ghazal he sang in the movie Leela is my favourite.
4. The bookstore near my house is my favourite haunt. I always go there when I have the time to spare. Browsing through books is my favourite pastime.
5. Pizza is an all-time favourite snack. I can have it anytime, anywhere.
6. Tea is my favourite beverage. There is nothing like a hot cup of tea in winters and iced tea with lime in summers.
7. White is my favourite color. Whenever I shop for clothes, I invariably select ones that are white.

**Exercise**

Find out the meanings of the words and write in the space given below:

1. Unique
2. Pet
3. Preferred
4. Choice
5. Favoured

---

**Table**

<table>
<thead>
<tr>
<th>Word</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Favourite</td>
<td>most liked</td>
</tr>
<tr>
<td>Pastime</td>
<td>a pleasurable means of passing the time</td>
</tr>
<tr>
<td>Hobby</td>
<td>an activity for enjoyment</td>
</tr>
<tr>
<td>Passion</td>
<td>a strong liking for something. An object of strong liking and enthusiasm</td>
</tr>
<tr>
<td>Passionate</td>
<td>having a strong liking for</td>
</tr>
<tr>
<td>Fond</td>
<td>having a strong liking for</td>
</tr>
</tbody>
</table>
Assessment
A. Complete the sentences.
1. I like ___________________.
2. is my favourite pastime / my favourite pastime is ___________________.
3. My hobby is ___________________ / My hobbies are ___________________.
4. I am passionate about ___________________.
5. ___________________ is my passion.
6. I have a passion for ___________________.
7. I _________________ for a hobby.
8. I enjoy ___________________.
9. I am fond of ___________________.
10. I do not like ___________________ / I dislike ___________________ / I am _________________
     not fond of ___________________.
11. I like listening to music because ___________________.
12. The kind of music I like is ___________________.
13. But I do not like music which is ___________________.
14. My favourite songs are ___________________.
15. My favourite singers’are ___________________.
16. I like watching movies because ___________________.
17. I like to watch movies which ___________________.

B. Fill in the blanks:
1. I _________________ drinking tea. (like, liking)
2. She _________________ a passion for reading. (has, having)
3. Of all the sports that I (enjoy, enjoying) watching, hockey _________________ the best. (is, being)
4. I _________________ a cricket fan. (are not, am not)
SESSION 10: EXPRESSING STRENGTHS AND WEAKNESSES

A person’s strength is someone or something which gives the person support and encouragement. For example:

“My strength is my patience/willingness to listen to others’ opinions/etc.” A person’s weakness is an imperfect quality that he has. For example: “My weakness is my laziness/inability to forgive easily.”

Exercise

Think of at least of one strength and one weakness that you have and write them in the space given below:

Assessment

Fill in the blanks:

1. My strength is my ________________ .
2. My ________________ is my strength.
3. One of my biggest strengths is my ________________ .
4. My greatest strength is my ________________ .
5. My strengths are my ________________ , my ________________ , and my ________________ .
6. My ________________ , my ________________ , and my ________________ are my strengths.
7. My weakness is my ________________ .
8. My ________________ is my weakness.

SESSION 11: TALKING ABOUT ASPIRATIONS

Relevant Knowledge

An aspiration is something you wish to achieve.
Exercise

Fill in the sentences below stating what aspire to do in life, and, then read them out aloud.

1. I want to...
2. I wish to...
3. I dream of...
4. I would like to...
5. What I really want to do is...
6. I aim for...
7. My ambition is to...
8. What I aspire for is...
9. My aspiration in life is...
10. I aspire to...

Note that the “-ing” form denotes a thing - What is the thing that you dream of? For example: I dream of earning well and living well. On the other hand, the “to -” form denotes action - What do you want to do? For example: I want to earn well and live well.

Some sentences may appear to speak about a future time but they do not denote a future action. For example, the sentences, I aspire to be the best singer in the next Indian Idol contest, or, I hope to do well in my exams tomorrow, are not in the future tense. The action is in the present - I aspire, and, I hope.

Tick the sentences that denote a future action

1. I will try to complete my education and get a good job.
2. I will try to do a IT course as IT is the fastest growing industry.
3. I hope to do well in my exams tomorrow.
4. I want to be happy in life, doing whatever.
5. I should be able to enjoy the work that I am doing - that is the most important thing for me.
6. I aspire to be the best singer in the next Indian Idol contest.
7. I shall be rich and famous by the time I turn 30.
SESSION 12: TALKING ABOUT VALUES

Relevant Knowledge

Your values are your personal inventory of what you consider most important in life.

Your list of values could include the following:

1. Honesty
2. Helpfulness
3. Sincerity
4. Loyalty
5. Respect for work
6. Respect for others

Assessment

Read the following and fill in the blanks.

1. I believe in ________________.
2. The value I cherish the most is ________________.
3. I have grown up w’th the values of ________________.
4. My parents have taught me the values of ________________.
5. I think and are the values that should be present in every individual.
6. It is good to be guided by the values of ________________ and ________________ in one’s life.

TIME

# A C T

work ethics
SESSION 13: QUANTIFIERS

Relevant Knowledge
Quantifiers are words or phrases used before a noun to indicate the amount or quantity. Quantifiers are used depending upon whether the noun is countable or uncountable. Words such as Many, Much, Some, Few, a lot of, etc. are called quantifiers.

Some things can be counted. For example, a kilo of rice, number of houses, etc. However, qualities or values cannot be counted just as many other things such as water, milk, gas, etc.

Countable Nouns
Countable nouns have singular and plural forms. In plural, these nouns can be used with a number i.e., they can be counted. And that is why they are called as countable nouns.

Examples:
many, few/a few, a lot of, several, none
I kept some/many/a few/a very few/a number of/a lot of/several oranges in the basket.
None of the oranges in the basket were ripe.

Uncountable nouns
Uncountable nouns can only be used in singular form. These nouns cannot be used with a number i.e., they cannot be counted.

Examples:
much, little/a little, very little, bit of, a lot of, a great deal of, a large amount of, a large quantity of.

Read the following examples:
1. My grandfather is a farmer. Last winter, I ate a lot of apples from my grandfather’s orchard. (apples is countable)
2. My grandfather has some very good qualities, such as honesty and sincerity. (good qualities is countable as you can count the number of good qualities. In this case, it is two - honesty and sincerity)
3. The whole family loves and respects my grandfather. He gets *much* respect from other farmers in the area too. (*respect* is uncountable)

4. We need to add *some/a little/a lot of* sugar.

5. How much sugar should we add?

**Adjectives for countable and uncountable nouns**

**Much / Many**

We use much with uncountable nouns.

Example: How *much* more time is left for the show to get over?

She has so *much work* to complete before the weekend.

*Many* is used with countable nouns.

**Example:** How *many* clothes will fill this suitcase?

There are *many children* in the park. **A lot of / lots of**

**A lot of** is used with countable nouns. Example: There is a lot of money in the bank.

**Lots of** is used with uncountable nouns. Example: I want to drink lots of *water*.

There are lots of flies in this room.

**Little, quite a little, few, quite a few**

Little and quite a little modify only uncountable nouns.

**Example:** There is *little room* for you in the bus. (Meaning hardly any space)

There is quite a little space left for you to fit in. (Meaning plenty of space)

**Few** and *quite a few* are used with countable nouns.

**Example:** There are a few coins in her piggy bank. (Meaning very less)

There are *quite a few coins* in her piggy bank. (Meaning many) **A little bit of, quite a bit of.**

Both these phrases are used with uncountable nouns.

**Example:** We mix a *little bit of yellow* with *red* to make orange. (Meaning less)

There is *quite a bit of salt* in the mutton. (Meaning much) **Fewer / Less**
**Fewer** is used with countable nouns.  
**Example:** Fewer **people** can be seen traveling in buses.

Drink **fewer glasses** of alcohol. **Less** is used with uncountable nouns. There is less **water** in this bottle.

One should take less **sugar**.

However, there is an exception to this rule. When less is used in terms like “no less than” or “or less”, it is used with countable nouns. His lesson had **no less than ten red marks** on it. State your reasons in **25 words or less**.

Also, we use **less than** for a countable noun that denotes a measure of time, amount, or distance.  

**Less than** three months; less than **50 km**; less than **Rs 100**

**Enough, plenty of, some, any, and no** are used with both countable and uncountable nouns.

There is **enough content** in the book. There are **enough pages** in the note book. There is **plenty of food** in the kitchen. There are **plenty of trees** in the orchard.

We have **some money** kept at home. We have **some bottles** in the fridge.

Are there **any good shoes** in the shop? Is there **any water** in the well?

There is **no time** left.

There are **no ducks** in the pond.

**Assessment**

Choose the correct option and fill in the blanks:

1. ___________ people may value money but I value love more. (Some, Little)
2. I believe ___________ things in this life are as priceless as a true friend. (none, few)
3. A ___________ kindness can do a lot for those who need it. (little, few)
4. There are ______________ things which we do not need in life but we still go after. (much, many)

5. ______________ people make the mistake of thinking only wealth can bring happiness. (A lot of, Much)

6. Fame, beauty, money - ______________ of them can fool the wise into chasing them. (any, none)

7. Sharing a laugh with friends is a ______________ better way of dealing with sadness than crying. (little, much)

8. Love, kindness, generosity - ______________ of them is worth more than jewels or gold. (a lot of, any)

9. I believe that ______________ of the hatred in this world is caused by lack of respect. (many, much)

10. ______________ (Any, Few) of us are ready to say “Sorry” but ______________ of us always demand it from others. (many, much)
SESSION 14: INVITING SOMEONE

Relevant Knowledge
Read the sentences given below aloud, with the right intonation (modulation of voice):

1. Do you want to come to my party tonight?
2. I have a party tonight. You can come.
3. Come to my party tonight.
4. I am inviting you to come to my party tonight.
5. There is a party at my place tonight. Why don’t you come?
6. There is a party at my place tonight. I would like you to come.
7. Would you like to come to my party tonight?
8. I have a party tonight. I would love it if you could come.

Did you notice any difference in tone between the first four examples and the last four?

In all the sentences given above, the speaker is inviting someone to his party that night. However, examples 1-4 are hardly used by people as they sound very casual and even rude (example 3). Examples 5-8, on the other hand, are polite ways of inviting people and so are preferable.

Read aloud the following sentences:
1. Would you like to come to the party?
2. Why don’t you come to the party?
3. It would be nice/great if you come to my wedding.
4. I would be happy if you come to my wedding.
5. I would love it if you come to my wedding.
6. I would like to invite you to my wedding/party/...

Inviting someone to go somewhere with you:
1. We are going to the movie/mall/... today. Would you like to come?
2. Would you like to go to the movies/mall/... with us?
3. We are going to the movie/mall/... Do you want to come?
Inviting someone to join you in something:
1. We are having lunch at the hotel. Would you like to join us?
2. Would you like to join us for lunch?

Exercise
Study the conversation snippets A, B, C and D given below:

Snippet A: Invitation to a birthday party
Student 1: It’s my birthday today.
Student 2: Really? Happy Birthday!
Student 1: Thanks. Actually, I am having a birthday party at my place this afternoon and I would like to invite you.
Student 2: Sounds great! I would love to come. Student 1: Thanks. I will see you then.

Snippet B: Invitation to an engagement
Student 1: I am getting engaged!
Student 2: That’s great news! When?
Student 1: On the 15th of this month. Why don’t you come to the party?
Student 2: Of course, I will come.

Snippet C: Invitation to a picnic
Student 1: Hey, are you free this Sunday?
Student 2: Yes. Why?
Student 1: We are planning to go on a picnic to Deer Park. Would you like to join us?
Student 2: Definitely!

Snippet D: Invitation to a show
Student 1: Do you have any plans for this Saturday?
Student 2: Not at the moment. Why?
Student 1: I have two tickets for a play. Would you like to come?
Student 2: Oh! I would love to. Thanks!
SESSION 15: SHOPPING FOR NECESSITIES

Relevant Knowledge

Whenever we shop for items, there is a conversation exchange. In this session, you will learn to speak some standard sentences used to shop for necessities. Read out aloud the following sentences:

1. I want a litre of full-cream milk. Do you have Amul Gold or Mother Dairy?
2. Do you have Kissan jam? I want a 500 gm bottle.
3. Can you weigh me a kilo of potatoes?
4. I want a packet of Harvest Gold brown bread.
5. Do you have Britannia cheese slices?
6. I want a litre each of Sundrop sunflower oil and Dhara mustard oil.
7. I want a dozen bananas? Are these fresh?
8. I want a 10 kilo packet of Shakti Bhog Atta.

Read the following sentences:

1. Ram buys bread and milk daily.
2. Bread and milk is bought by Ram daily.
1. The shop stocks fresh fruits and vegetables.
2. Fresh fruits and vegetables are stocked by the shop.
1. My brother owns the garment shop in the locality.
2. The garment shop in the locality is run by my brother.

Do you notice any difference between the two sets of sentences? In these sentences, the subject and the object have changed places.

The subject is the person or thing that the sentence talks about.
The object is the person or thing that is affected by the action of the verb.

So, in the first sentence, Ram (subject) becomes the object in the second sentence, and the object of the first sentence (bread and milk) becomes the subject of the second sentence.

The first sentences are more direct expressions, and the second sentences, with the “-by-” construction, are indirect expressions of the same thing.

Therefore, generally, the first type of sentence construction is preferred. For example:

1. Sita gave a book to Geeta to read.
2. Geeta was given a book to be read by Sita.
3. Ravi paid the hospital bills.
4. The hospital bill was paid by Ravi.
5. The gardener has watered the plants.
6. The plants have been watered by the gardener.

To summarize:
In sentences which are in the Active Voice, the action expressed in the verb is performed by the subject. For example:

I cooked the meal. He watered the plants.
Meenu sang the song.

In sentences which are in the Passive Voice, the action expressed in the verb is received by the subject. For example:

The meal was cooked by me.
The plants were watered by him.
The song was sung by Meenu.
Exercise
Now change the subject-object places in the following sentences:
1. The teacher greeted the class.
2. Ritu read out a paragraph from the book.
3. My mother makes the best dosas.
4. This chair makes a lot of noise.
5. Smita gave some money to the child.

Assessment
Change the following sentences into Active/Passive Voice as directed. The first two have been done for you.
1. I bought the eggs from Mandeep’s store.
   \[\text{Passive Voice: } \text{The eggs were bought by me from Mandeep’s store.}\]
2. Twenty rupees was charged by Mandeep for the eggs.
   \[\text{Active Voice: } \text{Mandeep charged twenty rupees for the eggs.}\]
3. We sell only refined sugar.
   \[\text{Passive Voice: } \text{_____________________________________________________}\]
4. I was asked by my parents to choose anything from the mall for my birthday.
   \[\text{Active Voice: } \text{_____________________________________________________}\]
5. At the mall, the salesman showed me a lot of pretty dresses.
   \[\text{Passive Voice: } \text{_____________________________________________________}\]
6. I was given a discount on the blue dress.
   \[\text{Active Voice: } \text{He } \text{_____________________________________________________}\]
7. Ramu’s son sells potter ware at Kamla Nagar market.
   \[\text{Passive Voice: } \text{_____________________________________________________}\]
8. Around ten to twelve pots are sold by him every week.
   \[\text{Active Voice: } \text{_____________________________________________________}\]
9. The woman asked him to show her some big pots.

   \textit{Passive Voice}: \underline{The big pots were shown to her by him.}

10. Three pots were finally bought by the woman.

   \textit{Active Voice}: \underline{He showed her some big pots.}

\textbf{SESSION 16: ASKING THE PRICE}

\textbf{Relevant Knowledge}

How would you ask the price of the book? \textit{“Excuse me, how much does that book cost?”}

How would you find out the price of some articles that are used daily?.

Let’s understand the correct usage of the articles \textbf{a}, \textbf{an}, and \textbf{the}.

- \textbf{A} - Before singular nouns beginning with a consonant sound

  Examples: a woman, a bag, a united country, a doctor, a teacher, a horse, a university, a useful item etc.

- \textbf{An} - Before singular nouns beginning with a vowel sound

  Examples: an Indian, an airplane, an open door, an egg, an upper floor, an honest boy, an enemy, an umbrella, an heir, an hour, an inkstand, an ice cream etc.

- \textbf{The} - Before particular nouns

  Examples: the girl who has long hair, the man in the car, the dog that barked at you, etc.

1. The book I wanted is out of print.
2. I like the novel you gave me.
3. Let us go to the park for a walk.
4. Before uncountable nouns
More Examples:
1. The banyan is a kind of fig tree (Note: do not say a kind of a fig tree!).
2. The cow is a domestic animal. (Can also say - A cow is a domestic animal - What is the difference between the two?)
3. The Himalayas lie to the North of India.
4. The Mr. Chauhan you met yesterday is my uncle.

Exercise
Study the following conversation snippets and complete them: Asking the Price A
1. Customer: Excuse me, _________________ for a kilo of potatoes?
2. Shopkeeper: 10 Rupees.
3. Customer: And _________________ those mushrooms _________________ ?
4. Shopkeeper: 20 Rupees per packet.
5. Customer: And _________________ of half a kilo of paneer?
7. Customer: Ok. I will take them. _________________ for all of them?
8. Shopkeeper: You will have to pay 90 Rupees.

Asking the Price B
1. Customer: _________________ of that shirt?
2. Shopkeeper: The price of that shirt is 240 Rupees.
3. Customer: Do you have any socks?
4. Shopkeeper: Yes. Here they are.
5. Customer: _________________ that black pair _________________ ?
7. Customer: And _________________ for that packet of handkerchiefs?
9. Customer: _________________ for all of them?
10. Shopkeeper: You will have to pay 345 Rupees.
Assessment

A. Fill in the blanks with the appropriate article:
1. Could you tell me the price of ______________ blue dinner set over there? (the)
2. How much does ______________ oven cost? (an)
3. What is the price of ______________ liter of mustard oil? (a)
4. How much do I have to pay for ______________ kilo of onions? (a)
5. How much are you charging for ______________ brand new plasma-screen TV at the back? (the)
6. I want to buy ______________ deodorant. How much does the one by Fa cost? (a, the)
7. I want to buy ______________ potatoes. How much does ______________ kilo cost? (no article needed, a)

B. Fill in the blanks with the correct articles “a”, “an”, or “the”.
1. How much does ______________ automatic camera cost?
2. I always buy my clothes from ______________ market near my house.
3. I bought this phone in exchange offer last week.
4. How much will I have to pay for ______________ second-hand bike?
5. What is price of this book?
6. I want to eat ______________ orange. How much will I have to pay for one?
7. How much will I have to spend to reach Kingsway Camp from India Gate in ______________ auto rickshaw?
8. This is ______________ very pretty dress. But it must be very costly.
9. How much does ______________ dozen bananas cost?
10. This watch is very expensive. Could you show me ______________ cheaper one?
C. Fill in the blanks with any item of your choice.

1. How much do you charge for ________________?
2. What is the price of ________________?
3. How much does ________________ cost?
4. How much will I have to pay for ________________?
5. Could you tell me the price of ________________?

SESSION 17: NEGOTIATION

Relevant Knowledge

What does a negotiation entail (meaning - involve)? It means “finding the middle ground” - to arrange or settle something by discussion and mutual agreement.

Study the table given below:

<table>
<thead>
<tr>
<th>To agree on a point</th>
<th>To disagree on a point</th>
</tr>
</thead>
<tbody>
<tr>
<td>§E2 C$ €3</td>
<td>€55 £2$ €35 €31</td>
</tr>
<tr>
<td>C25 &lt;S5 C2?</td>
<td>SALE C23</td>
</tr>
<tr>
<td>I agree with you on that point.</td>
<td>I understand your point. However...</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------</td>
</tr>
<tr>
<td>That’s a fair suggestion.</td>
<td>I am prepared to compromise, but...</td>
</tr>
<tr>
<td>So what you are saying is that you...</td>
<td>If you look at it from my point of view...</td>
</tr>
<tr>
<td>In other words, you feel that...</td>
<td>Well, I think of it differently.</td>
</tr>
<tr>
<td>You have a strong point there.</td>
<td>I am afraid this is not going to work for me.</td>
</tr>
<tr>
<td>I think we can both agree that...</td>
<td>I think we could also look at it this way...</td>
</tr>
<tr>
<td>I don’t see any problem with that/harm in that...</td>
<td>I have to disagree with you there.</td>
</tr>
</tbody>
</table>

The sentences in the first column are used to agree to what the other person is saying during a negotiation. The sentences in the second column are used to disagree or state a different point of view during a negotiation.

Notice the usage of these sentences in the dialogue between a manager and a worker on negotiating a raise in salary.

**Negotiating a Raise in Salary**

**Manager:** Hi Ajay! You wanted to meet me?

**Ajay:** Yes Sir. There is something important that I want to discuss with you. **Manager:** Ok...what is it about?

**Ajay:** Sir I wish to discuss my salary...I would like a raise.

**Manager:** A raise!...Don’t you know the state of the economy?...you should feel lucky that you have a job!

**Ajay:** I am aware of that Sir, but I also know that some companies are hiring in this sector. I have made a few calls and what they are offering is certainly much more than what I get here.

**Manager:** But I thought you were happy with us, Ajay. You know that we offer many facilities and incentives to our employees.

**Ajay:** I agree on that...but if you look at the rising cost of living, you will see that my
salary over the last 2 years has effectively remained the same.

**Manager:** You have a strong point there, Ajay. In other words you feel that you are underpaid.

**Ajay:** Yes, I am afraid so.

**Manager:** I can understand your problem, Ajay. But you also know that for in the past year we have hardly made any profits and the coming year does not look very bright either.

**Ajay:** Yes I know Sir. I am prepared to compromise. I am not asking for what other companies in this sector are offering. But I do expect a salary revision. Anything less than that is not going to work for me.

**Manager:** Ok...Let me see what I can do for you. Shall we meet again after two days to discuss this?

**Ajay:** Yes Sir™ I will expect your call. Thank you for considering my case.

Notice how the use of these sentences helps both contenders in the negotiation to present their case and forward their interest.

Some examples of phrases used while negotiating on different occasions:

1. This is too costly.
2. Can you give me a discount?
3. That is not possible.
4. Look at the quality of the paper. It is the best quality.
5. I know but...
6. I am buying a large number of cards...
7. Okay, let me see...
8. That is the maximum discount I can give you.
9. Is that your last price...
10. Ok, let us settle for...

**Exercise**

Try to answer the following questions based on the dialogue above:
1. Whom did Ajay approach?
2. What did Ajay want to talk about?
3. Why was the Manager surprised when he heard what Ajay had to say?
4. What had the Manager thought about Ajay?
5. Did the Manager understand Ajay’s problem?
6. What “compromise” was Ajay willing to make?

We all can easily understand what is clearly stated in the passage. However, comprehension is the ability to “read between the lines” or understand what is implied in the passage but not explicitly stated. For example:

1. Select the correct option:
   a. The Manager was angry at Ajay.
   b. The Manager was surprised.
   c. The Manager disagreed with Ajay.

2. Select the correct option:
   a. Ajay knew he had a strong case, so he spoke with conviction
   b. Ajay knew he was asking too much, given the uncertain economic climate
   c. Ajay knew he had a strong case, but was unsure of his success at negotiating the raise

3. When Ajay says that he has made a few calls to other companies to know the salary they are offering, does it mean that he may leave and join some other company if he is not given a raise? Answer in “Yes” or “No”.

Assessment

Read the following passage and answer the questions given below.

Negotiation is a tricky art that not many find easy to do. The important thing to keep in mind is that you have to listen to what the other person is saying. You cannot go on talking about what you want or what you think. The other person may have a point of view that you need not take note of too.
The other important point is that you should never disagree strongly or deny any point completely. For example, you should not say: I think you are wrong. Instead you should say: I see your point. However, I also think that...

So the ideal negotiation would be a situation where both parties feel that they have been heard and some of their demands have been met. Of course, if you feel that the other person is making a completely unreasonable demand, you could just walk away!

1. What do you think the line “Negotiation is a tricky art...” mean?
   a) It is difficult
   b) It is complicated
   c) It is easy

2. What is the first important point about negotiation that one has to keep in mind?
   a) You have to listen to what the other person is saying.
   b) You should first talk about what you want or what you think.
   c) You should first let the other person tell you what s/he wants.

3. What is the second important point about negotiation that one has to keep in mind?
   a) You should strongly deny what the other person is saying.
   b) You should completely agree with what the other person is saying.
   c) You should show that you understand what the other person is saying, but you have your own point of view too.

4. What does the line “…you could just walk away!” mean?
   a) You could ask the other person to take a walk with you.
   b) You could drop the negotiation.
   c) You could walk to another place to negotiate.

SESSION 18: CONFUSING WORDS

In English, a lot of words can be confusing because they look or sound similar but have different meanings.
A. Same Spelling, Same Sound, Different Meanings

Many words in English can have two (or sometimes even more) meanings that are not related to one another. They are called homonyms. Consider the following two sentences:

1. Yuvraj could not find a place to park his car; so he did not go to the mall.
2. Gautam and Yuvraj were taking a walk in the park when Preeti met them.

In the first sentence, the word park means “to leave a vehicle for some time at a certain location” while in the second sentence, it means “playground or recreational area”.

Here are some more examples:

1. (a) I’ve been working continuously for the last six months; I need a break.
   (b) He was worried that the children might break the glass; so he asked them to play elsewhere.
2. (a) You can see the most beautiful view of the river from this spot. (b) The dirty spot has spoilt the beauty of the cut-glass mirror.
3. (a) Priya was looking gorgeous in a pink top and black skirt.
   (b) When asked about the latest scam, authorities prefer to skirt the issue rather than answer questions.
4. (a) The investigation seemed to be leading nowhere, so the investigators decided to review the case from a different angle.
   (b) The Leaning Tower of Pisa leans at an angle of 3.97 degrees.
5. (a) The red Maruti Swift parked near the cafe is mine.
   (b) Apart from being one of the largest manufacturers of steel in the world, the Gupta family also owns a gold mine in South Africa.
6. (a) On our way to the Kempty Falls, we went past some of the most beautiful views.
   (b) The seed of the present lies in the past.
7. (a) I must reach the institute on time, because I do not want to miss my English class.
   (b) Our society is divided along the lines of class and caste.
B. Same Sound, Different Spellings, Different Meanings
The words that sound the same but are spelt differently are known as homophones.

For Example:

Ascent — Assent
The ascent to the top of the mountain was made more difficult because of the strong winds.
You must get your father’s assent before you decide to go for the mountaineering trip w’Ui your friends.

Brake — Break
My car brakes are not working properly.
Please handle the parcel carefully; the contents may break easily.

Cite — Sight — Site
To explain his point, he cited a ‘shloka’ from the Gita.
The old man was nearly blind; he was losing his sight rapidly.
Is this the site where the new hotel is supposed to come up?

Coarse — Course
This fabric is too coarse for this dress; we need something smoother. Our teacher completed the course two weeks ago.

Complement — Compliment
The two politicians complement each other very well — one makes up for nearly all the shortcomings of the other.
The two politicians complimented each other for the good show of their party in the general elections.

Descent — Dissent
Descent = Opposite of Ascent Dissent = Opposite of Assent

Desert — Dessert
The camel is sometimes called the Ship of the Desert.
I’m feeling too full after having this dinner — I’ll skip the dessert.
**Device — Devise**

This new *device* can connect my mobile phone to my audio CD player. They have *devised* a new way to connect a phone to a CD player. *Device* is a noun while *devise* is a verb.

**Discreet — Discrete**

As a diplomat, you learn to be very *discreet* (tactful) about what you say. His style of music is distinctly *discrete* (different) from that of his father.

**Forth — Fourth**

The movie about the lonely child brought *forth* a range of emotions in her mind — she was reminded of her own childhood. This is the *fourth* (4th) movie I’ve seen this year.

**Hair — Hare**

*Hair* is what grows on your head, and *hare* is the animal (that raced the tortoise and lost in the old fable).

**Lessen — Lesson**

I thought the ointment would *lessen* the pain; instead, it aggravated. I have now learnt a *lesson* — I will never use this ointment again.

**Lose — Loose**

*Lose* is the opposite of “Win” as well as “Find”.

We will *lose* the match. He *loses* his car keys all the time.

*Loose* means “not tight”, “Unattached”.

I can’t wear these shoes as they are very *loose*.

**Plane — Plain**

On the basics of business, my partner and I were on the same plane. (Level of thought or existence)

Since the fares have come down, I prefer to travel by plane (short for airplane) than by train.

The states of Bihar and Uttar Pradesh are benefited by the fertile plains of the Ganga.

She chose to wear a plain (simple) sari for the occasion instead of a bright and colorful one.
Principal — Principle
The principal of this college is very strict.
Lage Raho Munnabhai was a great attempt to talk about Gandhiji’s principles in today’s times.
(Remember: the word principLE is related to a ruLE)

Stair — Stare
Stairs are steps to go up or down.
The stairs led to a long corridor with several rooms along the passage. Stare is to look, used both as a verb and a noun. Ayesha stared at me as if I had just landed from Mars!

Stationary — Stationery
The planets are not stationary — they do not stay in one place.
Various stationery items such as pens, paper clips etc. were scattered on the floor.

Weather — Whether
We should not move out in this weather — it is too stormy.
We wondered whether we should move out in the stormy weather.

C. Some Examples of Different Spellings, Different Sounds, Yet Confusing Words
Accept — Except — Expect
He refused to accept the award.
Everyone went to the party except Parineeta.
I did not expect Australia to lose the match.

Among — Between
The teacher distributed sweets among all the students in her class. The teacher distributed sweets between the two sections.

Altar — Alter
The young priest was looking magnificent standing at the altar in front of the worshippers.
This shirt is too tight for me; please alter its size.
Assure — Ensure — Insure

The police assured us that they will catch the thief.
We must get our office insured as we have a lot of equipment now.
We must ensure that the shipment reaches by 6am; otherwise it will get very hot.

Bare — Bear — Beer

The little girl with bare feet was working all by herself in the hot sun. Little Darsheel was fascinated to see the huge bear at the zoo. In some countries, there is no age restriction on the consumption of mild alcoholic drinks such as beer.

Beside — Besides

I will sit beside (next to) the window.

Besides (other than) you, all others will go to Preeti’s wedding.

Conscious — Conscience

The word conscious has three different meanings: (i) awake; (ii) aware; and (iii) deliberate.

(i) Despite being given anesthesia, Sanjay was conscious through most of the operation.

(ii) From his expression, it was clear that he was not even conscious of the huge mistake he had committed.

(iii) Because it was raining so heavily, I had to make a conscious effort to drive very slowly and keep my eyes fixed on the road.

Conscience is the sense of right and wrong within each of us (antar-aatma) His conscience did not allow him to keep quiet once he came to know about the fraud that his colleagues were planning against the company.

Continual — Continuous

We had continual rain throughout the day. (The rain was starting and stopping again and again)

We had continuous rain throughout the day. (The rain never stopped once it started)

Elicit — Illicit

The police tried hard to elicit a confession from the criminal, but to no avail.
Many people think that he has an *illicit* relationship with his secretary.

**Emigrate — Immigrate**

To *emigrate* is to leave one’s country of residence. To *immigrate* is to settle in a new country to which one is not native.

She *emigrated* to the US in 2002 with her husband.

He was not allowed to *immigrate* to India as he did not have the necessary papers.

**Eminent — Imminent**

Since he won the elections, Mr. Goyal has become an eminent (famous) personality in our colony.

The exit polls seem to suggest that a victory for the Mr. Goyal is *imminent* (certain) in the next elections.

**Especially — Specially**

I *especially* value this ring; it was made *especially* for our wedding ten years ago.

Especially = Particularly; Specially = For a special reason

**Explicit — Implicit**

His instructions were loud and *explicit* — the gangster was to be shot at sight.

Though he did not say it, it was *implicit* that he wanted the gangster to be shot at sight.

**Farther — Further**

The hotel is much *farther* from the airport than I thought — it took me over an hour to reach there.

I had already waited for three hours — I did not want to wait any *further*. *Farther* is used to indicate distance; *further* to refer to additional time, amount, or abstract ideas.

**Formally — Formerly**

Mrs. Ambani *formally* issued an invitation.

I was *formerly* with the Reliance Group; now I have joined the Mittals.

**Human — Humane**

In the Matrix movie series, the entire *human* race is shown to have become a prisoner of machines.
The doctor is known not only for his knowledge of medicine, but also for the kind and humane touch that he brings to his practice.

**Idol — Idle — Ideal**

The crime branch has recovered the stolen idol of Lord Ganesha from the jungle hideout of the gangsters.

Please don’t sit idle in the house — do something worthwhile!

Because of his impressive personality and his deep voice, he was considered as the ideal candidate for the master of ceremonies.

**Imply — Infer**

Her letter clearly implies (means) that she is no longer interested in you. You can infer (understand) from her letter that she is no longer interested in you.

**Later — Latter**

I’m in a meeting right now; can you please call me later (afterwards)? I like the latter (second) design more than the former (earlier) one.

**Lay — Lie — Laid**

I will lay the table for dinner.

If you are not able to sleep, at least lie down for some time. After being hit by a bike, he laid on the road for two hours. Laid here is the past tense of lie.

**Lighting — Lightening**

The lighting in the hall is not good enough — it needs to be brighter. The rain was accompanied by a lot of thunder and lightning.

**Moral — Morale**

His stories were not only interesting; they also provided simple moral lessons like truthfulness and righteousness for children. The morale of the soldiers was already quite low; they got depressed further when it started raining heavily.

**Personal — Personnel**

This is her personal matter — I will not interfere in it.

The CEO of the company decided to personally head the personnel (human resource) department of the company.
Peruse — Persuade — Pursue

*Peruse* is to read thoroughly.

My boss *peruses* each and every document several times before he approves it.

I am attaching the budget for the project for your *perusal*.

*Persuade* is to plead with someone or try to convince someone about your point-of-view.

The little boy finally managed to *persuade* his father to take him to the new shopping mall.

*Pursue* is to follow or chase.

He is *pursuing* a career in animation technology.

The police jeep *pursued* the speeding thieves but they managed to get away.

Quite — Quiet

I am *quite* upset with her behavior. Please be *quiet* in the library.

Raise — Rise

Why don’t you *raise* (bring up) the question of a *raise* (increase) in salaries at the staff meeting today?

I will not *rise* (get up) from my desk till I complete this work.
Unit 2: Fundamentals of Computer
SESSION 1: INTRODUCTION TO COMPUTERS

Introduction

Computer is an electronic device used in almost every field; even where it is most unexpected. Now we cannot imagine a world without computers. These days, computers are used extensively by engineers and scientists and also by millions of people around the world. That is why this age is called as the era of INFORMATION TECHNOLOGY (IT).

A computer is made up of two components - one is the \textbf{hardware} and the other is the \textbf{software}. All physical components of computer including keyboard, mouse, monitor, etc, are a part of the hardware. The programs and languages used by the computer are called software.

The computer has become very important now-a-days because it is \textit{accurate}, \textit{fast} and can \textit{accomplish many tasks} easily. Otherwise, to complete those tasks manually much more time is required. It can do very big calculations in just a fraction of a second. Moreover, it can \textit{store large amount of data}. We can also get a lot of information on different aspects using internet.

Today, the computer is used in different fields, which include the following:

\textbf{Banks}

Almost every bank uses computers to keep the records of money transactions and financial documents. It is also used in this sector because of the speed, convenience and security that it provides.

\textbf{Communication}

Communication has become very easy and simple through internet and email. Computer communicates using telephone lines, modems and satellites. Through email we can send messages in a split-second to anybody in any part of the world. On the other hand, the traditional form of communication, for example postal services takes many days to reach the recipient. So the internet has helped to make the earth a global village and above all, it saves time. Internet helps us to find information on every topic. It is the easiest and fastest way of communication. Computer network makes the user capable of accessing remote programs and databases of same or different organizations.
Business

Computer has now become an integral part of corporate life. Business transactions take place very easily, accurately and records of all the business transactions can be stored. Today computers can be found in every store, supermarkets, restaurants, offices etc. One can buy and sell things online, bills and taxes can be paid online and even the future of business can be predicted using artificial intelligence software. Computers also play a very important role in the stock markets.

Medical Science and Health Care

Diseases can be easily diagnosed with the help of computer and we can also know about the cure. Almost every medical diagnostic equipment uses a computer. In the field of healthcare, computers are used to perform various tasks such as reviewing medical records of patients. Using computers, doctors can easily search information about latest drugs that are available to treat a disease. In addition, doctors use computer technology to discuss and share information about various diseases.

Education

Today computer has become an important part of one’s education because we are using computers in every field. Without the knowledge of computer we cannot get a job and perform well in it. So computers can improve job prospects. Computers are used in class rooms by teachers to teach, maintain records of students, online learning and assessments, etc.

Media

Almost every type of editing and audio-visual composition can be made by using special software made for the purpose. Some software can even make three dimensional figures which are mostly used in making cartoon films. Special effects for action and science fiction movies are also created on computer.

Travel and Ticketing

With the advent of computers, ticketing and reservations have become an easy task. Now-a-days, it is possible to reserve our train tickets over the internet. Reservation of tickets can be done through the Indian Railway Catering and Tourism Corporation (IRCTC) website of Indian Railways. It also allows one to check the railway seat availability and PNR status in real-time.
Weather Predictions

Weather predictions are also possible by the experts using supercomputers. Weather forecasting now relies on computer-based models that take many atmospheric factors into account. Ever since computers are being used, there is a greater accuracy in weather forecasting.

Sports

Computers are also used for umpiring decisions. Many a times, the umpire has to go for the decision of third umpire in which the recording is seen on the computer and finally an accurate and fair decision is reached. Simulation software helps the sportsman to practice and improve his skills.

Arts and Entertainment

Video games are one of the most popular applications of personal computers. The constantly improving graphics and sound capabilities of personal computers have made them popular tools for artists and musicians. Personal computers can display millions of colors, can produce images far clearer than those of a television set, and can connect to various musical instruments and synthesizers. Painting and drawing programs enable artists to create realistic images and animated displays much more easily than they could with more traditional tools. “Morphing” programs allow photographers and filmmakers to transform photographic images into any size and shape they can imagine. High-speed supercomputers can insert life-like animated images into frames of a film so seamlessly that movie-goers cannot distinguish real actors from computer-generated images. Musicians can use computers to create multiple-voice compositions and to play back music with hundreds of variations.

Social Media

The spreading of an idea, or of news occurring somewhere in the world is now possible through social sites on the internet. As long as one person is able to connect to the internet and express their view about a situation or simply about an idea, then the information that individual will want to share, will get out into the world. Sites such as Facebook, Twitter, YouTube and LinkedIn allow people to share ideas on not just news, but also on products and services.
Mobile Computing

Mobile computing is the human–computer interaction by which a computer is expected to be transported during normal usage. Mobile computing involves mobile communication, mobile hardware, and mobile software. It also means being able to use a computing device even when you are mobile and therefore changing location. Portability is one aspect of mobile computing. Mobile Computing is a variety of wireless devices that allow people to connect to the internet, providing wireless transmission to access data and information from wherever they are. Many types of mobile computing devices have been introduced since 1990s including the following:

- Personal digital assistant (PDA): A small, usually pocket-sized, computer with limited functionality.
- Smartphone has a wide range of features and installable applications.
- Tablet computer does not have a keyboard and is shaped like a slate or a paper notebook.

Scientific Research

Scientists use documentation. For example, scientists use computers to view images from space and to publish information on their recent research.

Government

In government organizations, you can use computers to organize information by storing and maintaining records. Computers are also used for providing services to citizens.

Publishing

Computers are used to design any type of publication ranging from simple newsletters to magazines, marketing materials, books, or newspapers. Most of the publishers also have an electronic version of their magazines and newspapers. E-books have become widely prevalent.

Daily Life

We operate washing machines, microwave oven and many other products using software. Moreover we can store all the information about our important work, appointments
Information Technology – Class IX

schedules and list of contacts in a computer. Computer is, therefore, playing a very important role in our lives and now we cannot imagine the world without computers.

Relevant Knowledge

An automobile, such as a car or a van, is available in different models and colors, but its essential components remain the same. All automobiles have an engine, a body, and wheels. Similarly, computers are available in various sizes and shapes, but they all have common components that work in the same manner. The essential components of a computer are hardware and software. In this session, you will learn about common computer terminologies, such as hardware, software, data, and network.

Hardware

*Hardware* refers to all the physical components of a computer. It includes all input devices, processing devices, storage devices, and output devices. The keyboard, mouse, motherboard, monitor, hard disk, cables, and printer are all examples of hardware.

You use hardware to provide input to a computer and also to get the desired output. For example, when you play a musical instrument, such as a piano, you provide input by pressing the keys and get the desired output in the form of music. Similarly, computers also need input and output devices to perform tasks. Apart from input and output devices, a computer uses processing devices to work on the input data and generate the desired output. The most important processing device is the **Central Processing Unit (CPU)**. The CPU is the brain of the computer. It processes the input to perform calculations and produce output.

A **motherboard** is a large circuit board that connects input, output, and processing devices. The motherboard circuits provide pathways that allow data to pass through these various components. It also contains chips that determine how, when, and where data can flow through the computer. Depending on the task that you want your computer to perform, you can choose the appropriate hardware. You can also use expansion cards, such as video cards, to add new features or enhance the performance of your computer. All of these devices are plugged into the motherboard.

Operating System

In addition to hardware, a computer needs software to function. Software sends instructions to the hardware to perform the necessary tasks. The most important software on the computer is the **operating system**, which controls and manages the hardware connected to
your computer. The operating system provides an interface that helps you to interact with the computer. Some examples of the operating systems is Windows, Linux, Android. A user interface can be either text-based or graphics-based. Most operating systems provide a graphical user interface (GUI), which displays images and pictures that allow you to interact with a computer easily.

**Programs and Data**

The hardware and the operating system together are referred to as a platform. Programs, also called applications, use this platform to perform tasks. There are many types of programs. Some programs allow you to perform tasks such as writing letters, doing calculations, or sending e-mail messages. For example, a word processor, such as Microsoft Office Word 2007, is a program that helps you create a letter. Other programs allow you to create illustrations, play games, watch movies, or communicate with other computer users.

Programs process data that you provide as input to your computer. This data can be in the form of text, graphics, audio, or video depending on the type of program. For example, Calculator is a program that requires input in the form of numbers. Similarly, Sound Recorder is a program that requires input in the form of audio. When the program receives the data, it processes the data and displays the output on the screen. You can save this output in a file. Depending on the type of data that a file contains, the file is classified as an audio file, a text file, a graphics file, or a video file.

**Networks**

Consider a scenario where an organization has 10 employees. These employees use computers to perform daily tasks. They also need to print data frequently. Instead of giving each employee a printer, which would be expensive, all computers can be connected to a single printer. You can connect your computer to other computers to share information and hardware components. A group of computers and associated devices that are linked together to facilitate sharing information is called a network. Networks can also be used to share data and devices such as printers. You can also communicate with other computer users on the network. A typical network has the following three components:

**Server:** The main computer on a network that provides services to other computers on the network. A server decides which computers are to be allowed to access the hardware and software on the network.

**Workstation:** A computer connected to a network. You use a workstation to access the hardware and software on a network.
Communication channel: A path or link that connects computers or peripheral devices, such as printers and disk drives, to transfer information. Cables are commonly used as communication channels in a network, but networks can also transfer information through wireless connections.

Depending upon the area covered, a network can be categorized as a local area network (LAN) or a wide area network (WAN). A LAN connects devices within a limited area, such as a home or a small group of offices. It commonly includes computers and shared resources such as printers and scanners. A WAN is a network that connects devices in geographically separated areas. You can use the resources of a WAN to connect two or more LANs by using long wires, optical cables, and satellites. Many organizations use a WAN to connect their networks across different countries. The Internet is an example of a WAN.

Internet

The Internet is a worldwide collection of public networks that are linked to each other for information exchange. The Internet started as a network to facilitate communication between government and educational departments in the United States. When other networks were connected to this network, it became a vast medium for exchanging information and ideas.

Today, the Internet connects many commercial, government, and educational networks, as well as individual computers, which share data. The Internet offers a range of services to its users, such as file transfers between Internet users and electronic mail for sending messages.

The World Wide Web (WWW), or the Web, is another service that the Internet provides. WWW includes specially formatted documents that are interlinked and stored on servers around the world. You can use the Internet and its services to send messages to other Internet users, search and apply for jobs, watch movies, and buy and sell products.

Intranet

Many organizations use a special type of network to communicate and share information within the organization. Such a network is called an intranet. An intranet is similar to the WWW but is accessible only to authorized users of the organization. An intranet is much smaller than the Internet and can provide services such as document distribution, software distribution, access to databases, and training.
SESSION 2: PARTS OF A COMPUTER SYSTEM

Relevant Knowledge

A computer is an electronic device that can store and process information. Computers help perform a variety of tasks such as receiving and sending messages to family and friends, making presentations, and maintaining records. Computers are also used in education, research, broadcasting news, making weather forecasts, and for various other business and recreational activities.

Parts of a Computer

A computer has various parts, and each part performs a specific function. The following table describes the parts of a computer.

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input devices</td>
<td>Input devices are used to provide information to a computer, such as typing a letter or giving instructions to a computer. Some examples of input devices are as follows:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Mouse</strong>: A standard mouse has a left and a right button. You use the left button to select items and provide instructions by clicking an active area on the screen. You use the right button to display commonly used menu items on the screen.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Keyboard</strong>: A set of keys that resembles a keyboard on a typewriter. You use the keyboard to type text such as letters or numbers into the computer.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Microphone</strong>: A device that you can use to talk to people in different parts of the world. You can record sound into a computer by using a microphone. You can also record your speech and let the computer convert it into text.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Scanner</strong>: A device that is similar to a photocopy machine. You can use this device to transfer an exact copy of a photograph or document into a computer. A scanner reads a page and translates it into a digital format that a computer can read. For example, you can scan photographs of your family using a scanner.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Webcam</strong>: A device that is similar to a video camera. It allows you to capture and send live pictures to other users. For example, a webcam allows your friends and family to see you when you are communicating with them.</td>
</tr>
</tbody>
</table>
### Information Technology – Class IX

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Stylus:</strong></td>
<td>A pointing device, similar to a pen, used to make selections and enter information by tapping on a touch sensitive surface. For example, to enter information on a personal digital assistant (PDA), you use a stylus. A PDA is a lightweight, palmtop computer.</td>
</tr>
<tr>
<td><strong>Trackball:</strong></td>
<td>A pointing device that is an alternative to a mouse. A trackball consists of a ball that is rotated to move the pointer on a computer screen. You can use a trackball when you have limited desk space.</td>
</tr>
<tr>
<td><strong>Output devices</strong></td>
<td>You use output devices to get feedback from a computer after it performs a task. Some examples of output devices are as follows:</td>
</tr>
<tr>
<td><strong>Monitor:</strong></td>
<td>A device that is similar to a television. It is used to display information in visual form, using text and graphics.</td>
</tr>
<tr>
<td><strong>Printer:</strong></td>
<td>A device that you use to transfer text and images from a computer to a paper or to another medium, such as a transparency film. You can use a printer to create a paper copy of whatever you see on your monitor.</td>
</tr>
<tr>
<td><strong>Speaker/Headphone:</strong></td>
<td>A device that allows you to hear sounds. Speakers may either be external or built into the computer.</td>
</tr>
<tr>
<td><strong>Central Processing Unit (CPU) and Memory</strong></td>
<td>The Central Processing Unit (CPU) is a device that interprets and runs the commands that you give to a computer. It is the control unit of a computer. The CPU is also referred to as the processor. Memory is where information is stored and retrieved by the CPU. There are three main types of memory.</td>
</tr>
<tr>
<td><strong>Random access memory (RAM):</strong></td>
<td>It is the main memory and allows you to temporarily store commands and data. The CPU reads data and commands from RAM to perform specific tasks. RAM is volatile, which means it is available only while the computer is turned on. The contents of RAM must be copied to a storage device if you want to save the data in the RAM.</td>
</tr>
<tr>
<td><strong>Read only memory (ROM):</strong></td>
<td>It is the memory that retains its contents even after the computer is turned off. ROM is nonvolatile, or permanent, memory that is commonly used to store commands, such as the commands that check whether everything is working properly.</td>
</tr>
<tr>
<td><strong>Flash memory:</strong></td>
<td>It is a nonvolatile memory that retains data even after a computer is turned off. Unlike in ROM, you can erase or modify stored information.</td>
</tr>
</tbody>
</table>
**Motherboard**
The motherboard is the main circuit board inside a computer. It has tiny electronic circuits and other components on it. The motherboard connects input, output, and processing devices together and tells the CPU how to run. Other components on the motherboard are the video card, the sound card, and the circuits that allow a computer to communicate with devices like a printer. The motherboard is sometimes called a system board.

**Expansion Cards**
An expansion card is a circuit board that can be attached to a motherboard to add features such as video display and audio capability to your computer. An expansion card improves the performance of your computer and enhances its features. Expansion cards are also called expansion boards. Some types of expansion cards are described in the following list:
- **Video card:** It is connected to a computer monitor and is used to display information on the monitor.
- **Network interface card (NIC):** It allows a computer to be connected to other computers so that information can be exchanged between them.
- **Sound card:** It converts audio signals from a microphone, audio tape, or some other source to digital signals, which can be stored as a computer audio file. Sound cards also convert computer audio files to electrical signals, which you can play through a speaker or a headphone. You connect microphone and speakers to a sound card.

**Storage Devices**
You use storage devices to store computer information. Storage devices come in many forms. Some examples are hard drive or disk, CD-ROM, floppy disk, and DVD-ROM. Storage devices can be divided into two types, internal storage devices and external storage devices. Some common storage devices are as follows:
- **Hard disk:** A magnetic disk that is usually the main storage device on most computers. It can be an external or an internal device.
- **Floppy disk:** A portable storage device that allows you to store a small amount of data. A disadvantage of this disk is that it can be easily damaged by heat, dust, or magnetic fields.
- **CD-ROM:** A portable storage medium that allows you to store 400 times more data than on a floppy disk. It is less prone to damage than a floppy disk.
- **DVD-ROM:** A portable storage medium that is similar to a CD-ROM; however, it can store larger amounts of data than a floppy disk or a CD-ROM. A DVD-ROM is commonly used to store movies and videos.
Information Technology – Class IX

<table>
<thead>
<tr>
<th>Part</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ports and Connections</td>
<td>A port is a channel through which data is transferred between input/output devices and the processor. There are several types of ports that you can use to connect a computer to external devices and networks. Some types of ports are described in the following list.</td>
</tr>
<tr>
<td>Universal serial bus (USB) port</td>
<td>You use this to connect peripheral devices such as a mouse, a modem, a keyboard, or a printer to a computer.</td>
</tr>
<tr>
<td>FireWire</td>
<td>You use this to connect devices such as a digital camera. It is faster than a USB.</td>
</tr>
<tr>
<td>Network port</td>
<td>You use this to connect a computer to other computers to exchange information between the computers.</td>
</tr>
<tr>
<td>Parallel port and serial port</td>
<td>You use these ports to connect printers and other devices to a personal computer. However, the USB port is now preferred to connect peripheral devices because it is faster and easier to use.</td>
</tr>
<tr>
<td>Display adapter</td>
<td>You connect a monitor to a display adapter on your computer. The display adapter generates the video signal received from a computer, and sends it to a monitor through a cable. The display adapter may be on the motherboard, or on an expansion card.</td>
</tr>
<tr>
<td>Power</td>
<td>A motherboard and other components inside a computer use direct current (DC). A power supply takes alternating current (AC) from a wall outlet and converts it into DC power.</td>
</tr>
</tbody>
</table>

SESSION 3: COMPUTER FUNDAMENTALS

A computer system includes software and hardware together to make it perform the required tasks. Software is a collection of instructions and related data that tells a computer what to do and how to do. In other words, software is a conceptual entity, which contains a set of instructions (computer programs) with associated documentation related to the operations of a data processing system; whereas, computer hardware is a collection of electronic and other peripheral units, which enables software to perform desired operations. And, there is important software, known as Operating system (OS) specially designed to establish the communication between various hardware devices and software loaded on a computer system.

“A computer system is a programmable machine designed to perform arithmetic and logical operations to produce meaningful results in desired format”
Relevant Knowledge

A computer system is broadly divided into three units – Input Unit, Central Processing Unit (CPU) and Output Unit. Input unit helps the user to enter raw data and instructions into the computer system, central processing unit performs the required operations as per given instructions and at the end output unit produces meaningful results in the desired format for the user.

Let us understand this concept with the help of an example - What information will you require to calculate the amount to be paid to a shopkeeper for buying several pieces of a branded pen? You will require its Unit Price and Quantity procured by you – So Unit Price and Quantity will become the raw data to be entered by you through the input unit. Now, you need to multiply both these values to know the Amount to be paid to the shopkeeper – So multiplication of these two values will become the operation, which will be performed by the CPU and the Amount, which is the result will be on the Output unit of a computer system.

Fig. 1: Block Diagram of a Computer System

The CPU is further divided into three parts (i) control unit (CU), (ii) arithmetic & logic unit (ALU) and (iii) memory unit (MU). Inside CPU, Control unit acts as a receptionist and a manager of a company. It receives each and every instruction from user and coordinates between different parts to perform various operations. Arithmetic and logic
unit acts as an accountant of a company, which performs all the mathematical and logical calculations.

And memory unit acts as a temporary store of a company, where small amount of data is stored while other operations are being performed. In addition to these units, a computer system also has secondary storage device to hold or store large amount of data for later use by various applications running on it. Figure 1 illustrates the interconnection of these units and secondary storage device.

Now, you must be wondering how you can recognize these units in the form of real devices in a personal computer system. You might have seen a device having several buttons (known as keys) with alphabets and numbers, this device is known as keyboard, which acts as an input device of the computer system. You might have also seen another oval shaped device with two/three buttons in front, this device is known as mouse, which is also an input device of the computer system. Further, you can see a vertically standing/horizontally places box/case with an on/off/reset button – this cabinet/case is known as CPU cabinet, which also contains place to hold secondary storage devices such as hard disk to hold large amount of data and instructions and Compact Disc (CD)/Digital Versatile Disc (DVD)/Blue Ray drive to keep data on portable discs. One of the most common output devices is LCD/LED/Monitor, which is used as output unit to display the results coming out from a computer. The computer system may also have some more additional devices connected with it to act as input and output devices as per the requirement of an individual work.

Some examples of input and output devices are given below:

<table>
<thead>
<tr>
<th>Input/Output device</th>
<th>Purpose</th>
<th>Sample Requirement</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mic/mike</td>
<td>Used to take the audio input</td>
<td>To record nursery rhymes in the system</td>
</tr>
<tr>
<td>Scanner</td>
<td>Used to accept digital input from a paper picture/image/document.</td>
<td>To scan a picture that is to be included in an assignment</td>
</tr>
<tr>
<td>Camera</td>
<td>Used to accept image/video inputs</td>
<td>To take pictures of students for identity cards.</td>
</tr>
<tr>
<td>Barcode Reader</td>
<td>Used to read barcode</td>
<td>To read Barcodes present on books being issued/returned in the School library.</td>
</tr>
<tr>
<td>Printer</td>
<td>Used to print output on paper</td>
<td>To print an assignment on paper</td>
</tr>
<tr>
<td>Speaker</td>
<td>Used for audio output</td>
<td>To listen to Nursery Rhymes from the system</td>
</tr>
</tbody>
</table>
The memory unit of CPU is further divided into two components, one is known as **Random Access Memory (RAM)** to take care of intermediate storage of data while working on a computer system and another **Read Only Memory (ROM)** to keep the essential instructions written and stored by the manufacturer to load operating system and take care of basic input/output operations – also referred as **BIOS** i.e. Basic Input Output System.

In the computer, the data is stored in the form of Bits and Bytes. Bit (Binary Digit represented by 0 or 1) is the smallest storage unit, 8 Bits combined together form a single byte, which in turn represent a single character. Let us see an example, if the name “RAVI” is required to be stored in computer, it will need 4 bytes in the computer’s memory. The following table represents other higher units of computer memory.

<table>
<thead>
<tr>
<th>Memory unit</th>
<th>Relationship with Earlier Memory Unit</th>
<th>In equivalent Bytes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Kilo Byte (KB)</td>
<td>1 Kilo Byte = 1024 Bytes(or 210 Bytes)</td>
<td>1024</td>
</tr>
<tr>
<td>Mega Byte (MB)</td>
<td>1 Mega Byte = 1024 Kilo Byte (or 210 KB)</td>
<td>1024x1024</td>
</tr>
<tr>
<td>Giga Byte (GB)</td>
<td>1 Giga Byte = 1024 Mega Byte (or 210 MB)</td>
<td>1024x1024x1024</td>
</tr>
<tr>
<td>Tera Byte (TB)</td>
<td>1 Tera Byte = 1024 Giga Byte (or 210 GB)</td>
<td>1024x1024x1024x1024</td>
</tr>
</tbody>
</table>

RAM and ROM constitute the **Primary Memory**. Now, let us discuss in detail about the various **Secondary Storage Devices**. These are used to store large amount of data (with capacity in the range of 20 GB to 2 TB) permanently on computer, i.e. the data is retained even when the system is switched off. **Hard Disc** is one of the most important secondary storage devices, which is used to store operating system, office applications, utility software and the user’s data, etc. Apart from hard disk, one can always use additional (portable) secondary storage devices such as Compact Disk (CD with a storage capacity of 750 MB), Digital Versatile Disk (DVD with a capacity of around 4.5 GB), Blue-ray Disk (with a storage capacity of around 25 GB/50GB), Pen Drives (with a storage capacity of 512 MB to 32 GB), Memory Stick (with a storage capacity of 512 MB to 32 GB).

Now, let us connect/check the connections between various parts of a personal computer. Try to locate all the sockets or ports, which are present behind the CPU Cabinet as shown in Figure 2. Some of the common sockets/ports are power socket for connecting power cable, Personal System 2 (PS2) ports for connecting Mouse and Keyboard, Universal Serial Bus (USB) Port for connecting USB devices such as mouse, keyboard, printer,
pen drive, etc., Video Graphic Adapter (VGA) port for connecting Monitor/Screen. Connect Monitor with VGA cable, mouse & keyboard with PS2/USB cable and power on the CPU after connecting power cable. Your computer should display some message from the manufacturer and then it should start the Operating System (boot up with the operating system). Once the booting process is over, you will see the desktop – the first screen you see in the beginning, to allow you to choose and start the application of your choice.

Figure 2: CPU Cabinet Back Panel
Some of the common ports and cables along with their pictures are described in Figure below:

<table>
<thead>
<tr>
<th>Port &amp; Cables</th>
<th>Firewire Port &amp; Cables</th>
<th>Ethernet (RJ45) Port &amp; Cables</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="USB port" /></td>
<td><img src="image2.png" alt="Firewire port" /></td>
<td><img src="image3.png" alt="Ethernet cable" /></td>
</tr>
</tbody>
</table>

A USB (Universal Serial Bus) port is a standard cable connection interface available on personal computers and some other electronic devices for data communication. USB ports allow stand-alone electronic devices to be connected with the help of cables to a computer (or to each other). USB ports can also supply electric power across the cable to devices without their own.

Pins: 4 Standard: Institute of Electrical and Electronics Engineers (IEEE) Standard in 1990

FireWireÆ ports are forms of a serial port that make use of FireWireÆ technology to transfer data rapidly from one electronic device to another. The FireWireÆ port has the ability to interact with a number of different devices. A FireWireÆ port can provide an ideal way to connect a scanner and digital camera to a computer system as the data transfer is relatively faster than on USB and also results in excellent quality.

Pins: 4, 6, 9 Standard: Institute of Electrical and Electronics Engineers (IEEE) 1394

Ethernet Port used to connect computers and other devices form a computer network. It uses Ethernet cables establish efficient and effective communication between computers and other peripheral devices such as modem, router, multimedia projector etc.

Pins: 8 Pins Standard: Institute of Electrical and Electronics Engineers (IEEE) Standards 802.1 to 802.10
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activities</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Identify Monitor Screen, CPU Cabinet, Keyboard, Mouse and Printer.</td>
</tr>
<tr>
<td>2.</td>
<td>Distinguish between common i/o ports and connectors.</td>
</tr>
<tr>
<td>3.</td>
<td>Connect the cables to the parts of computer.</td>
</tr>
<tr>
<td>4.</td>
<td>Classify the given input and output devices.</td>
</tr>
</tbody>
</table>

Assessment

1. What is input unit of a computer system?
2. What is output unit of a computer system?
3. What is the job of Control Unit inside CPU?
4. What is the job of Arithmetic Logic Unit inside CPU?
5. Name four input devices and write the type of input that can be entered through them into a computer system.
6. Name four output devices and write the type of output that can be exhibited through them.

SESSION 4: TYPES OF COMPUTERS

Consider a situation where you want to buy a television. There are many brands and models available in the market. You need to make a decision based on the features that you want and the price of the product. Similarly, there are different types of personal computers available in the market. They differ on the basis of features such as price, size, and speed. In addition, these factors affect the overall performance of the computer.

After you buy a television, you need to choose from different kinds of channels that are available. These channels may offer entertainment, sports, or news. You can choose to view a channel based on your preferences. In the same way, after you start using a computer, there are different types of programs available that help you perform different tasks. You can use a word processor to create documents or a spreadsheet to perform mathematical calculations. Communications programs can help you talk to people at
distant locations. With entertainment programs, you can watch movies, listen to music, or play games.

**Relevant Knowledge**

Different types of computers are available in the market today. The most common computer is the *Personal Computer (PC)*, typically used by individuals and small businesses. A personal computer is a computer that is designed for use by one person at a time. A personal computer is used in the workplace to create documents, manage business records, and communicate with others. It is used in schools to teach lessons, research over the Internet, and work on assignments. You can also use a personal computer to play games, view videos, and listen to music. Depending on the size and the purpose of a personal computer, it can be categorized into four different types: desktop, laptop, handheld, or tablet.

You select a computer depending on the tasks that you want it to perform. For example, if you want to use the computer to edit photos or play complex games, you need a computer with a fast CPU and a good display adapter. The following table describes the different types of computer in detail:

<table>
<thead>
<tr>
<th>Type of Computer</th>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop computers</td>
<td>Desktop computers are made up of individual components such as a monitor, a keyboard, a system unit, and a printer. Desktop computers are not portable and are generally placed on the surface of a desk or a table. The components of desktop computers can easily be replaced or upgraded. Desktop computers usually have more memory, a larger hard drive, more ports, and a bigger display than laptops and other portable computers.</td>
</tr>
<tr>
<td>Laptop computers</td>
<td>Laptop computers are lightweight personal computers. Laptop computers are smaller in size as compared to a desktop computer and are designed for travel. Laptop computers are also called notebooks. The main feature of laptop computers is that they are small and portable. As the name suggests, these can easily be placed on the lap of a user. Laptop computers run on electricity only, while laptop computers run on electricity or on batteries that can be recharged. However, laptop computers consume more power than desktop computers with a similar hardware setup.</td>
</tr>
</tbody>
</table>
### Type of Computer

<table>
<thead>
<tr>
<th>Feature</th>
</tr>
</thead>
<tbody>
<tr>
<td>Handheld computers are devices used for specific everyday tasks, such as managing personal data. These are smaller than laptops and provide fewer features compared to desktop computers or laptops. These can also perform basic word-processing activities and help you access the Internet. You can also send and receive e-mail messages by using handheld computers. Several handheld computer models can also work as cellular phones or digital cameras.</td>
</tr>
<tr>
<td>Tablet computers are fully functional computers that allow you to write directly on the screen by using a tablet pen. You can also use the tablet pen to perform mouse functions. Tablet computers, therefore, do not need a keyboard and a mouse.</td>
</tr>
</tbody>
</table>

### Role of Memory

When a computer performs a task, it stores data in the memory. The data that is stored in the memory is internally represented in the form of 0s and 1s. Each 0 or 1 is called a **bit**. A combination of eight bits is called a **byte**. The following table explains the various terms used to measure storage or memory capacity.

<table>
<thead>
<tr>
<th>Term</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bit</td>
<td>A bit is the smallest unit of information that a computer handles. A single bit can hold only one of two values, 0 or 1. One of the two values is always present. A single bit conveys little meaningful information. However, you can obtain more meaningful information by combining consecutive bits into larger units.</td>
</tr>
<tr>
<td>Byte</td>
<td>A byte is a combination of eight bits arranged in a particular sequence. Each sequence represents a single character, symbol, digit, or letter. A byte forms the basic unit that is used to measure the storage capacity of a storage device.</td>
</tr>
<tr>
<td>Kilobyte</td>
<td>One kilobyte (KB) is equal to 1,024 bytes. Most of the user data stored in a computer, such as simple e-mail messages or a text file, occupies storage space of a few kilobytes.</td>
</tr>
<tr>
<td>Megabyte</td>
<td>One megabyte (MB) is equal to 1,024 KB. The amount of information contained in 1 MB is approximately equal to a complete textbook.</td>
</tr>
<tr>
<td>Gigabyte</td>
<td>One gigabyte (GB) is equal to 1,024 MB, which is approximately a billion bytes. Most computers today have hard disks with large capacities that are measured in gigabytes. A gigabyte denotes a huge storage capacity. For example, a video film stored on a computer can occupy more than 1 GB of space.</td>
</tr>
</tbody>
</table>
Term | Description
--- | ---
Terabyte | One terabyte is equal to 1,024 GB, approximately a trillion bytes. Storage devices having capacities in terabytes are generally used by organizations that need to store large volumes of data. A terabyte is so large that a few terabytes of memory space can contain the complete text of a large number of books.

**Computer Performance**

Whether you use your computer for business or for personal use, it is important that your computer perform efficiently. However, performance does not depend on a single factor. The following table lists some of the important factors that affect the overall performance of the computer.

<table>
<thead>
<tr>
<th>Factor</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CPU speed</td>
<td>The CPU is the brain of the computer and its speed is an important factor that affects the overall performance of the computer. The CPU speed is the rate at which the CPU can perform a task, such as moving data to and from RAM, or performing a numerical calculation. If you have two computers that are identical except for the CPU speed, the computer with the faster CPU completes a task more quickly.</td>
</tr>
<tr>
<td>Hard disk factors</td>
<td>Hard disks differ in storage capacities as well as their speed of data storage and retrieval. If the speed of data retrieval is fast, the computer takes less time to start and to load programs. Additionally, the speed and size of the hard disk play an important role when a program needs to process large volumes of data.</td>
</tr>
<tr>
<td>RAM</td>
<td>The speed of retrieving data stored on RAM is very fast and for this reason the computer uses it to store the information that is currently in use. If the amount of RAM is large enough to hold all of the information in use, this can result in faster computer performance. The RAM speed and the amount of RAM are important factors in personal computer performance. When there is not enough RAM in a computer, the computer slows down or fails to function properly.</td>
</tr>
</tbody>
</table>

**Productivity Programs**

You can use different computer programs to perform a variety of tasks. You can use computer programs to organize numbers, write letters or proposals, maintain records, create and modify images, convert text into visuals, and create magazines and brochures. The following table lists the different types of programs and describes their uses.
<table>
<thead>
<tr>
<th>Program</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Word-processing and publishing programs</td>
<td>You use word-processing programs to create and modify text-based documents. You can type in and modify text, use the spelling checker and the built-in thesaurus, and format the document. By using these programs, you can also create personal and professional documents. Microsoft Office (MS) Word is a commonly used word-processing program. Publishing programs are used to combine text and graphics to create documents such as brochures, greeting cards, annual reports, books, or magazines. These programs also include word-processing and graphics features that allow you to refine parts of the document.</td>
</tr>
<tr>
<td>Presentation programs</td>
<td>You use presentation programs to present your information in the form of slides. You can add sound and pictures to these slides to make them more attractive and informative. Microsoft Office (MS) PowerPoint is a commonly used presentation program.</td>
</tr>
<tr>
<td>Spreadsheet programs</td>
<td>You use spreadsheet programs to create budgets, manage accounts, perform mathematical calculations, and convert numerical data into charts and graphs. Spreadsheets store information in a table, with values spread over horizontal rows and vertical columns. Each value is stored in a cell. A cell is the intersection of a row and a column. Microsoft Office (MS) Excel is an example of a spreadsheet program.</td>
</tr>
<tr>
<td>Database programs</td>
<td>You use database programs to store and manage data in an organized way. By using these programs, you can also sort or search for the information stored in a database. In addition, you can create simple reports from the data that you have stored. For example, you can use a database program to store customer details, create and manage inventory, and track sales. You can then create reports to target sales or plan customer services. An example of a database program is Microsoft Office (MS) Access.</td>
</tr>
<tr>
<td>Graphics programs</td>
<td>You use graphics programs to create and edit drawings. You can also use these programs to enhance photographs. The Paint program is an example of a graphics program that allows you to create drawings.</td>
</tr>
</tbody>
</table>

**Communication Programs**

Just as you use a telephone or postal mail to communicate with friends and family, you can also use computers to communicate with people. Computers use special programs
called communication programs that allow you to send and receive messages with other people in a digital format.

**E-Mail:** Sending e-mail messages is the exchange of messages from one computer user to another computer user. This exchange can be within a local area or from one part of a country to another. You can send an e-mail message to or receive an e-mail message from one or several persons at any time of the day. To send an e-mail message you must have an Internet connection and an e-mail account. This Internet connection is provided by an Internet service provider (ISP). You can use several programs, such as Windows Mail, to create an e-mail account. If you have an e-mail account, it will be similar to username@example.com, where the username is your name. The @ is the at sign and example.com is the domain name. A domain name identifies the name and type of organization with whom you have an e-mail account. After you have an e-mail account, you need to know the e-mail account of the person to whom you want to send an e-mail. You can send both text and pictures through e-mail; however, this depends on various factors, such as the type of service you have or the kind of picture you are sending.

Sending and receiving e-mail messages is an instant way of communicating with anyone. It only takes a few seconds to send and receive an e-mail. This also depends on the speed of your Internet connection.

**Chat:** Another type of communication is through chat programs, which allows you to send and receive messages immediately. You can use a chat program to communicate with several people at the same time. A commonly used communication program is Windows Live Messenger.

When you are chatting with someone, the person on the other end receives your messages immediately. Through chat you can also talk to the person you are chatting with. This is called voice chat. Another form of chatting allows you to also see the person you are talking to. You use a device called a webcam to do this.
SESSION 5: USING A COMPUTER

Session 5: Using a Computer Relevant Knowledge

To turn on a computer, press the power button on the system unit. When you turn on the computer, lights on the keyboard may blink briefly and you may also hear a beep. This is an indication that the power-on self test (POST) has started. The computer performs a sequence of quick tests to check whether the motherboard, memory, hard drive, and other components are working. If you hear a series of beeps, the monitor may display a message indicating that a component is not functioning. For example, if the keyboard cable is not attached, an error message may report that there is no keyboard detected.

After POST, the computer starts the operating system. The operating system controls the computer’s hardware and manages the different operations of the computer, such as logging on, logging off, and shutting down.

When the computer starts the operating system, a welcome screen appears. This screen displays the links to existing user accounts. To log on to Windows Vista, you need to click the link to your user account, type your password in the box, and then click the button next to the box.

After you log on to your computer, operating system prepares the desktop in a few seconds. The desktop appears and the Welcome Center opens. The Microsoft Windows Sidebar appears on the right side of the screen. The Welcome Center contains information about your computer and about using Windows.

After you log on, you can perform various tasks, such as creating a new file or modifying an existing file. Before you close the file, you need to save the changes you made to the file. You can then log off from Windows. Logging off is useful if you share your computer with other people. You can end your Windows session without affecting the sessions of other users if they did not log off from their sessions. You can also end your computer session by using the Shut Down command. If you shut down a computer when other users are logged on, they can lose unsaved data.

If you encounter problems while using the computer, you can use the Restart option to restart the computer. On most computers, you should never use the actual power button on the front of the system unit to turn off the computer unless it stops responding.
# Overview of a Keyboard

The keyboard is an input device that you can use to type commands or text into a computer. Different keyboards have different key layouts. In addition, the functions of some keys such as DELETE, BACKSPACE, PAGE UP, and PAGE DOWN may vary from program to program.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1.</strong></td>
<td>Keys labeled from F1 to F12 are function keys. You use them to perform specific functions. Their functions differ from program to program. The function of the F1 key in most programs is to access the help file associated with a program. Some keyboards may have fewer function keys.</td>
</tr>
<tr>
<td><strong>2.</strong></td>
<td>Keys, such as Control (CTRL), SHIFT, SPACEBAR, ALT, CAPS LOCK, and TAB, are special keys. The special keys perform special functions depending on when and where they are used. Most keyboards include a special key called Windows logo key. This key is located between the CTRL key and the ALT key. This key is used to open the Start menu, or is used in combination with a second key to perform common Windows tasks.</td>
</tr>
<tr>
<td><strong>3.</strong></td>
<td>There are keys which are used for entering letters and numbers.</td>
</tr>
<tr>
<td><strong>4.</strong></td>
<td>Punctuation keys include keys for punctuation marks, such as colon (:), semicolon (;), question mark (?), single quotation marks (‘ ’), and double quotation marks (“ ”).</td>
</tr>
<tr>
<td><strong>5.</strong></td>
<td>The label on this key can be either ENTER or RETURN, depending on the brand of computer that you are using. You use the ENTER or the RETURN key to move the cursor to the beginning of a new line. In some programs, it is used to send commands and to confirm a task on a computer.</td>
</tr>
<tr>
<td><strong>6.</strong></td>
<td>Keys such as INSERT (INS), DELETE (DEL), and BACKSPACE are command keys. When the INSERT key is turned ON, it helps you overwrite characters to the right of the cursor. When the INSERT key is OFF, it helps you enter text or characters to the right of cursor, without overwriting this text or characters. The DELETE key and the BACKSPACE key are used to remove typed text, characters, and other objects on the right and left side of the cursor, respectively.</td>
</tr>
<tr>
<td><strong>7.</strong></td>
<td>Keys such as the arrow keys, HOME, END, PAGE UP, and PAGE DOWN are navigation keys. You use the arrow keys to move the cursor up, down, right, and left. The HOME key moves the cursor to the left end of a line of text. The END key moves the cursor to the end of a line. The PAGE UP key is used to move one page up and the PAGE DOWN key is used to move one page down while viewing a document.</td>
</tr>
</tbody>
</table>
8. Not all keyboards have a numeric keyboard. If available, this is a separate set of keys with numbers from 0 to 9, the decimal point, special characters, and navigation symbols. The NUM LOCK key on this keypad allows you to switch between the numeric and the navigation keys.

**Using a Mouse**

A mouse is a small device that you can use to move, select, and open items on your computer screen. The mouse is usually kept on the desk next to the keyboard. Most mouse devices have at least two buttons, left and right. Most of the actions are performed by clicking the left button. The right button is used for specific functions. Some advanced types of mouse devices provide additional buttons to speed up common tasks, such as scrolling text.

As you move the mouse on your desk, a pointer moves correspondingly on your screen. The mouse allows you to select an item on the screen. As you move the pointer over different areas of the screen, the items or the pointer change. These changes indicate that you can click an item to open it, or see more of its options. You can open an item by moving the pointer to it, and clicking the left mouse button twice. In a document, you can use the mouse to select a position to start typing. You need to position the pointer in the document, click where you want to insert text, and then use your keyboard to begin typing.

To move an item, you need to click it, and then holding the mouse button down, move the item to a different location. After you move the item to the new location, you release the mouse button. The right button on the mouse is used to display a menu. The options on this menu include the most common tasks, such as copying text from one location and pasting it to another location. These are called context-sensitive menus. These menus help you complete tasks quickly.

Most mouse devices also have a wheel that help you to scroll through documents or pages. To scroll, place your finger on the wheel and roll it back and forth. This moves the document up and down. There are different types of mouse devices available in the market. A regular mouse has a rubber or a metal ball on the underside. The mechanical movement of the mouse device moves the ball. This movement further moves the pointer on the screen. An optical mouse can be used in the same way as a regular mouse. However, it does not have a ball. It uses a laser to detect movement.
Exercise

Write the types of each device in the column given:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Device</th>
<th>Type of Device: (Input, Output or Storage)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Mouse</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Microphone</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Keyboard</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>CD-ROM</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Printer</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>Stylus</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Floppy Disk</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Headphone</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>Scanner</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>Hard Disk</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>Speaker</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Monitor</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>DVD-ROM</td>
<td></td>
</tr>
</tbody>
</table>

Assessment

Write the appropriate category for each of the statements given in the table:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Statement</th>
<th>Category (Hardware, Operating System, Application)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Helps control the physical components</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Allows you to play games or watch movies</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Helps provide input to a computer</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Ensures reliable operation of the computer</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Helps you view the output of a computer</td>
<td></td>
</tr>
</tbody>
</table>
SESSION 6: COMPUTER OPERATING SYSTEMS

An operating system performs four primary functions. It manages and controls the hardware connected to a computer. It helps other programs running on a computer to use the hardware. It helps you organize and manage files and folders on the computer. It provides a user interface that allows you to interact with the hardware, the operating system itself, and other programs.

Relevant Knowledge

An operating system controls how programs work with each other and how they interact with the computer hardware. It also creates the file system that determines how your data is stored within a storage device. The performance of an operating system depends on the number of bits that it can transfer at a time. Early operating systems could transfer only 8 bits of data at a time and were called 8-bit operating systems. Operating systems, such as Windows Vista, can transfer data up to 32 bits or 64 bits at a time, depending on the hardware of the system. An operating system such as Windows Vista provides a GUI that makes it easier for you to give instructions to a computer.

As you are now, familiar with the basics of a computer system and you could now switch on your computer system, you must be curious to work on the system. Look at the screen – you will find some pictures and text present on the various parts of the screen. A sample view of the desktop and its various components are illustrated in Figure 11.

Desktop - A desktop is a computer display area of windows that contains the various objects one might find in the computer. On the desktop of your computer, you may find pictures with the following labels: (i) My Computer or Computer – it contain all the storage areas of your computer (Hard Disk, Floppy Disk, CD/DVD etc.), (ii) Recycle Bin – it contains all the deleted content of your computer, (iii) My Network Places or Network – it contains the information of interconnected computers (if any), (iv) My Documents or Documents – it contains a common area to store various types of files on the computer. You may find some more pictures on the desktop with self-explanatory labels.

All these pictures, which you see on screen, are known as “icons”. At the bottom of desktop, you can see a bar (known as Taskbar), left side of which may contain a Start button, right side may contain date, time and active device information and the center of the taskbar may have some shortcuts and active applications. Shortcuts are the direct links to help the user to start the application, which may be stored anywhere on the computer.
It is also important for you to know, which area of desktop will perform an operation on left click of a mouse button. You can click on any shortcut or buttons, to start an application or to perform the desired task. Now, just look at the figure 2 to view a sample menu and sub-menu display, which you will see after clicking the Start Menu. Here, you will see various options you can choose from.

The common ones are: (i) **Help and Support** to provide documented form of basic help information to work on the computer, (ii) **Search** to help you searching for an applications or a file, (iii) **Settings** to customize various settings (Display, Hardware, Software etc.) of the computer, (iv) **Documents** to provide you quick links to all recent documents, which were opened/modified recently on the computer, (v) **Programs** to display a submenu with list of various applications available on the computer to work on. The Start menu also gives you an option to Log Off/Shut Down/Turn Off the computer. These options may vary from version to version and OS to OS. You can easily identify them, as you will find similar names for them.
Let us now, discuss about some common applications, which come along with the operating system. **Notepad** is one such application, which allows you to type in the content in a text file, save it on the hard disk and print the same, if required.

In **My Computer** or **Computer**, you will find a list of all the Secondary Storage device(s) available on your computer. These drives are represented in the form of alphabets (from A: to Z:). For example C: Drive normally represents the first hard disk present in your system, D: Drive may represent the second hard disk or CD/DVD Drive. A: and B: Drives normally represent Floppy Drives, last alphabets are normally used to represent Network Drives (i.e., the hard disk or DVD drive of another computer). A sample content is shown below in Figure 3:

The data on computer can be organized in files and folders. Files are the immediate container of the content created by you using a particular tool/application. Like using
Information Technology – Class IX

Notepad, you create a Text file “REPORT.TXT” containing report of a particular program organized in your school, you might create another text file “LESSON1.TXT” containing a list of assignments to be given in a class and using paint tool, you might create a file “MYCREATION.BMP”. All these are known as “files”. When you have many files loaded or stored on the computer, you would like them to be organized in separate groups to manage your files easily. You can create Folders on computer to represent these groups, where each folder can hold any number of file(s) or sub-folder(s). For example, you can create a folder as Movies with sub-folders as Hindi and English to contain Hindi Movie Files and English Movies Files respectively, and you may create a Folder with name Academics with sub-folders as School Work, Homework and Downloaded resources to hold related files. Figure below illustrates a Folder as “CBSE VOCATIONAL 2011” with its content as Files “ITBookReference.txt, Logo.JPG, Excercise1.odt, Expenses.ods, Class9Lesson1.odp, RESUME.pdf”.

<table>
<thead>
<tr>
<th>Folder</th>
<th>Various Files</th>
</tr>
</thead>
</table>
| CBSE VOCATIONAL 2011 | ITBookReference.txt  
Text Document  
2 KB                  |
|                      | RESUME.pdf  
Adobe Acrobat Document  
12 KB                 |
|                      | Excercise1.odt  
OpenDocument Text  
8 KB                   |
|                      | Class9Lesson1.odp  
OpenDocument Presentation  
11 KB                  |
|                      | Expenses.ods  
OpenDocument Spreadsheet  
7 KB                   |
|                      | Logo.JPG  
1218 x 617  
JPG File              |

**Fig. 6: Files and Folders**
## Function | Description
--- | ---
Provides a user interface | Many operating systems provide visual elements, such as icons and menus, to help you interact with a computer. You can use a mouse to select icons and issue commands. For example, you can double-click a file to open it with the appropriate program.

Provides utilities to configure your system | A GUI-based operating system provides easy-to-use utilities to help you configure your computer. These utilities are small programs that help you perform specific functions, such as connecting to a network, managing resources, and adding new programs to your computer.

Helps manage computer resources | An operating system helps manage hardware. Programs communicate with the operating system to work with the required hardware, such as the CPU, to complete the required tasks.

Helps secure data by controlling user access to a computer | An operating system allows you to secure your data. It helps you specify authentication and authorization rights to control access to your computer and its resources. **Authentication** is the process by which the computer system validates a user’s logon information. An operating system can help you create a username and a password, so that only those users who know the username and password can access the resources on your computer. In addition, you can associate specific permissions to each username. This is called **authorization**. For example, you can prevent users from printing documents from your computer.

### Managing Files and Folders
Suppose you own a book shop. To manage it efficiently, you need to first categorize books based on their subject, such as management or fiction. You can then arrange these books in separate sections of a cabinet. You need to provide appropriate name to each section so that it is easier to locate a book. Similarly, in the Windows operating system, you use Windows Explorer to arrange files in appropriate folders. Windows Explorer is a program that helps you locate and open files and folders.

The Windows Explorer window in Windows Vista is divided into two sections, called panes. The pane on the left side, called the navigation pane, displays the structure of drives and folders on your computer. A folder is a container for programs and files in GUI interfaces. It is represented by an icon of a file folder on the screen. It can hold both files and additional folders. The pane on the right is called the content pane. It displays
the contents of a drive or folder. You can select folders from the list displayed in the navigation pane to view its contents in the content pane.

In this simulated lab, you will use Windows Explorer to expand a folder, create a new folder, and rename a folder. You will also use Windows Explorer to copy a file, move a file, and delete a file from a folder. The following table contains the steps of an online simulation.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>To view the Activities folder, click the <strong>Start</strong> button, and then click <strong>Documents</strong>.</td>
</tr>
<tr>
<td>2.</td>
<td>To view the contents of the <strong>Vacation folder</strong> (for example), in the navigation pane, under the <strong>Activities</strong> folder, click the <strong>Vacation</strong> folder.</td>
</tr>
<tr>
<td>3.</td>
<td>To view the contents of the Vacation folder as a simple list, click the <strong>Views</strong> arrow, and then click <strong>List</strong>.</td>
</tr>
<tr>
<td>4.</td>
<td>To create a new folder in the Vacation folder, click <strong>Organize</strong>, and then click <strong>New Folder</strong>, for example.</td>
</tr>
<tr>
<td>5.</td>
<td>To name the new folder, for the purposes of this exercise, press <strong>SPACEBAR</strong> to have the name typed for you, and then press <strong>ENTER</strong>.</td>
</tr>
<tr>
<td>6.</td>
<td>To rename the Activities folder, in the navigation pane, click <strong>Activities</strong>, and then, for the purposes of this exercise, press <strong>SPACEBAR</strong> to have the folder right-clicked for you.</td>
</tr>
<tr>
<td>7.</td>
<td>On the shortcut menu, click <strong>Rename</strong>, for the purposes of this exercise, press <strong>SPACEBAR</strong> to have the folder name typed for you, and then press <strong>ENTER</strong>.</td>
</tr>
<tr>
<td>8.</td>
<td>To move a file to a new location, in the content pane, click the <strong>Insurance Agency</strong> file (for example), click <strong>Organize</strong>, and then click <strong>Cut</strong>.</td>
</tr>
<tr>
<td>9.</td>
<td>To paste the file in the Legal folder, in the navigation pane, click the <strong>Legal</strong> folder, click <strong>Organize</strong>, and then click <strong>Paste</strong>.</td>
</tr>
<tr>
<td>10.</td>
<td>To verify that the Insurance Agency file has been moved, in the navigation pane, click the <strong>Volunteer Activities</strong> folder (for example).</td>
</tr>
<tr>
<td>11.</td>
<td>To copy a file, in the content pane, click the <strong>Notes</strong> file (for example), click <strong>Organize</strong>, and then click <strong>Copy</strong>.</td>
</tr>
<tr>
<td>12.</td>
<td>To paste the file, in the navigation pane, point to the <strong>Vacation</strong> folder, click the arrow that is located to the left of the <strong>Vacation</strong> folder, and then click the <strong>Memos</strong> folder (for example).</td>
</tr>
</tbody>
</table>
13. Click Organize, and then click Paste.

14. To delete the Draft Garden Report file (for example), in the navigation pane, click the Volunteer Activities folder (for example).

15. In the content pane, click the Draft Garden Report file, click Organize, and then click Delete.

16. To confirm that you want to send the file to the Recycle Bin, in the Delete File message box, click Yes.

SESSION 7: PERFORMING BASIC FILE OPERATIONS

Every file has an associated format that defines the way data is stored in the file. The file format is identified by a period (also called a dot) appended to a file name, followed by three or four letters. The following are some of the more common file formats:

- Word documents (.doc/.docx)
- Images (.gif and .jpg)
- Executable programs (.exe)
- Multimedia files (.wma and others)

Relevant Knowledge

When you open a file, the operating system selects an appropriate program to display the contents of the file based on the file format.

You will now create and save a file, browse the file, delete the file, and restore the file. The following table contains the steps:

1. To view a program that is installed on a computer, click the Start button, and then click All Programs.

2. To open WordPad, click Accessories, and then click WordPad.

3. To add text in the document, in the Document - WordPad window, for the purposes of this exercise, press SPACEBAR to have the text typed for you.

4. To save the document, click the File menu, and then click Save As.
<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>5.</strong></td>
<td>To name the document, in the Save As dialog box, in the File name box, for the purposes of this exercise, press SPACEBAR to have the name typed for you, and then click Save.</td>
</tr>
<tr>
<td><strong>6.</strong></td>
<td>To close the Sample file, click the Close button.</td>
</tr>
<tr>
<td><strong>7.</strong></td>
<td>To view a different program, click the Start button, and then click All Programs.</td>
</tr>
<tr>
<td><strong>8.</strong></td>
<td>To open Windows Explorer, click Accessories, and then click Windows Explorer.</td>
</tr>
<tr>
<td><strong>9.</strong></td>
<td>To open the Sample file, double-click Sample.</td>
</tr>
<tr>
<td><strong>10.</strong></td>
<td>To close the file, click the Close button.</td>
</tr>
<tr>
<td><strong>11.</strong></td>
<td>To delete the Sample file, ensure that the Sample file is selected, click Organize, and then click Delete.</td>
</tr>
<tr>
<td><strong>12.</strong></td>
<td>To confirm that you want to send the file to the Recycle Bin, in the Delete File message box, click Yes.</td>
</tr>
<tr>
<td><strong>13.</strong></td>
<td>To close Windows Explorer, click the Close button.</td>
</tr>
<tr>
<td><strong>14.</strong></td>
<td>To restore the Sample file to its original location, double-click Recycle Bin.</td>
</tr>
<tr>
<td><strong>15.</strong></td>
<td>In the Recycle Bin window, click Sample, and then click Restore this item.</td>
</tr>
</tbody>
</table>

**Managing/Customizing Files and Folders**

A file in computer terminology can be considered as the modern counterpart of paper documents which traditionally were kept in offices and libraries. The term file is used in computers for a block of arbitrary information, or resource for storing information. Text and picture files icons are shown below for your reference with filenames Bill_Gates.jpg, Thoughtsofpranav.txt, Steve.jpg, pranav_mistry.jpg, AmoutSteveJobs.txt and Microsoft.jpg.

Here are some of the ways to rename, copy, cut and paste files.
Rename a file:

Close the file to be renamed, if opened. Locate and Select the file [1] click the right button of mouse [2] Select Rename [3] The filename will become editable – type the new name and press ENTER Key on the keyboard.

OR

Locate and Select the file [1] Click F2 button of mouse [2] The filename will become editable – type the new name and press ENTER Key on the keyboard.

To delete a file:

Close the file to be deleted, if opened. Locate and Select the file [1] Click the right button of mouse [2] Select Delete [3] Pop up will ask to confirm File Delete – Click on YES.
OR
Locate and Select the file [1] Press Delete key on keyboard [2] Pop up will ask to confirm File Delete – Click on YES.

To COPY-PASTE a file:

OR

Note: In Copy-Paste, the file will remain there in the original location and a copy of the same will be saved on the new location.

To CUT-PASTE a file:

OR

Note: In Cut-Paste, the file will be removed from the original location and will be copied in the new location.

A folder is basically a container, in which the files can be organized in the computer’s storage devices. We create folders to keep different kind of information separately for later use. You already have seen some icons of some files above and you can very well put those files in the appropriate folders.

To rename a folder:
Close all the applications, which are using the folder to be renamed.

OR

Locate and Select the folder [1] Click F2 button of mouse [2] The folder name will become editable – type the new name and press ENTER Key on the keyboard.

To delete a particular folder:
Close all the applications, which are using the folder to be deleted.
Locate and Select the folder [1] Click the right button of mouse [2] Select Delete [3] Pop up will ask to confirm Folder delete – Click on YES.

OR
Locate and Select the folder [1] Press Delete key on keyboard [2] Pop up will ask to confirm File Delete – Click on YES.

To COPY-PASTE a folder:

OR

Note: In Copy-Paste, the folder will remain there in the original location and a copy of the same will be saved on the new location.

To CUT-PASTE a folder:
Close all the applications, which are using the folder to be deleted.

OR
Note: In Cut-Paste, the folder will be removed from the original location and will be copied in the new location.

If we wish to select all the files with in a folder in one go, we can simply go in that folder and select them by pressing **CTR&A** together as shown in the following picture – all the files in the folder are selected. After selecting the files, we can Copy or Cut these files with the help of **CTR&C** or **CTR&X**.

![Selecting all files in a folder](image)

**Fig. 4: Selecting all files in a folder**

We can select some of the files, which are one next to each other in a particular folder with the help of **Shift** and direction keys (Left, Right, Up and Down Keys) as shown in the following picture – the first four files in a sequence are selected.

![Selecting files in sequence](image)

**Fig. 5: Selecting files in sequence**

We can also select some of the files, which are not in a sequence by holding **CTR** key and using Left button of Mouse one by one as shown in the following picture – three files selected, which are not in sequence.
Fig. 6: Selecting Files (Not in sequence)

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Start and shut down computer.</td>
</tr>
<tr>
<td>2.</td>
<td>Log on and log off.</td>
</tr>
<tr>
<td>3.</td>
<td>Identify the key components of the desktop and recognize and use features of the window environment.</td>
</tr>
<tr>
<td>4.</td>
<td>Identify text and picture files in folder.</td>
</tr>
<tr>
<td>5.</td>
<td>Use the mouse to click on the icon.</td>
</tr>
<tr>
<td>6.</td>
<td>Scroll the mouse for various operations.</td>
</tr>
<tr>
<td>7.</td>
<td>Create, rename and delete files, folders and subfolders.</td>
</tr>
</tbody>
</table>

**Assessment**

1. Which two keys help you copy a file/folder?
2. What combination of keys helps you to select all the files in a folder?
SESSION 8: THE INTERNET

The Internet has changed the way people communicate with each other. The Internet has also revolutionized the way information is made available to the world. With the help of the World Wide Web, a popular service on the Internet, you can now access information from a vast pool of resources in a few seconds. You can use the Internet to perform your day-to-day personal tasks or to find better jobs. For example, if you have just completed your studies and are searching for a job, you can use the Internet to create and submit your resume over the Internet. Companies use the Internet to search for potential candidates.

Relevant Knowledge

Uses of the Internet

Imagine a scenario where you want to communicate by using a computer on your network with a computer on another network. For this, both the networks need to be connected. The Internet is a collection of networks that are connected together for exchange of information. When the computer is connected to the Internet, it is said to be online. This illustration describes the various uses of the Internet.
### Requirements for an Internet Connection

To connect to the Internet, you need a computing device, a connection device, and an Internet Service Provider (ISP). The computing device can be a personal computer, a portable computer, or even a mobile device, such as a cell phone or a handheld device.

You need a connection device, such as a modem, to connect your computer to the Internet. A modem converts digital information into analog information and transmits it over a phone line. A modem can either be built-in your computer, or externally attached to it.
An ISP is a company that provides Internet connectivity to individuals, businesses, and organizations. It may also provide additional services such as the storage space to share your personal content. There are different methods by which you can connect to the Internet. When you connect to the Internet by using cables, the connection is called a physical connection.

You can also connect to the Internet by using wireless technology. A computing device that supports wireless technology has a Wireless Fidelity or the Wi-Fi card that provides wireless communication between the computing device and the network. A Wi-Fi card is not physically connected to an ISP.

Another device you need for wireless connectivity is an access point (AP). An AP is used to connect a wireless computing device to a wired network. This wired network may belong to an ISP. You can then connect to the Internet through the ISP.

**Bandwidth**

Bandwidth is the amount of data that can be transmitted over a network in a certain amount of time (in layman’s language, you can equate it to a pipe). The amount of water that can flow through it depends on its thickness. Similarly, the amount of data that your network can receive/send depends on its Bandwidth). Bandwidth is measured in Mbps (megabits per second), Kbps (kilobits per second), or bps (bits per second). If the bandwidth of a network is 1 Mbps, then 1 megabit of data can be transmitted over that network in 1 second.

The actual rate of transfer of data will vary depending on the ISP’s equipment, the type of Internet connection, and the number of people using the same connection at one time. You can use various types of technologies, such as dial-up and cable modem, to connect to the Internet. Each technology supports a different bandwidth. Sometimes you might connect to the Internet by using more than one type of connection. For example, in some airports, you can use a wireless connection to connect to a cable modem.

<table>
<thead>
<tr>
<th>Type of connection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dial-up</td>
<td>Most dial-up connections offered today allow data transfer rates up to 56.6 Kbps.</td>
</tr>
<tr>
<td>Type of connection</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Digital Subscriber Line (DSL)</td>
<td>If you use a DSL connection, you are always connected to the Internet. A type of DSL connection is the asymmetric digital subscriber line (ADSL) connection. To use an ADSL connection, you must have a special ADSL modem. The date transfer rate of DSL Internet connection is 384 kbps to 8 Mbps.</td>
</tr>
<tr>
<td>Cable modem</td>
<td>If you have a cable TV connection, you can get a high-speed Internet connection from the cable TV provider. Using this type of connection, you can be connected to the Internet at all times. This connection supports data transfer rates of 4 Mbps.</td>
</tr>
<tr>
<td>T1</td>
<td>T1 lines provide a dedicated phone line connection to connect to the Internet. T1 are a popular option for businesses today. This connection supports data transfer rates of 1.544 Mbps.</td>
</tr>
<tr>
<td>Wireless</td>
<td>You can connect to the Internet by using wireless technology. When you connect to the Internet by using wireless technology, it further connects to wired connections such as a cable modem. Although you may connect to a high-speed cable connection, this wireless connection might not provide you the full data transfer rates of the wired connection. The data transfer rates of wireless Internet connections can range from 11 Mbps to 45 Mbps. Some wireless connections support a bandwidth of several gigabits per second (Gbps).</td>
</tr>
</tbody>
</table>
**Internet Connectivity**

To start with using the Internet, the computer needs to be connected with internet using an internet account. Some of the internet service providers in India are BSNL, MTNL, Reliance, Airtel, TataIndicom. There are different kinds of internet connections like a Data Card, Broadband connection, and Leased Line.

The home users normally take internet connection from the telephone connection provider. The speed of such connections varies from 256 kbps to 2 mbps. Such connections are shared with many users at the same time and so its speed varies depending on various users’ internet activity at that point of time.

The corporate users prefer subscribing a leased line internet connection for faster, effective and reliable connectivity. The speed of such connections varies from 1 mbps to 100 mbps. These connections are provided with the help of dedicated connectivity with service provider’s internet server.

Internet Browser is the software, which helps you to access web pages from various websites. There are various Internet browsers available such as Google Chrome, Mozilla Firefox, Safari, Opera and Internet Explorer. These browsers can be downloaded freely from their relevant websites.

**Basic tips to search or information using search engines**

Searching information on the internet is simple. Start the Internet Browser and just type whatever comes to mind in the search box, hit Enter or click the [Search] button, and the search engines such as Google will search the web for content that’s relevant to your search. Most of the time, you will be able to find exactly what you are looking for just by typing the words in search box.

However, the following tips can help you make the most of your searches.

1. If you type the words [India and America] will give different results than when you type only [India] or only [America]
2. Every word, what you type as (‘search word’) matters. Generally, all the words you put in the query are used by the search engines.
3. Search is always case insensitive. A search for [Delhi CAPITAL of India] is the same as a search for [delhi capital of india].
4. Generally, punctuation symbols are ignored, such as @#$%^&*()=+[]\.
To make sure that your search engine returns the most relevant results, there are some exceptions to the rules above, which are as follows.

**Specific tips for better searches**

Keep the searching text (word or words) simple. If you are looking for a particular school, just enter its name, or as much of its name as you can recall. If you’re looking for a particular product, place, or concept - start with its name. Think of some of the key words which it is likely to contain and use these words to search for the site. For example if you want to search for a recipe for preparing different kinds of soups, you could use the key words:

“Soup Recipe prepare”.

Remember, a search engine is a computer program, and it is not a human. It is a program that matches the words you give to pages on the World Wide Web. Use the words that are most likely to appear on the web page. For example, instead of saying [pain in my head], you should say [headache], because that’s the term a medical page will use. The query [which five countries produce maximum coconuts in the world] is very clear to us, but the document that gives the answer may not have those words. Instead, use the query [Top 5 coconut producing countries], because that is probably what the right page will say.
<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
<th>Yes</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Establish an internet connection.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>Search information on the web using appropriate key words.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Assessment

1. Name any three internet service providers in India?
2. Name any three internet browsers?
3. Name any two internet search engines?
4. Which of two sets of words should be typed in search engines to get more appropriate results?
   (a) [What is the capital of India?] OR [Capital of India]
   (b) [Fastest Train] OR [Which train has the highest speed?]

SESSION 9: THE WORLD WIDE WEB

Relevant Knowledge

Imagine that you and your family have decided to go on a holiday to Bangkok, and you would like more information about the place. You will probably speak to your friends who have already visited Bangkok, or search for books that will provide the information you want. As a result, you spend a lot of time in gathering this information. By using the Web, you can quickly get information such as the hotel details or the places to visit in Bangkok.

In this session, you will learn the basic components of the Web. You will also learn to use a search engine to find information on the Web. In addition, you will learn to navigate Web sites for information and perform online transactions.

Introduction to the Web

The World Wide web or Web is a way of accessing and sharing information over the Internet by using Web browsers. It is an information-sharing model that is built on top of the Internet. The Web uses the HTTP protocol, only one of the languages used over the Internet, to transmit data. The Web also utilizes browsers, such as Internet Explorer or Firefox, to access Web documents called Web pages that are linked to each other via hyperlinks. The Web refers to the collection of information that is accessible on the Internet. The information is in the form of text, pictures, and sound, which are arranged logically and stored on computers known as Web servers. The Web is a very popular service on the Internet.
**Note:** Many people use the terms the Web and the Internet synonymously, but they are technically two different terms.

The following table describes the components of the Web.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web browser</td>
<td>A Web browser is a software program that enables you to view and interact with various resources on the Web. An example of a widely used Web browser is Microsoft Internet Explorer that displays both text and graphics. Windows Internet Explorer 7 is available with Windows Vista. Some browsers, such as Internet Explorer 7, offer a new feature called tabbed browsing to facilitate better Web browsing. Using tabs, you can view multiple Web sites in a single browser window and easily switch from one Web site to another. Some Web sites may contain content in the form of animation, video, or audio files. To view these files, you need additional programs known as add-ons. An add-on is a software program that adds features to your browser and enhances your Internet experience. Add-ons provide added functions by allowing the Web browser to access and run files that are included in Web pages. For example, Microsoft Silverlight is a browser add-on that is required to view high-quality videos by using Web browsers.</td>
</tr>
<tr>
<td>Web page</td>
<td>A Web page is a formatted text document on the Web that a Web browser can display. Most Web pages on the Internet allow you to quickly move to another Web page. You can do this by clicking a hyperlink, commonly called a link. Clicking a link opens the new Web page in your Web browser. You can access existing Web pages or even create and publish new Web pages on the Web. You can create Web pages by using a software language known as Hypertext Markup Language (HTML). Web browsers use HTML to display Web pages. Hypertext is a method of linking text with other text that helps you to easily browse through related non sequential topics on the same page or on other Web pages.</td>
</tr>
<tr>
<td>Web site</td>
<td>A Web site is one or more Web pages that reside on a single server. This server is known as a Web server and is connected to the Internet. The first Web page that is displayed when you access a Web site is known as the home page. Every Web site has a unique home page.</td>
</tr>
</tbody>
</table>
Overview of Web Addresses

Every Web site on the Web is stored on a computer that is part of a vast network. To access a Web site, you need to access the computer on which the Web site is stored. Just as every house has a unique address, each computer on the Web is identified by a unique address, known as the Internet Protocol (IP) address. The IP address is a numeric address that specifies the exact location of a computer on the Web. You can access a computer on the Web by using an IP address, such as 192.168.0.1.

The IP address is linked to a corresponding domain name because it is easier to remember names than a string of numbers. For example, the corresponding domain name for the IP address 127.0.0.1 can be proseware.com. Web browsers can use either the domain name or the IP address to locate and display a Web page.

A Web site for a domain is accessed with the help of a unique alphanumeric address known as the Web address. The Web address is also known as the Uniform Resource Locator (URL), which specifies the protocol to be used and the exact location of the Web site. A protocol is a standard method of transferring data between different computers. In the example http://www.ugc.ac.in/page/Annual-Report.aspx, http indicates what protocol to use and www.ugc.ac.in/page/Annual-Report.aspx specifies the exact location of the Web page. The following table lists the components of a URL.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>http://</td>
<td>Indicates the protocol to be used to access a file.</td>
</tr>
<tr>
<td>www</td>
<td>Indicates that the Web site is on the Web.</td>
</tr>
<tr>
<td>ugc</td>
<td>Indicates the name of the domain.</td>
</tr>
<tr>
<td>ac.in</td>
<td>Indicates the type of domain.</td>
</tr>
<tr>
<td>/page/Annual-Report.aspx</td>
<td>Indicates the path of the document.</td>
</tr>
</tbody>
</table>

A URL also includes a domain name suffix that indicates the type of organization to which the Web site belongs. For example, in the domain name microsoft.com, the domain name suffix is .com. The following table lists some examples of domain name suffixes.
Information Technology – Class IX

<table>
<thead>
<tr>
<th>Suffix</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.com</td>
<td>Indicates that the Web site is for a commercial organization.</td>
</tr>
<tr>
<td>.edu</td>
<td>Indicates that the Web site is for educational institutions, such as schools, colleges, and universities.</td>
</tr>
<tr>
<td>.net</td>
<td>Indicates that the Web site is for a network-oriented organization or for an ISP.</td>
</tr>
<tr>
<td>.org</td>
<td>Indicates that the Web site is for a nonprofit organization.</td>
</tr>
<tr>
<td>.info</td>
<td>Indicates that the Web site is informative in nature.</td>
</tr>
<tr>
<td>.museum</td>
<td>Indicates that the Web site is used for a museum or for an individual of the museum profession.</td>
</tr>
</tbody>
</table>

Note: There are country-level domains that are specifically used by a country or an independent territory. Some examples of country-level domains include .ke for Kenya, .in for India, and .jp for Japan.

Working with Internet Explorer

The Internet offers a range of services, such as file transfer between Internet users, electronic mail for sending messages, or Web sites for viewing news. You can use the Internet and its services to search and apply for jobs, send messages to other Internet users, watch movies, and buy and sell products.

In this simulated lab, you will use Internet Explorer 7 to navigate through a Web site on the Web. In addition, you will save a Web page and then open multiple Web sites in one browser window. The following table contains the steps of an online simulation.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>To open Internet Explorer, click Start, and then click Internet.</td>
</tr>
<tr>
<td>2.</td>
<td>To open a Web site, for the purposes of this exercise, press SPACEBAR to have the address typed for you in the Address bar, and then press ENTER.</td>
</tr>
<tr>
<td>3.</td>
<td>To view the Weather Web page, under the Page options button, click the Weather link.</td>
</tr>
<tr>
<td>4.</td>
<td>To view the Forecasts Web page in a new Internet Explorer 7 window, in the left column, for the purposes of this exercise, press SPACEBAR to have the hyperlink right-clicked for you, and then click Open in New Window.</td>
</tr>
</tbody>
</table>
1. To open Internet Explorer, click Start, and then click Internet.

5. To refresh the Web page, click the Refresh button that is to the right of the Address bar.

6. To search for the weather forecast for Denver city, for the purposes of this exercise, press SPACEBAR to have the keyword typed for you, and then click Go.

7. To go back to the previous Web page, click the Back button that is to the left of the Address bar.

8. To open a new Web page in the same window, click the New Tab button.

9. To switch to another tab, click the Quick Tabs button, and then click the first Web page.

10. To view the menu bar, on the Command bar, click Tools, and then click Menu Bar.

11. To save the Web page, click the File menu, and then click Save As.

12. To specify a name for the Web page, in the Save Webpage dialog box, in the File name box, for the purposes of this exercise, press SPACEBAR to have the name typed for you, and then click Save.

13. To add a Web page to your Favorites list, click the Add to Favorites button, and then click Add to Favorites.

14. To specify a name for the Web site, in the Add a Favorite dialog box, for the purposes of this exercise, press SPACEBAR to have the name typed for you in the Name box, and then click Add.

15. To view a Web site that you previously visited, click the Favorites Center button, and then click History.

16. In the Favorites Center pane, click Today, click weather.msn (weather.msn.com), and then click the first link.

17. To close Internet Explorer 7, on the title bar, click the Close button.

18. To close all tabs of Internet Explorer 7, in the Internet Explorer message box, click Close Tabs.

**Searching for Information**

With multiple Web sites on the Web, it is possible that the information provided by a Web site is not authentic. For example, you are a broker, and you need to track the price
variations in the market. The information that you get from the Web sites must be accurate to ensure a correct analysis of the price variation.

There are various guidelines that will help you evaluate a Web site.

<table>
<thead>
<tr>
<th>Guideline</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Includes reliable content</td>
<td>A good Web site should state the various sources, such as other Web sites, books, or names of experts, for the content that is displayed on the Web site.</td>
</tr>
<tr>
<td>Answers your questions</td>
<td>The Web site should answer your questions by giving you valid and specific information.</td>
</tr>
<tr>
<td>Includes content by authors with credentials</td>
<td>The people who have written the content that is displayed on the Web site should preferably be writers with reliable credentials.</td>
</tr>
<tr>
<td>Includes current content</td>
<td>The Web site should be well organized to help you easily navigate within the Web site. All the links in the Web site should be working, and the content on the Web site should be regularly updated.</td>
</tr>
</tbody>
</table>

**Search Engines**

To search for information on a specific topic, you use a search engine. After you specify a keyword in a search engine, it displays a list of Web sites that contain information related to that keyword. This type of search is called keyword search. An example of a search engine is Windows Live Search provided by Microsoft, which helps you to quickly find Web sites that contain information relevant to your search. A search engine consists of directories, which group similar information. For example, the Weather directory on the MSN Web site contains Web pages that provide information about weather. In a search engine, you can also perform a directory search. You can browse to a specific directory and then search the directory for specific information. For example, you can browse to the Shopping directory on the MSN Web site and then search for keyboard. The results contain the links for Web pages from the shopping directory that relate to keyboard.

You can also search information with the help of portals, which are Web sites that offer information related to a specific topic in the form of a directory. The information on a portal is usually arranged in a specific order. A portal acts as a starting point to a number of resources on the Web. For example, on the MSN Web site, various Web pages are linked together to form the complete Web site. These Web pages act as gateways to a host of information on the Web. From the MSN Web site, you can access your e-mail, perform
Information Technology – Class IX

a keyword or a directory search, participate in online discussions, find the location of a movie theater, join Web communities, and get the latest news.

In this demonstration, you will see how to perform a directory and a keyword search in a search engine. The following table contains the steps and transcript of an online demonstration.

Steps

| 1 | Searching for Information |
| 2 | To open Internet Explorer, click Start, and then click Internet. |
| 3 | To open a search engine, in the Address bar, type the address of the required Web site, and then press ENTER. |
| 4 | To browse to the required directory, click MSN Directory, click View by Category link, and then under a category, click Encyclopedia. |
| 5 | To perform a directory search, in the Search Encarta box, type the required keyword, and then click Search Encarta. |
| 6 | To view the required information from the list of resources, click the most appropriate link. |
| 7 | To return to the homepage, in the upper-right area, click MSN home. |
| 8 | To perform a keyword search, in the Live Search box, type the required keyword, and then click Search Web. |

Transcript

[Image of a computer screen showing Internet Explorer and search results]
The World Wide Web is a vast collection of information. You can use a Web browser, such as Internet Explorer 7, to search for the specific information that you want.

You can locate information on the World Wide Web by using a search engine. With a search engine, you can look for specific information by performing either a keyword search or a directory search. The search engine retrieves information that matches your search criteria.
Using a directory search, you can limit your search to a specific directory on a Web site. For example, the MSN Web site includes a directory for an online encyclopedia called Encarta.

You can use Encarta to find information about a specific topic. For example, you can search for information about the history of computers. The results page displays a list of links to the resources in the directory that provide information about the history of computers. The search results include a part of the information that is included in each retrieved Web page and a link for the Web page.

You can choose the most appropriate link from the results page.
Unlike a directory search, a keyword search returns results from various Web sites on the World Wide Web. For example, if you search for history of computers, the results page displays links from all the Web sites on the World Wide Web that have information related to your keyword.

**Introduction to e-Commerce**

E-commerce refers to the business transactions made over the Internet, such as buying and selling items online. The *online purchase* requires you to provide your credit card details. To ensure a secure transaction, you must provide your credit card details only to reputed Web sites. In addition to making *online transactions*, e-commerce includes *online stock trading* that gives you an opportunity to buy and sell shares in the stock market. You can also check your bank account status or insurance details online.

You can purchase online tickets to visit a museum. The illustration below describes the steps to buy online tickets to visit a museum.
To purchase online tickets to visit a museum, access the museum’s Web site. You need to create a new account on the Web site. While creating:

1. A new account, you need to provide details such as a user name, a password, and your address in a registration form. You will then receive an authentication to make an online transaction on the Web site.

2. To purchase online tickets, you need to select the date and the number of tickets you want to purchase.

3. You can also compare the prices of the tickets available.

4. Before you complete the process of purchasing the tickets, you need to provide your credit card details along with the shipping address.

5. After you submit these details, a Web page is displayed indicating that your online transaction is complete. It also provides you a transaction code that you can use for any further queries related to this purchase.

Exercise

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Search for the required information on the world wide web using a search engine</td>
</tr>
</tbody>
</table>
Assessment

A. State whether the statement is True or False.

<table>
<thead>
<tr>
<th>Statement</th>
<th>True/False</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. World Wide Web IS a part of the Internet.</td>
<td>True</td>
</tr>
<tr>
<td>2. Internet Explorer is a Web SERVER.</td>
<td>False</td>
</tr>
<tr>
<td>3. IP address is also known as URL.</td>
<td>True</td>
</tr>
<tr>
<td>4. You can open ONLY A SINGLE WEB SITE one window of a web browser</td>
<td>False</td>
</tr>
<tr>
<td>5. You CAN save a Web page on your computer.</td>
<td>True</td>
</tr>
<tr>
<td>6. A portal IS NOT a Website.</td>
<td>True</td>
</tr>
<tr>
<td>7. A reliable Website includes content by authors WITHOUT credentials.</td>
<td>False</td>
</tr>
<tr>
<td>8. Search engines are Web BROWSERS with special technology.</td>
<td>True</td>
</tr>
</tbody>
</table>

B. Tick the right answer from the options given below the statement.

1. Computer system has a unit, which displays the results from it.
   - A. Central Processing Unit
   - B. Memory Unit
   - C. Input Unit
   - D. Output unit

2. A computer system can accept textual input with the help of
   - A. Mouse
   - B. Video Camera
   - C. Keyboard
   - D. Barcode Reader

3. We can enter the audio form of data into a computer system with the help of
   - A. Mike
   - B. Scanner
   - C. Keyboard
   - D. Barcode Reader

4. One of the Internet Service provider in India
   - A. CBSE
   - B. BSNL
   - C. Microsoft
   - D. Infosys

5. Files can be organized in
   - A. Printer
   - B. Keyboard
   - C. Folder
   - D. Mouse
Information Technology – Class IX

6. Which of the following combination of keys are used for copying a particular file in a folder?
   A. CTR+V  
   B. CTR+X
   C. CTR+C  
   D. CTR+A

7. Which of the following is not an Internet Browser?
   A. Google Chrome  
   B. Internet Explorer
   C. Mozilla Firefox  
   D. Notepad

8. Identify a valid email id out of the following.
   A. jamesmartin@james.in  
   B. jame_martin.james.in
   C. james@martin@in  
   D. jamesmartin@james.in

9. Which of the following can be used for Audio-Video communication?
   A. Video Conferencing  
   B. Chat
   C. Email  
   D. IP Telephony

C. Fill in the blanks

1. Computer system has a unit, which displays ________________

2. A computer system can accept textual input with the help of ________________

3. ________________ can help us enter the audio form of data into a computer system.

4. ________________ has all the emails, which were received on an email id.

5. ________________ helps in searching for information from the internet.

6. Printer is an ________________ device.

7. ________________ is the combination of keys, which selects the entire content within a folder.

8. We should use ________________ names for files/folders.

9. ________________ provides dedicated connectivity with internet service provider’s server.
SESSION 10: DIGITAL TECHNOLOGY AND MEDIA DEVICES

Relevant Knowledge

Today, the functions of telephones, cameras, video recorders, media players, and Internet devices are being merged into a single portable device. The table below describes how merging technologies affect some commonly used digital devices and their features.

<table>
<thead>
<tr>
<th>Devices</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Audio and Video Players</td>
<td><em>MPEG Audio Layer 3 (MP3) players, CD players, and DVD players are examples of audio and video players. You can use MP3 players to play audio whereas you can use CD players and DVD players to play audio or video. If you have multipurpose CD players or DVD players, you can use them to play audio, video, and MP3 files. MP3 is a format that helps reduce the size of the files dramatically while having a small impact on quality. You can transfer MP3 files from a computer to an MP3 player.</em></td>
</tr>
<tr>
<td>Mobile Phones</td>
<td><em>A mobile phone is a wireless device that provides the capabilities of a traditional wired phone and allows you to make a call from almost any location. You can use a Web-enabled mobile phone to connect to the Internet, check your e-mail messages, or download songs and games from the Internet. If you have a mobile phone that has camera and multimedia features, you can take pictures, record short video clips, and play music and games. You can transmit pictures and videos from one mobile phone to another or to another person by using e-mail.</em></td>
</tr>
<tr>
<td>Video Game Systems</td>
<td><em>Microsoft Xbox is an example of a video game system that is similar to a personal computer. An Xbox has a motherboard and a hard disk and supports online gaming. You play games on an Xbox by using an Xbox game disk. You can also transfer audio files from audio CDs to the hard drive of an Xbox. Therefore, you can use an Xbox as an audio player. You can also play movie DVDs by using the latest Xbox system.</em></td>
</tr>
<tr>
<td>Personal Digital Assistants (PDAs)</td>
<td><em>A PDA is a handheld computer that is used as a personal organizer. A traditional PDA includes features, such as an address book, task list, and a calculator. You can connect a PDA to a computer to transfer information. If you have a Web-enabled PDA, you can connect it to the Internet, send and receive e-mail messages, and play multimedia files over the Internet. Some PDAs also contain a built-in digital camera. A smart phone is a mobile phone that provides the functions of a PDA in a phone. You can use a smart phone to access the Internet, play games, take pictures, and listen to songs.</em></td>
</tr>
</tbody>
</table>
### Devices

<table>
<thead>
<tr>
<th>Devices</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital Cameras</td>
<td>A <em>digital camera</em> stores images digitally on a memory device, such as a flash memory card or a mini hard disk, whereas a traditional camera stores images on film. Some digital cameras allow you to print images by connecting your digital camera directly to a digital printer.</td>
</tr>
<tr>
<td>Digital Video Cameras</td>
<td>You can use a <em>digital video camera</em> to record video and store it in a digital format. Digital camcorders and webcams are examples of digital video cameras. You can use a digital camcorder to record both video and audio and store it in a digital format on a storage device, such as a recordable CD or DVD. A <em>webcam</em> is also a digital video camera that captures images and transmits the images across the Internet. The images are transferred either continuously or at regular intervals of time. Webcams can be connected to a computer, or they can be wireless.</td>
</tr>
</tbody>
</table>

### Digital Audio

Audio is of two types, *analog* and *digital*. When you speak, the sound you create is in the analog or wave format. The sound that you hear is also in analog format. Computers are basically digital devices. Therefore, it is necessary to convert audio from the analog format to the digital format before using it on a computer.

*Digital audio technology* allows you to record, edit, and play digital audio files on a computer. Digital audio technology also lets you communicate with the computer by just speaking. This lesson introduces you to digital audio technology. It also briefly describes the concepts of copying and converting digital audio.

### Characteristics of Digital Audio

One of the important characteristics of digital audio is that it can be compressed. Audio files are generally large. Compressed audio files save space, allow portability, and are easier to transfer over the Internet. When you compress audio files, the quality of the audio file is generally affected.

Another important characteristic of digital audio is that it can be edited on a computer by using *audio editing software*. For example, you can use this software to move sections within an audio file or add effects. You can also use audio editing software to store an audio file in different formats on the computer. There are number of audio file formats that different programs use for different purposes. Some of the common formats that you
need to be familiar with are:

- **Wave (WAV):** This format is part of a series of standards for audio and video developed for Microsoft Windows 95 as a universal sound file format. It is used to store audio files in the wave audio format. Audio files stored in this format have good audio quality but this format is used sparingly these days. This is because the audio files in this format are larger when compared with other formats.

- **MPEG Audio Layer 3 (MP3):** This format was developed by Motion Picture Expert Group to allow compression of audio and video for digital distribution. The MP3 format is a popular format that is used to store digital audio files. This is because MP3 files are generally smaller than WAV files.

- **Windows Media Audio (WMA):** This format was developed by Microsoft and is used to store digital audio files.

Digital audio also allows streaming of digital audio files. With audio streaming, you do not have to wait to completely download a large audio file from the Internet to play it. Instead, you can use a streaming audio player or a browser add-in to play the audio file from the Internet. In this case, the audio file is sent to your computer in a continuous stream.

**Overview of Copying and Converting Digital Audio**

Digital recording is the technique of recording and storing audio files in a digital format. You can then copy the stored audio files to storage devices, such as recordable CDs and DVDs, in various formats, such as WAV and MP3. You can also convert audio from a CD or a DVD to a different format before you store it on your computer’s hard disk. The following table describes the concepts of copying audio and converting audio.

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copying audio</td>
<td>You can copy audio from storage devices, such as a computer’s hard disk, and store it on a recordable CD or DVD. This process of copying audio and storing it on a recordable CD or DVD is referred to as <em>burning</em>. You need a special hardware device, such as a CD writer or a DVD writer, for burning. A CD writer allows you to burn only recordable CDs whereas most DVD writers allow you to burn recordable CDs and DVDs.</td>
</tr>
</tbody>
</table>
Information Technology – Class IX

<table>
<thead>
<tr>
<th>Concept</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Along with hardware, you also need software to copy audio to a recordable CD or DVD. You can use the software to create different types of CDs. You can create data CDs, audio CDs, and mixed mode CDs. Mixed mode CDs contain audio, video, and data files. For example, you can create an audio CD and add video files and text files to it to create a mixed mode CD. Copying audio directly from the Internet and storing it on recordable CDs is illegal. It is also illegal to copy music from CDs and DVDs. Ensure that you have permission before you copy any material.</td>
<td></td>
</tr>
</tbody>
</table>

| Converting audio | You can convert audio from a CD or a DVD to a different format before storing it on a computer’s hard disk. For example, you can convert your favorite song from a CD to an MP3 file before storing it on the computer. You must have audio conversion software, such as Microsoft Windows Media Player 11, installed on your computer to convert audio files. The software changes the format of the audio and might also compress the audio so that the files take up less space on the hard disk. You can then transfer these audio files from the computer to a digital device, such as a PDA, a mobile phone, or an MP3 player. Converting audio from CDs and DVDs to a different format is illegal. Ensure that you have permission to convert audio to a different format before converting it. |

**Speech Recognition and Synthesis**

Digital audio technology allows you to interact with the computer by just speaking. This helps improve productivity and empowers challenged users to expand their ability to use computers. The following table introduces two speech technologies, speech synthesis and speech recognition.

<table>
<thead>
<tr>
<th>Technology</th>
<th>Description</th>
</tr>
</thead>
</table>
| Speech synthesis | Imagine a scenario. Eric Andersen has finished writing his short story. Eric wants to read the short story once before sending it to the publisher, but is tired. Therefore, he decides to use the speech synthesis feature, also referred to as the text-to-speech feature in Microsoft Windows Vista, to listen to the short story. *Speech synthesis* is a technology that allows the computer to speak to you by converting text to digital audio. Windows Vista has a built-in *screen reader* called Narrator that supports speech synthesis. A screen reader is a program that reads the text on the computer screen aloud. To support speech synthesis, your
## Speech Recognition

Imagine a scenario. Eric Andersen is using Microsoft Office Word 2007 to write a short story. However, his typing speed is slow and it takes him a long time to complete the story. To solve this problem, Eric’s friend advises him to use the speech recognition feature of Windows Vista.

Speech recognition is a technology that allows you to communicate with a computer by using only your voice to enter text and to issue commands. To enable speech recognition, you need an audio input device, such as a microphone, a sound card, and speech recognition software that converts human speech into text or commands for the computer. You can use speech recognition technology to interact with various programs. For example, you can use it to browse the Internet or enter text in documents.

The speech recognition feature is readily available in operating systems, such as Windows Vista. You can configure the speech recognition feature in Windows Vista by using the Ease of Access link in Control Panel.

### Digital Video

Before digital technology, video was recorded, edited, and stored in the analog format on tape. After the introduction of digital technology, video was still recorded on tape, but to make editing easy, people first converted video to a digital format. Today, digital video technology allows you to record video in the digital format on a digital storage device, such as a CD, DVD, or flash memory card, and edit it on a computer by using digital video editing software. This has benefited both home users and professionals. Both home users and professionals, such as movie makers, use digital video technology to create videos and films with titles, introduce transitions between scenes, and add special effects.

### Characteristics of Digital Video

One of the important characteristics of digital videos is that you can edit them easily on a computer by using digital video editing software. For example, you can edit videos to include titles, add a sound track, or add special effects. You can also upload the video to a Web site and share it over the Internet. In addition, you can copy the video from a computer to a recordable CD or DVD.

<table>
<thead>
<tr>
<th>Technology</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speech recognition</td>
<td>Imagine a scenario. Eric Andersen is using Microsoft Office Word 2007 to write a short story. However, his typing speed is slow and it takes him a long time to complete the story. To solve this problem, Eric’s friend advises him to use the speech recognition feature of Windows Vista. Speech recognition is a technology that allows you to communicate with a computer by using only your voice to enter text and to issue commands. To enable speech recognition, you need an audio input device, such as a microphone, a sound card, and speech recognition software that converts human speech into text or commands for the computer. You can use speech recognition technology to interact with various programs. For example, you can use it to browse the Internet or enter text in documents. The speech recognition feature is readily available in operating systems, such as Windows Vista. You can configure the speech recognition feature in Windows Vista by using the Ease of Access link in Control Panel.</td>
</tr>
</tbody>
</table>
Another characteristic of digital videos is that they can be compressed. Compressed files save space, allow more portability, and are easier to transfer over the Internet. A camcorder captures and records video. The following provides a brief description about the two types of camcorders available in the market.

**Analog Camcorder**

An analog camcorder records and stores video in an analog format on a tape. To edit the video on a computer, you need to convert it from the analog format to the digital format.

**Digital Camcorder**

A digital camcorder records and stores video in a digital format, which makes editing the recorded video easy. Another advantage is that a digital camcorder is generally lighter and smaller than an analog camcorder.

**Digital Video Editing and Output Formats**

Imagine a scenario where you have recorded your friend’s birthday party by using a camcorder. You would like to add certain effects to your video to make it look better. Using digital video editing software, you can:

- Add titles and background music to your video to make it more appealing.
- Cut or remove certain scenes from the video.
- Add special effects, such as fade-in and fade-out to the video.
- Enhance video quality by adjusting its brightness, contrast, and color.
- Record audio over the video to describe certain scenes.

Digital video editing can either be linear or nonlinear. In linear editing, you have to sequentially traverse a file to edit it. For example, if you want to remove a frame that is in the middle of a video, you have to linearly traverse to that frame. However, in nonlinear editing, you can directly go to the frame and remove it from your video. Tape is always in the linear format and has to be edited linearly. Random access devices, such as DVDs and CDs, let you read and write data in a nonlinear manner. You can edit DVDs and CDs linearly and nonlinearly.

After you edit a video, you can store it in various formats. You can use video editing software, such as Windows Movie Maker, to capture a frame from a movie and save it as a still image. For example, you can capture a frame from a video and save it as a .jpg
file. You can also edit the video and save it as a video clip in the Windows Media Video (WMV) format. Saving the video in the WMV format allows you to play the video clip on the computer by using Windows Media Player. You can share the video clip or the still image with your friends by uploading it to a Web site or sending it by e-mail.

You can save the edited video clips and still images in a format that can be copied to a recordable DVD or Video CD (VCD). You can play the DVD by using a DVD player and the VCD by using a VCD player. Some DVD players also allow you to play VCDs.

**Warning**

Copying video directly from the Web and storing it on CDs is illegal. Copying video directly from a video CD or DVD is also illegal. Ensure that you have permission to copy any video before you copy it.

**Web Video Technology**

These days, you can view video over the Internet. Web video technologies allow you to transfer digital video files over the Internet. Some of the examples of Web video technologies are.

- Video Streaming
- Downloading Video
- Web Conferencing

**Digital Photography**

With digital cameras, you can transfer pictures to a computer where you can edit pictures to enhance their quality. The following table describes some of the capabilities of software that is designed for working with digital images.

<table>
<thead>
<tr>
<th>Capability</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple photo editing</td>
<td>Sometimes, when you take pictures of your friends, their eyes appear red in the picture. This is called the red-eye effect. You can use <em>simple photo editing software</em> to remove this effect. Using simple photo editing software, such as Windows Photo Gallery, you can improve the appearance of a picture by adjusting the brightness, contrast, or color of the picture. You can also crop, resize, and print pictures.</td>
</tr>
</tbody>
</table>
### Capability | Description
--- | ---
Advanced photo editing | *Advanced photo editing programs* include tools for enhancing and adding special effects to a picture. For example, you can remove blemishes from a picture, change its backgrounds, and add text to it by using *advanced text design tools* built in the software.

Photo management | *Photo management software* helps you sort and organize your picture collection. Photo management capabilities are often included as part of a photo editing program, such as Windows Photo Gallery. Many photo management software packages also include tools for compressing and fine tuning pictures.

---

### Overview of Printing Digital Images

Sometimes, you might want to share pictures with friends who do not have a computer in their homes. To share the pictures, you can either print the pictures using a personal photo printer or a professional photo printer.

#### Personal Photo Printers

There are various types of personal photo printers. They can be either black and white or color printers. Color inkjet printers are the most commonly used personal photo printers. Inkjet printers spray small ink drops on the paper to create a print of the picture. Dye sublimation printers are also used, but they are not as popular as inkjet printers. Dye sublimation printers use dyes to create a print on paper. Most color inkjet and dye sublimation printers can produce near-photographic quality prints on special print paper. Near-photographic quality means that the pictures do not have the very fine detail of pictures taken by using a traditional camera. However, this difference can be seen only by a professional.

#### Professional Photo Printers

Professional photo printers, which are used in print labs, use special imaging devices to expose regular photo paper. The paper is then developed by using normal silver photo chemicals. Professional photo printers produce true-photographic quality prints on paper. Some print labs also use laser printers, high-end dye sublimation printers, and high-end inkjet printers.
### Assessment

**A.** Each pair of statements contains a true statement and a false statement. For each pair of statements, indicate which statement is true by placing a mark in the True column to the right.

<table>
<thead>
<tr>
<th>Statement</th>
<th>True</th>
<th>False</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  A smart phone CANNOT organize and store information.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2  A smart phone CAN organize and store information.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3  An XBOX is used to organize information.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4  A PDA is used to organize information.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5  A CAMCORDER is used to record video.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6  An XBOX is used to record video.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7  You CAN edit photographs taken using a digital camera.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8  You CANNOT edit photographs taken using a digital camera.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9  A digital camera stores images in its MEMORY.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 A digital camera stores images on FILM.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11 You CAN play games online by using an Xbox.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12 You CANNOT play games online by using an Xbox.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13 Videoconferencing can be held between MULTIPLE people.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14 Videoconferencing can be held between only TWO people.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15 A webcam IS NOT a digital video camera.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16 A webcam IS a digital video camera.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17 A digital camcorder records ONLY audio.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18 A digital camcorder records BOTH audio and video.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**B.** Each pair of statements contains a true statement and a false statement. For each pair of statements, indicate which statement is true by placing a mark in the True column to the right.

<table>
<thead>
<tr>
<th>Statement</th>
<th>True</th>
<th>False</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  You CANNOT change the format of audio files.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2  You CAN change the format of some audio files.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Information Technology – Class IX

<table>
<thead>
<tr>
<th>Statement</th>
<th>True</th>
<th>False</th>
</tr>
</thead>
<tbody>
<tr>
<td>3  MP3 format ALLOWS compression of audio files.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4  MP3 format DOES NOT ALLOW compression of audio files.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5  Converting audio from CDs and DVDs to a different format is ILLEGAL.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6  Converting audio from CDs and DVDs to a different format is LEGAL.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7  You NEED software to convert audio from a CD.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8  You DO NOT NEED software to convert audio from a CD.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9  When converting audio, the audio file MAY BE compressed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 When converting audio, the audio file IS NEVER compressed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11 When converting audio, the format IS NOT changed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12 When converting audio, the format IS changed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13 You can browse the Internet using SPEECH SYNTHESIS technology.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14 You can browse the Internet using SPEECH RECOGNITION technology.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15 A DVD writer can copy audio to CDs AND DVDs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16 A DVD writer can copy audio to ONLY DVDs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17 You NEED software to copy audio to CDs and DVDs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18 You DO NOT NEED software to copy audio to CDs and DVDs.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

C. Each pair of statements contains a true statement and a false statement. For each pair of statements, indicate which statement is true by placing a mark in the True column to the right.

<table>
<thead>
<tr>
<th>Statement</th>
<th>True</th>
<th>False</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  A DIGITAL camera uses film to store pictures.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2  A TRADITIONAL camera uses film to store pictures.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3  A digital camera DOES NOT HELP you delete unwanted pictures.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4  A digital camera HELPS you delete unwanted pictures.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Statement</td>
<td>True</td>
<td>False</td>
</tr>
<tr>
<td>---------------------------------------------------------------------------</td>
<td>------</td>
<td>-------</td>
</tr>
<tr>
<td>5  A SENSOR creates the image of a picture.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6  A FLASH MEMORY CARD creates the image of a picture.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7  You can change backgrounds using ADVANCED photo editing software.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8  You can change backgrounds using SIMPLE photo editing software.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9  You CAN crop a picture by using simple photo editing software.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 You CANNOT crop a picture by using simple photo editing software.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11 You CAN compress pictures by using photo management software.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12 You CANNOT compress pictures by using photo management software.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13 Windows Photo Gallery IS a photo editing program.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14 Windows Photo Gallery IS NOT a photo editing program.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**D. Tick the correct option given below the statement:**

**Question 1**
Which of the following is a characteristic of audio streaming?
Select all answers that apply.

a) It sends the audio file to your computer in a continuous stream.

b) It allows you to listen to digital audio without first downloading the entire file.

c) It allows you to transfer analog audio files.

d) It needs a browser add-in or streaming audio player to play audio files.
Question 2
Which of the following is a feature of speech synthesis?
Select the one best answer.

a) It allows you to communicate with the computer by using your voice.
b) It essentially requires a microphone.
c) It allows your computer to convert text to audio.
d) It allows you to enter text in word-processing documents.

Question 3
Which of the following statements are true when copying audio to a recordable CD or DVD?
Select all answers that apply.

a) The process of copying audio to a recordable CD or DVD is also called burning.
b) You need a special hardware device such as a CD writer to copy audio to a recordable CD or DVD.
c) Copying audio directly from the Internet to a recordable CD or DVD is legal.
d) Copying audio from CDs and DVDs is illegal.

Question 4
Which of the following statements are correct about nonlinear video editing?
Select all answers that apply.

a) You go directly to a frame to edit it.
b) You can edit DVDs in a nonlinear manner.
c) You sequentially traverse to a frame to edit it.
d) You can edit tapes in a nonlinear manner.
**Question 5**

Which of the following statements are correct about video streaming?
Select all answers that apply.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>a)</td>
<td>The video file is received as a continuous stream.</td>
</tr>
<tr>
<td>b)</td>
<td>Sometimes, a special program is needed on the computer to enable video streaming.</td>
</tr>
<tr>
<td>c)</td>
<td>The quality of the video is not affected by the speed of the Internet connection.</td>
</tr>
<tr>
<td>d)</td>
<td>It allows you to view video files over the Internet without first downloading them.</td>
</tr>
</tbody>
</table>

**SESSION 11: COMPUTER SECURITY AND PRIVACY**

Like any other electronic device, your computer is at risk from damages caused by accident or by intention. Some of these damages can be permanent. You can prevent your computer hardware, software, and the data stored on it from a number of damages by taking certain preventive measures. This session will help you to identify the various threats to your computer and the data stored on it. You will explore how to protect your computer from these threats by taking some preventive measures. If you use computers regularly, you may have a lot of information stored on the computer. This information may be in form of tax details, personal letters, or business correspondence. You need to ensure that this information is not viewed by other people without your permission. You also need to protect this information from getting damaged.

**Relevant Knowledge**

**What is Computer Security and Privacy**

Any factor that can damage your computer or the data on it is a computer threat. Natural events such as earthquakes or hurricanes can cause widespread physical damage. It is possible that you or someone else accidentally deletes some important files causing the computer to malfunction. When your computer is connected to a network, the computer becomes even more vulnerable to computer threats. For example, another user may use the network to gain unauthorized access to your computer. There are various measures that you can use to reduce these threats and reduce the likelihood of loss due to damage.
By following basic guidelines, you can minimize the risks of damage to your computer and ensure its security and privacy.

**Computer Security:** The computer hardware can be damaged due to human carelessness or natural causes. Also, the data and software on the computer need to be protected from accidental or intentional loss and tampering. Computer security deals with the measures that you can take to avoid such damage to the computer and its data.

**Computer Privacy:** You store your personal files or documents on your computer and would not want anyone to read them. Computer privacy means that your data, such as personal files and e-mail messages, is not accessible by anyone without your permission. Computer privacy deals with the measures that you can take to restrict access to your data. Computer privacy also includes being careful while giving out any personal information over the Internet. Any such information is likely to be misused to gain access to your personal accounts, such as your e-mail and bank accounts.

**Natural Threats**

Natural calamities such as earthquakes, floods, hurricanes, can damage your computer at any time. Natural calamities can cause fires, extreme temperatures, and lightning strikes that lead to major physical damage to the computers and loss of data.

This table given below describes the various natural threats to computer security and privacy.

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Most of the components of a computer are designed to operate within a specific <strong>temperature</strong> range. In case of excessive heat or cold, some components may start to malfunction, and you may need to replace them. If your computer has been exposed to extreme temperatures, let it return to room temperature before you start it.</td>
</tr>
<tr>
<td>2.</td>
<td><strong>Fire</strong> can damage your computer beyond repair. Even if the computer does not directly catch fire, the heat caused is enough to melt the delicate components inside the computer. Moreover, smoke can damage the CPU fan, which in turn can cause overheating of the CPU and damage it.</td>
</tr>
<tr>
<td>3.</td>
<td><strong>Lightning</strong> that strikes with a huge amount of electrical charge can cause a surge. A surge or spike is a sudden increase in the supply voltage, which can permanently damage some components of your computer. For example, a sudden increase in voltage can destroy the motherboard of your computer.</td>
</tr>
</tbody>
</table>
Measures for Protection from Natural Threats

Natural threats can cause considerable damage to your computer. The following table explains the measures that you can take to protect your data and computer from natural threats.

<table>
<thead>
<tr>
<th>Measure</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Back up data</td>
<td>Backing up data involves creating multiple copies of your data. Events like floods and earthquakes can strike without warning. Making a backup helps you recover your data in case of any data loss. To provide better recoverability, keep a copy of your important data in a physically separate location, such as in another building or city.</td>
</tr>
<tr>
<td>Install computers in secure locations</td>
<td>Install your computer in a place where it is not likely to get damaged due to natural factors. For example, avoid installing computers in rooms that are exposed to excessive dust or moisture.</td>
</tr>
<tr>
<td>Install protective electrical devices</td>
<td>Install devices such as an Uninterruptible Power Supply (UPS) that can provide battery backup in case of a power outage. A UPS prevents software damage caused by abrupt shutting down of your computer. A UPS also provides surge protection and line-conditioning features, which help protect your computer against spikes and surges on the power line. You can also install separate surge protectors and line conditioners. However, in case of a strong surge, caused by events such as a major storm, you should turn off the computer and unplug it from the power to avoid damage.</td>
</tr>
<tr>
<td>Insulate computers from fire</td>
<td>Insulate the computers from fire by housing them in fire retardant surroundings. In addition, you can install adequate fire safety equipment and procedures for quick damage control.</td>
</tr>
<tr>
<td>Maintain appropriate temperature and humidity</td>
<td>You should maintain an optimum temperature and humidity level to ensure the smooth functioning of your computer. You can do this by installing devices such as air conditioners and humidity controllers.</td>
</tr>
</tbody>
</table>

Threats from Human Actions

A type of threat to your computer is malicious human sources. A discontented employee in your office can deliberately try to tamper with or destroy the data on your computer. A **hacker** is a person who tries to illegally access your computer when you connect it to the Internet. After accessing your computer, a hacker can steal or damage the data stored...
on the computer. In addition to malicious human threats, human errors such as accidental deletion of data and physical damage are also a threat to your computer. The following table describes various threats from malicious human sources and human errors to your computer.

<table>
<thead>
<tr>
<th>Threat</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Theft</td>
<td>Anyone can steal your computer or its components, if they have access to it. With the popularity of portable computers, such as laptops, physical theft of computers has become very common. You can also become a victim of virtual theft, when your computer is connected to the Internet. One example of virtual theft is identity theft, in which a hacker can steal your personal information to assume your identity. Using this false identity, the hacker can gain access to your finances or perform an illegal activity. Another example of virtual theft is software piracy, which is theft of a computer design or program. It can also mean unauthorized distribution and use of a computer program and confidential documents.</td>
</tr>
<tr>
<td>Viruses, worms, and Trojan horses</td>
<td><em>Viruses</em> are computer programs that can damage the data or software on your computer or steal the information stored on your computer. These viruses can reach your computer, without your knowledge, through the Internet or through storage devices, such as floppy disks and CD-ROMs. <em>Worms</em> are viruses that replicate themselves once they attack a computer, making it difficult to remove them. A common worm, known as <em>Trojan horse</em> is a kind of virus disguised as useful software. Once a Trojan horse reaches your computer, it starts acting like a virus causing damage to the computer’s data.</td>
</tr>
<tr>
<td>Spyware</td>
<td><em>Spyware</em> are programs that get installed on your computer without your knowledge. They can secretly send out information about your Web browsing habits or other personal details to another computer through the network.</td>
</tr>
<tr>
<td>Internet scams</td>
<td>While using the Internet, you might come across some attractive offers through e-mail messages or chat room communication. You should be very careful before accepting any such offers because these offers can be part of well-planned scams that can cause you a financial loss.</td>
</tr>
<tr>
<td>Online predators</td>
<td><em>Online predators</em> are individuals who lure anybody online, into inappropriate and unethical relationships. You or your family members can become targets of online predators. Online predators develop contact with their targets by using e-mail or chat room communication.</td>
</tr>
</tbody>
</table>
Threat Description

**Accidental deletion of data**
Many times, damage to a computer is due to unintentional human errors. Accidental deletion of an important file can disrupt the integrity of data or prevent other files or programs from working. For example, you may accidentally delete an important file, causing the computer to malfunction.

**Accidental damage to hardware**
Computer components, being delicate, run the risk of getting damaged due to carelessness. For example, if you accidentally drop your laptop computer, this might result in damage to the hardware components, such as motherboard or CD-ROM. As a result you lose the data stored on the computer. In addition, physical damage to data due to spilling of food and beverages on storage devices or peripherals can affect your computer.

**Measures for Protection against Threats from Human Actions:**
You can take some simple measures to minimize the risks associated with malicious human threats and human errors. The following table describes measures to protect your computer from malicious human sources and human errors.

<table>
<thead>
<tr>
<th>Solution</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Store data safely</td>
<td>Keep your data in safe and secure locations that have limited access to others. This minimizes the possibility of theft or tampering of the data.</td>
</tr>
<tr>
<td>Encrypt data</td>
<td>The BitLocker feature of Windows Vista helps you encrypt data at the drive-level. When you encrypt data by using this feature, unauthorized users cannot access the data by removing the hard drive and attaching it to another computer.</td>
</tr>
<tr>
<td>Install antivirus and antispyware programs</td>
<td>Antivirus and antispyware software programs have the ability to check for viruses and spyware present in the computer’s memory and also prevent new ones from entering. You must regularly update antivirus and antispyware software so that they are able to recognize new viruses and spyware. Most antivirus and antispyware software offer the automatic updates feature that automatically installs the updated version of the software on your computer. Built-in features in e-mail software, such as Windows Mail, allow you to block junk e-mail messages and provide features to check for viruses and worms. Windows Vista includes Windows Defender, a built-in antispyware program, which provides real-time protection.</td>
</tr>
</tbody>
</table>
Install firewall

Installing a firewall is another effective step that you can take to protect against malicious threats. A firewall enables you to filter the Internet traffic before it reaches your computer or a private network. It provides additional protection against threats such as hackers and viruses.

A firewall also helps to ensure computer privacy by restricting external access to your computer by any unauthorized user. Windows Firewall that is available with Windows Vista blocks unwanted access to your computer.

Back up data

Regularly back up important computer data. Creating multiple copies of data provides protection against loss of data due to accidental erasure or destruction of data.

Keep computer in safe environment

Keep the computer in an area that is dust-free, free from vibration, and out of the way of possible impact. The table or shelf housing the computer should be steady and stable to keep the computer from falling, even if the computer is bumped.

Keep the computer away from any magnetic substance, water, or static discharge. For example, do not put the computer on the floor or on a rug. Avoid eating and drinking near the keyboard and use a keyboard cover to protect against any spillage.

Guidelines for Protecting your Computer

Imagine that you have saved a confidential project report on your computer. You have been working for weeks to prepare this report and now you want to share the project report with your supervisor. You have a single copy of this report on your computer and it is important to secure the report from being tampered with or deleted. However, another employee uses your computer in your absence and deletes the project report from your computer. To avoid such situations, you can take measures to secure the data on your computer. The following table explains the actions that you can take to safeguard the operating environment and data on your computer.

<table>
<thead>
<tr>
<th>Guideline</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Implement</td>
<td>An effective way to minimize the risk to your operating user environment and data is to keep unauthorized individuals identification from accessing your computer. One way to achieve this is by setting up accounts for authorized users of the computer, on the basis of which</td>
</tr>
<tr>
<td>Guideline</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Set username and password</td>
<td>You can also increase security and limit unauthorized access to your computer by setting up a username and password. The employees must provide the correct username and password to access their computers. You can set up users and passwords in Windows Vista.</td>
</tr>
<tr>
<td>Keep password secure</td>
<td>Your password acts like a key to your computer. Anyone who knows your password can access your computer and tamper with data. You must keep your password secure. Be careful while typing your password to prevent anyone else from seeing it. Do not share your password with others. Do not write the password and leave it on your computer or desk. If you think that the password has been compromised, change it immediately, before anyone else is able to misuse it.</td>
</tr>
<tr>
<td>Lock computer</td>
<td>When you leave your computer on and unattended, someone can tamper with your computer software or data. You can prevent this by temporarily locking your computer while you are away. When a computer is locked, it immediately hides the content of the screen and does not allow any operation until the computer is unlocked with the correct username and password combination. The exact steps to lock your computer depend on the operating system you are using. For example, in Windows Vista, you can lock your computer by pressing CTRL+ALT+DEL, and then clicking the Lock this computer button. Note that this feature of locking the computers is not available in all operating systems.</td>
</tr>
<tr>
<td>Install and update protective software</td>
<td>You need to continuously guard your computer against threats such as viruses and spyware. At times, the damage due to a virus is considerable and you may lose important data or need to reinstall the operating system and other software. You can protect your computer from viruses and spyware by installing antivirus and antispyware software. These protective software programs help you detect and remove viruses and spyware present in your computer. They also prevent new ones from infecting your computer. It is a good practice to install a firewall, which filters out the content that...</td>
</tr>
</tbody>
</table>
reaches your computer. Installing a firewall also protects against hackers by restricting access by other online users. As newer threats keep appearing, software companies regularly create updates that you can install on your computer. These updates make additions to the installed software or operating system in your computer to make it less vulnerable to security threats. Ensure that you regularly update the antivirus software so that it can detect the newest viruses. Windows Vista includes Windows Firewall to protect your computer against unauthorized access. In addition, Windows Defender is a built-in antispyware program that protects against pop-ups and other security threats.

<table>
<thead>
<tr>
<th>Guideline</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Encrypt data</td>
<td>Converting your data to an unreadable form to protect it from unauthorized access is called encryption. An authorized user can reconvert the encrypted data into a readable and usable form. This is called decryption. Various software products today include a way to encrypt data. In Windows Vista, encryption is transparent to the user who encrypts the file. That is, you do not have to manually decrypt the encrypted file before you can use it. You can open and change the file as you usually do.</td>
</tr>
<tr>
<td>Back up data</td>
<td>You can also help protect your files from loss or damage by making copies of important files and storing them on a different storage media, such as CDs, DVDs, or floppy disks. This process is known as backing up data. You should keep the backups in secure locations, so that you can use the backup data in case the original data is damaged or deleted.</td>
</tr>
</tbody>
</table>

**Best Practices for Securing Online and Network Transactions**

Connecting your computer to the Internet introduces it to a world of information and entertainment. However, it also leaves your computer vulnerable to many online threats. For example, it becomes easier for viruses to transfer from an infected computer to your computer. You can reduce the risks to your computer from these online threats by using a combination of best practices such as creating strong passwords, encrypting data, and using antivirus software. The following table explains the various actions that you can take to secure online and network transactions.
### Use strong passwords

A strong password is a complex password, which cannot be guessed easily. The password should consist of a combination of uppercase and lowercase letters, numbers, and special characters such as `&` and `#`, and should not contain complete words or names. A strong password is your primary defense against security and privacy threats. Strong passwords must be created for:

- Local access to standalone computers
- Access to networks
- Access to Web sites that have sensitive information, such as personal or financial details
- Access to any valuable data
- Personal data stored on your computer

### Protect against hacking and spyware

While you are browsing the Internet, it is possible that a software program installed on your computer is transmitting your personal information to a hacker in another country. Such software programs are examples of spyware. These programs generally get installed on your computer without your knowledge and secretly transfers confidential data from your computer to the hackers. Sometimes, employers deliberately install spyware on the computers used by the employees to track the computing activities of the employees.

Windows Vista includes a built-in antispyware program called Windows Defender, which helps prevent spyware from getting secretly installed on the computer.

Make use of Internet service provider (ISP) support for online security. The support can be in the form of antivirus and anti-spyware software. Some ISPs even provide firewall protection, e-mail virus screening, and spam protection.

### Clear browsing

The Web sites and Web pages that you visit while browsing are saved in your browser’s History. Also, periodically while you browse the Internet, a number of files are stored in the temporary memory of your computer. This temporary memory is known as cache memory. The files stored in the cache memory record information about the Web pages you visit.

However, some of these temporary Internet files may contain your personal information, such as your username and password, which can be accessed by hackers. To prevent hackers from accessing your personal information,
<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>regularly delete the contents present in the browser history and in the cache memory.</strong></td>
<td>While visiting a Web site, you may notice that it displays your name. This is made possible through the use of cookies. <em>Cookies</em> are small files that are created on your computer by previously visited Web sites to identify and track your preferences. Their purpose is to provide a more personal experience while visiting a Web site. However, cookies can also be a threat to computer privacy because they contain your personal information. For example, the cookies might contain your credit card details that you have used while shopping online. For these reasons, it is a good practice to periodically delete cookies to prevent your personal information from being misused.</td>
</tr>
<tr>
<td><strong>Avoid sharing</strong></td>
<td>Some Web sites require you to fill out forms containing <strong>personal</strong> personal information such as your name, gender, and age. <strong>information</strong> In case of e-commerce sites, you might even need to share your bank account details or credit card number. But, remember that hackers can access and misuse this information. Some companies may also use this information to send you unwanted commercial e-mail messages. Therefore, before you share any personal information on a Web site, ensure that it is a secured Web site and there is a specific need to provide the information.</td>
</tr>
<tr>
<td><strong>Perform online transactions only on secure sites</strong></td>
<td>While shopping online, you usually need to provide sensitive information such as your bank account number or credit card details. Therefore, it is important to ensure that you carry out online transactions only on secure Web sites. A Web site is secure if its name has the prefix <em>https</em>. The prefix indicates that the Web site implements the <em>Secure Sockets Layer (SSL)</em> protocol. SSL is an Internet security protocol that ensures secure data communication by encrypting the information transmitted. The SSL protocol certifies that the Web site is genuine and ensures that the data you provide to the site is not misused. When you enter a secure Web site, most of the Web browsers display a message to confirm that you have entered a secure Web site. The locked padlock icon that appears in the Address bar helps you identify a secure Web site. You can also check the security certificate of a Web site before performing any online transaction on that site.</td>
</tr>
</tbody>
</table>
### Configure security components by using Windows Security Center

Windows Security Center is a feature in Windows Vista, which provides you a convenient utility to check the status of essential security settings and track the antivirus software installed on your computer. You can open Security Center from Control Panel. The Security Center has four components:

- **Firewall.** In Windows Vista, Windows Firewall is automatically activated. The firewall helps prevent malicious content, such as viruses and worms, from entering your computer.
- **Automatic updating.** This feature checks for relevant security-related updates available on the Microsoft Update Web site. Enabling this feature ensures that your computer remains updated and protected against the newest security threats on the Internet.
- **Malware protection.** Spyware and other potentially unwanted software can install itself on your computer without appropriately obtaining your consent. Windows Defender provides real-time protection against such software while you are connected to the Internet.
- **Other security settings.** Other security settings include Internet settings and User Account Control settings.

Using Internet options, you can set the security level to medium, medium-high, or high. Internet Explorer 7 has higher security levels than its previous versions. User Account Control prevents unauthorized changes to your computer by asking for the password before making changes.

### Disable active content

Active content refers to small programs that get installed on your computer while you are browsing the Internet. Their basic function is to provide you with an interactive Internet experience through videos and toolbars. However, in some cases, these programs can be used to damage the data stored on your computer or install malicious software without your consent. By using your browser settings, you can disable active content to prevent the installation of such programs.

### Measures for Securing E-mail and Instant Messaging

E-mail and Instant Messaging (IM) are widely used for business and personal communication. However, hackers, online predators, and the people who create worms and viruses use e-mail and IM for malicious purposes. For example, these people can send e-mail attachments containing harmful software. These people can also use e-mail...
to solicit sensitive information or to lure you into fake offers. It is therefore important for you to take certain measures to ensure e-mail and IM security.

To ensure e-mail security, avoid opening e-mail with attachments, do not respond to junk mail, do not respond to unsolicited commercial mail, and protect yourself from phishing.

To ensure IM security, chat with known people only and do not open attachments received over IM.

- Be cautious when opening e-mail messages with attachments
- Do not respond to unsolicited commercial mail
- Protect yourself from phishing
- Limit chat activity to people whom you know
- Avoid opening instant messenger attachments

**Measures to Protect your Privacy**

With the growing popularity of computers and the Internet, there are multiple ways in which your privacy is compromised. You and your family members need to prevent these threats to privacy. You can take the following simple measures to safeguard yourself and your family members against invasion of privacy.

**Shield Your Identity**

Avoid sharing your personal information with anyone, unless you know the person. This is the golden rule of protecting privacy. While exchanging e-mail messages or chatting through instant messenger, ensure that you do not reveal personal details about you or others known to you. Also, use strong passwords for access to your computer and e-mail connections.

**Make Regular Backups of Your Computer and Important Data**

It is a good practice to back up all types of the important and sensitive data on your computer. Important data might be documents, databases, or contact information. You can use various storage media such as compact disc or another hard disk to back up your data. If you regularly back up the data stored on your computer, you can recover the data in case the original data is damaged or deleted. Also, it is advisable to store the backup data in a secure place and restrict access to it by using passwords and encryption.
Information Technology – Class IX

Check Current Security of Your System Regularly

Check the current security level of your computer regularly. Modern operating systems have built-in features that help you track the ability of your computer to safeguard against various threats to security and privacy. For example, Windows Security Center is a component in Windows Vista, which helps you to maintain firewall settings, set up schedules for software updates, and check the validity of the antivirus software installed on your computer.

Run Virus Scans Daily

Each day when you access the Internet, there is a chance that your computer is infected by viruses. Therefore, it is important that you run a virus scan on your computer everyday. You also need to keep the antivirus software on your computer up-to-date to protect your computer from new viruses.

Use Antispyware

Spyware programs can secretly enter your computer and transmit personal information about you and your family. Use antispyware software to keep a check upon these malicious programs, and keep the software up-to-date.

Perform Online Transactions on Secure Web Sites with Reputable Vendors

When you perform an online transaction, you need to provide your personal information, such as your credit card details or bank account details, to the Web site. This information, if disclosed to others, can be misused for financial fraud. Therefore, it is important that you carry out online transactions only on secure Web sites.

Report Abuse to the ISP

Most reputable ISPs have a set of terms and conditions that does not allow its users to follow any unethical or illegal practices. You should report to the ISP whenever someone attempts to invade your online privacy by sending you spam or attempts to hack your computer. This allows the ISP to take action against such individuals.

Filter E-mail Messages from Unknown/Anonymous Senders

You may receive a number of e-mail messages from individuals unknown to you. Such e-mail messages, referred to as spam or junk mail, can often be carriers of viruses or spyware. Hackers attempting to retrieve your personal information can also send you
junk mail. Therefore, it is important to be careful while dealing with them. With e-mail software programs, you can create e-mail filters that help you block the junk mail. You must also ensure never to respond to junk mail because it can lead to an increase in unwanted messages and accidental sharing of personal information.

**Encrypt Sensitive E-mail Messages, If Possible**

Using encryption is a simple and effective way to ensure that your e-mail communication remains confidential. Encryption is the process of encoding the e-mail message in such a manner that it appears unreadable to everyone except the intended reader. Most e-mail software, such as Windows Mail, provides this e-mail encryption feature.

**Online Predators**

The Internet is a popular medium of communication for people all over the world. You can get acquainted with someone while actually knowing very little about the identity and intentions of the individual. This aspect of the Internet communication can be misused by people to lure young individuals into inappropriate or dangerous relationships. The people who engage in such activities are known as online predators.

Online predators generally target children, especially adolescents. It is during adolescence that children gradually move out of parental control and look for new relationships. Online predators attempt to establish a relationship of trust and intimacy with these children. Online predators can also target adults with the objective of financial exploitation.

Online predators trap their victims by developing contact through chat rooms, instant messaging, e-mail, or discussion boards. Among the various tools, chat rooms are the ones most commonly used by these predators. Online predators often assume a fake identity as a member of a specific chat room. For example, if the chat room belongs only to children, an online predator can easily assume the identity of a child in order to participate in that chat room.

**Guidelines for Protection from Online Predators**

You and your family members can become the target of online predators. These predators may try to establish contact with you or your family members to exploit you financially. The predators may also try to involve you and your family members in inappropriate relationships. The following table lists some guidelines that you can follow to protect yourself and your family from online predators.
<table>
<thead>
<tr>
<th>Guideline</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Know the signs of predator behavior</td>
<td>Online predators have some predictable behaviors, which can help you identify them easily. Online predators tend to get intimate very quickly. They often express a great deal of interest and affection toward their targets. You need to ensure that you and your family members can detect such behavior to avoid contact with potential online predators.</td>
</tr>
<tr>
<td>Be cautious of offers from strangers online</td>
<td>Online predators usually lure their targets with gifts or other tempting offers. You should be cautious about such gifts or offers. Also, educate your family members to be suspicious about gifts offered over the Internet.</td>
</tr>
<tr>
<td>Educate your family on online safety measures</td>
<td>Educate your family members on appropriate chat room behavior to avoid being targeted by online predators. Tell them to use nonsuggestive and neutral screen names. The screen names must not give away their actual name, age, gender, or contact information because this information can be misused. Some Web sites try to extract information under the pretext of feedback or surveys. Tell your family not to reveal any personal information to these Web sites without your permission. Also, ensure that your family do not give out any personal details, such as name, last name, address, and phone number, in chat rooms and bulletin boards. Your family members must not share their username and password with anyone, including friends.</td>
</tr>
<tr>
<td>Guide children when they visit Web sites</td>
<td>As parents, restrict young children from visiting Web sites that are inappropriate for them, or those Web sites that bring them in contact with potential online predators. It is recommended that parents guide their young children when the children visit any Web site. As a parent, instruct your children to leave a Web site if it makes them uncomfortable or if the site contains any unpleasant content. Also, educate your children to leave a Web site that asks for excessive personal information.</td>
</tr>
<tr>
<td>Know the sites visited by children</td>
<td>It is important for parents to regularly check the type of Web sites their children visit. You can track the previously visited Web sites by viewing the browser history or by using software that help you track the online activity of a computer.</td>
</tr>
</tbody>
</table>
Information Technology – Class IX

<table>
<thead>
<tr>
<th>Guideline</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block access to inappropriate Web sites</td>
<td>You can enable your browser’s Content Advisor feature to control the type of Web sites that your family members can visit while browsing the Internet. By using this feature, you can restrict children from visiting Web sites that contain adult content. You can also install certain software programs that help you block specific Web sites.</td>
</tr>
<tr>
<td>Monitor chat activities</td>
<td>Specialized software can monitor chat activities and flag inappropriate information exchange on your computer. You can install these software to track the chat activities of your children.</td>
</tr>
</tbody>
</table>

Assessment

A. Tick the right option from the choices given below the statement

**Question 1**

Which one of the following statements best describes computer privacy?

Select the one best answer.

a) Securing a computer from fires and earthquakes.

b) Protecting a computer from a power surge.

c) Preventing your friend from viewing your computer data without your permission.

d) Preventing important computer files from getting accidentally deleted.

**Question 2**

Which of the following security measures can you adopt to help protect your computer and its data against natural threats?

Select all answers that apply.

a) Surge protection.

b) Antivirus software.

c) Firewall.

d) Humidity control.
Question 3

One of the most effective ways to protect the software and data in your computer is to restrict the use of your computer to a defined set of individuals. Which of the following methods can you use for this purpose?

Select all answers that apply.

a) Update your operating system.
b) Set up user accounts.
c) Install antivirus software.
d) Keep passwords secure.

Question 4

Various types of files are created on your computer while using the Internet. Some of these might present a threat to security, but are actually present for the benefit of the user. Which of the following are examples of such files?

Select all answers that apply.

a) Cookie.
b) Virus.
c) Active Content files.
d) Worm.

Question 5

Which of the following methods will you use to secure your e-mail and IM transactions?

Select all answers that apply.

a) Delete e-mail messages from unknown senders without opening them.
b) Forward unsolicited e-mail messages to a friend for advice.
c) Reply with personal information to an e-mail message if the sender is a bank employee.
d) Avoid opening attachments received in instant messages.
B. State whether the statement is True or False

Each pair of statements contains a true statement and a false statement. For each pair of statements, indicate which statement is true by placing a mark in the True column to the right.

<table>
<thead>
<tr>
<th>Statement</th>
<th>True</th>
<th>False</th>
</tr>
</thead>
<tbody>
<tr>
<td>1  Replying to junk mail CAN cause you to reveal personal information.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2  Replying to junk mail CANNOT cause you to reveal personal information.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3  Online predators GET intimate very quickly.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4  Online predators DO NOT GET intimate very quickly.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5  SPYWARE software helps you keep a check on programs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6  ANTISPYWARE software helps you keep a check on malicious programs.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>7  It is POSSIBLE to monitor chat activity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>8  It is NOT POSSIBLE to monitor chat activity.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>9  Encryption COMPRESSES the e-mail message so that it appears unreadable.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 Encryption ENCODES the e-mail message so that it appears unreadable.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>11 Online predators DO NOT TARGET children.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>12 Online predators TARGET children.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13 Children SHOULD be allowed to visit Web sites alone.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>14 Children SHOULD NOT be allowed to visit Web sites alone.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>15 Online predators DO NOT LURE their targets with gifts.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>16 Online predators LURE their targets with gifts.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>17 The screen name used for chatting SHOULD NOT be your real name.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>18 The screen name used for chatting SHOULD be your real name.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
C. Sort the measures for protection against various types of threats into their associated categories by writing the statement number in its corresponding option box.

<table>
<thead>
<tr>
<th>Statement</th>
<th>Option 1</th>
<th>Option 2</th>
<th>Option 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Surge protection and line conditioning</td>
<td>Natural Threats</td>
<td>Malicious Human Threats</td>
<td>Human Errors</td>
</tr>
<tr>
<td>2 Data encryption</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Insulation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 Stable shelf</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>5 Sufficient distance from magnetic substances</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>6 Antivirus</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7 Air conditioners and humidity controllers</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8 Spyware protection</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>9 Keyboard cover</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>10 Firewall</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Glossary of Terms**

1. **Terms Related To Computer**

**Applications**
Applications, also called programs, use the platform to perform tasks.
**Bit**
A bit is the smallest unit of information that a computer handles. A single bit can hold only one of two values, 0 or 1.

**Byte**
A byte is a combination of eight bits arranged in sequence.

**Camcorder**
A digital video camera used to record video.

**Compact disc (CD)**
A storage device used to store data in a digital format.

**Central Processing Unit (CPU)**
The central processing unit (CPU) is the primary hardware device that interprets and runs the commands you give to the computer.

**Commands**
A command is an instruction, which you give to a computer that causes an action to be carried out. Commands are either typed by using a keyboard or are chosen from a menu.

**Communication Channel**
A communication channel is a path or a link that connects computers or peripheral devices, such as printers and disk drives, to transfer information.

**CPU speed**
The CPU speed is the rate at which the CPU can perform a task, such as moving data to and from RAM, or performing a numerical calculation.

**Data**
Data is the plural for the Latin word datum, meaning an item of information.

**Database Programs**
Database programs are used to store and manage data in an organized way. You can also use these programs to sort or search for information stored in a database.
Desktop
The desktop is an on-screen work area that uses a combination of menus and icons.

Desktop Computers
Desktop computers are made up of individual components such as a monitor, a keyboard, a system unit, and a printer.

Digital camera
A camera that stores images digitally on a memory device, such as a flash memory card or a mini hard disk.

Digital versatile disc (DVD)
A storage device used to store data in a digital format.

Folder
A folder is a container for programs and files in GUI interfaces.

Gigabyte
One gigabyte (GB) is equal to 1,024 MB, which is approximately equal to one billion bytes.

Graphical User Interface (GUI)
A graphical user interface (GUI) displays images and pictures that allow a computer user to interact with a computer easily.

Graphics Programs
Graphics programs are used to create and edit drawings. You can also use these programs to enhance photographs.

Hardware
Hardware refers to all the physical components of a computer.

Home office
An arrangement that allows people to work from home.
Icon
An icon is a small image displayed on the screen to represent an object.

Input Devices
An input device is used to provide information to a computer. A keyboard is an example of an input device.

Intranet
A special type of network used to communicate and share information within an organization.

Kilobyte
One kilobyte (KB) is equal to 1,024 bytes.

Laptop Computers
Laptop computers are lightweight and portable personal computers. Laptop computers are also called notebook computers.

Local Area Network (LAN)
A LAN connects devices within a limited area, such as a home or a small group of offices.

Megabyte
One megabyte (MB) is equal to 1,024 KB.

Menu
A menu is a list of options from which a user can select an option to perform a desired action, such as choosing a command or applying a particular format to part of a document. Many programs, especially those that offer a graphical interface, use menus as a means to provide the user with an easy-to-use alternative to memorizing program commands and their appropriate usage.

Mobile phone
A wireless device that has the capabilities of a traditional wired phone and allows you to make a call from almost any location.
MPEG Audio Layer 3 (MP3)
A format developed by Motion Picture Expert Group to allow compression of audio and video for digital distribution.

Network
A network is a group of computers that are connected to share resources and exchange information.

Network Drives
A network drive is a disk drive that is shared with other computers on a network.

Online
When a computer is connected to the Internet, it is said to be online.

Operating System
The operating system controls the computer’s hardware and provides services and access to the hardware to programs. It also manages the computer’s operations and tasks, such as logging on, logging off, and shutting down.

Platform
The hardware and the operating system together are referred to as a platform.

Personal digital assistant (PDA)
A handheld computer that is used as a personal organizer. A traditional PDA includes features such as an address book, task list, and a calculator.

Pixels
Refers to small units that make up a picture. The higher the number of pixels, the better the quality of the picture.

Presentation Programs
Presentation programs are used to present information in the form of slides.

Processing Devices
Processing devices are used by computer users to process the input data and generate the desired output.
Programs
A program is a sequence of instructions that can be executed by a computer. A program is also known as software.

Publishing Programs
Publishing programs are used to combine text and graphics to create documents such as brochures, greeting cards, annual reports, books, or magazines.

Resolution
Refers to the clarity and sharpness of a picture.

Server
The server is the main computer on a network that provides services to other computers on the network. A server decides which computers are allowed to access the hardware and software on the network.

Setup Wizard
Setup wizards are provided by Windows Vista. They guide the user through each step of a particular task, such as installing hardware or software.

Software
Software is a sequence of instructions that a computer can execute. It is also referred to as programs.

Spreadsheet Programs
Spreadsheet programs are used to create budgets, manage accounts, perform mathematical calculations, and convert numerical data into charts and graphs.

Storage Devices
Storage devices are used to store data. A hard disk is an example of a storage device.

System Unit
A system unit refers to the box that holds the processor, motherboard, disk drives, power supply, and the expansion bus.
Tablet Computer
Tablet computers are computers that allow you to write directly on the screen by using a tablet pen.

Taskbar
The taskbar is a rectangular bar that is usually located at the bottom of the screen. You can use the taskbar to select a program running on your computer.

Terabyte
One terabyte is equal to 1,024 GB, approximately equal to trillion bytes.

Wallpaper
Wallpaper is a pattern or picture on the screen background that you can choose.

Wide Area Network (WAN)
A WAN is a network that connects devices in geographically separated areas.

Window
In Windows Vista, a window is a rectangular area on the monitor that displays a program. Each program has its own window.

Word-processing Programs
Word-processing programs are used to create and modify text-based documents.

Workstation
A workstation refers to a computer connected to a network. You use a workstation to access the hardware and software on a network.

2. Terms Related to Internet

Access point
An access point is a wireless connection device. It is used to connect a wireless computing device to a wired network.

Add-ons
Add-ons are programs that help you view files, such as animation, audio, or video, which are included in Web pages.
Information Technology – Class IX

Back Up
To make a duplicate copy of a program, a disk, or data. The duplicate copy is called a backup.

Cache Memory
Temporary memory on your computer that is sometimes used to store local copies of files opened when you browse the Internet.

Chat Program
Chat programs allow you to send and receive messages instantly. You can use a chat program to communicate with several people at the same time.

Computer Privacy
Keeping a user’s data, including personal files and e-mail messages, such that the data is not accessible by anyone without appropriate permission.

Computer Security
The protection of a computer system and its data from accidental or intentional loss and tampering.

Cookie
A small file on a computer that is created when a user visits a Web site. A Web site uses cookies to identify users who visit the site, and also track the preferences of the users.

Copyright
A method of protecting the rights of an originator of a creative work, such as text, piece of music, painting, or computer program, through law.

E-commerce
E-commerce refers to the business transactions made over the Internet, such as buying and selling items online.

Electronic mail (e-mail)
The exchange of text messages and computer files over the Internet. An electronic mail (e-mail) is the electronic form of the traditional postal mail. E-mail allows you to exchange messages and files over a network.
Firewall
A filter that blocks unreliable information from the Internet before it reaches your computer or a private network. It provides additional protection against threats such as hackers and viruses. A firewall also helps to ensure computer privacy by restricting external access by any unauthorized user.

Hacker
A person who uses computer expertise to gain unauthorized access to a computer, and then misuses or tampers the programs and data stored on the computer.

Hyperlinks
An element in an electronic document that links to another place in the same document or to a different document. Generally, you click on the hyperlink to follow the link. Hyperlinks are the most necessary element in all hypertext systems, including the World Wide Web.

Internet
The Internet is a worldwide collection of public networks that are linked to each other for information exchange.

Intellectual Property
Any information available on the Internet is an intellectual property, which is legally owned by the person who created it. The owner of an intellectual property has the exclusive rights to control the use of this information.

Internet Service Provider (ISP)
An ISP is a company that provides Internet connectivity to individuals, businesses, and organizations.

IP address
An Internet Protocol (IP) address is a numeric address that specifies the exact location of a computer on the Web.

ISP
An Internet Service Provider (ISP) is a company that provides Internet connectivity to individuals, businesses, and organizations.
Modem
A modem is a connection device that allows you to connect your computer to the Internet. It converts digital information into analog information and transmits it over a phone line.

Network
A network is a group of computers that are connected to share resources and exchange information.

Online
When a computer is connected to the Internet, it is said to be online.

Online communities
Online communities are formed by groups of computer users who have common interests and purpose to communicate with each other over the Internet.

Online Predator
An individual who develops contact with Internet users, through chat rooms, online forums, or e-mail, to exploit them financially or involve them in dangerous relationships.

Password
A unique string of characters that a user types in as an identification code. It is a security measure used to restrict access to computer systems and sensitive files.

Phishing
The act of extracting personal information, such as passwords and credit card details, from computer users and then use the information for malicious purposes.

Plagiarism
The act of copying someone's work and using it as if it is your own work, without mentioning the source.

Portal
A portal is a Web site that offers information related to a specific topic in the form of a directory. A portal acts as a starting point to a number of resources on the Web.
Protocol
A protocol is a standard method of transferring data between different computers.

Search engine
A search engine is a program that allows you to search and retrieve information over the Internet.

Software Piracy
Unauthorized copying of copyrighted software without obtaining the license or permission of its copyright owner is software piracy.

Spam
An irrelevant and unsolicited e-mail message sent by an unknown sender. A spam is sent to distribute a message to many recipients at one time.

Spyware
A computer program that is installed on your computer without your knowledge. Spyware can secretly send out information about your Web browsing habits or other personal details to another computer through the network.

Username
The name by which a user is identified to a computer system or network. To access a computer protected by username and password, a user needs to enter the correct combination of username and password.

Universal serial bus (USB) cable
A cable that helps you connect digital devices to a computer without turning off the computer.

Virus
A computer program that is designed to cause malfunctioning of a computer or damage the data stored on the computer.

Worm
A computer program that propagates itself across computers, usually by creating copies of itself in each computer’s memory. A worm might duplicate itself in one computer so often that it causes the computer to crash.
The Web

The Web, also known as the World Wide Web (WWW), is a collection of information that is accessible on the Internet. This information is arranged logically and stored on computers known as Web servers.

Web address

A Web address specifies the protocol to be used for transferring data between different computers and the exact location of the Web site. A Web address is also known as the Uniform Resource Locator (URL).

Web browser

A Web browser is a program that enables you to view and interact with various resources on the Web.

Web page

A Web page is a formatted text document on the Web.

Web site

A Web site is a collection of one or more Web pages that are linked together and made available through a Web server.
UNIT 3

Mastering Typing
SESSION 1: GETTING STARTED WITH TOUCH TYPING

Touch typing is a method of typing without using the sense of sight to find the keys. Specifically, a touch typist will know their location on the keyboard through muscle memory. Touch typing typically involves placing the eight fingers in a horizontal row along the middle of the keyboard (the home row) and having them reach for other keys. Touch typing can be done using two hands or possibly only with one.

A touch typist starts by placing his or her fingers on the “start position” in the middle row and knows which finger to move and how much to move it for reaching any required key. Learning typically includes first printing exercises containing only letters on or near the standard position and then gradually mastering other rows. It is important to learn placing fingers into the start position blindly as the hands are frequently raised from the keyboard to operate the line feed lever (in the past) or (more recently) the computer mouse. The keys F and J frequently contain some surface features that allow the typist to recognize them by touch alone, thus removing the need to look down at the keys to reset yourself at the home row.

Typing speed generally improves with practice. The typing speed can be increased gradually and speeds of 60 WPM or higher can be achieved. The rate of speed increase varies between individuals. Many websites and software products (e.g. Rapid Typing Tutor) are available to learn touch typing and many of these are free.

Relevant Knowledge

Rapid Typing Tutor - Introduction to the Software

Rapid Typing Tutor is designed to teach adults and kids to use their computer keyboard more efficiently than ever. Learning to type is fun with the typing game included with Rapid Typing Tutor, while its extensive training statistics and customized lessons are rarely seen in the much more expensive products.

Getting Started with Rapid Typing

Typing Tutor is an easy-to-use keyboard trainer, so you’ll hardly have any troubles with its usage and configuration. Follow the links below to get started:

1. First, get familiar with Typing Tutor’s user experience.
2. Then, start your lessons and learn how to interpret your results and statistics.
If you feel that the preset lessons and courses are not enough, you may also want to create your own with Lesson Editor. It’s a quick and easy way to customize your learning process.

**Touch Typing Technique**

Touch typing improves typing speed and accuracy. A touch typist never looks at the keyboard. The fingers hit the right keys by force of habit. The typist is entirely focused on the text being typed, reading the words and phrases as the fingers type the text reflexively. Touch typing can be learned by performing special exercises.

**Stage one** of the process begins with learning the home row of the keyboard (the row beginning with the Caps Lock key). Looking at the keyboard is strictly forbidden. This is followed by learning the lower and upper rows, the numbers row, upper-case letters and special symbols.

**Stage two** involves memorizing frequently used syllables and typing words containing these syllables.

**Stage three** involves typing actual text to perfect the skills acquired.

**Touch Typing Rules**

- The F, D, S, A, and J, K, L; keys (on a QWERTY keyboard) represent the base position. Keyboards usually have small protrusions on the F and J keys. They help your fingers locate the base position without looking at the keyboard. Try to return your fingers to the base position after each keystroke.

- Colour coding shows which finger should press each key. (see the picture above) The left index finger is reserved for all the red keys. The right index finger is reserved for
green keys, and so forth. Use the thumb of whichever hand is more convenient for you to press the Space key.

- The base position on the numeric pad is the number 5 key for the middle finger, 4 for the index finger, and 6 for the ring finger. The numeric pad simplifies and speeds up numerical data input.
- Upper-case letters and symbols appearing on keys in the numbers row are typed by one hand with the little finger of the other hand holding down the SHIFT key.
- Do not look at the keyboard. Try to locate the right key with your fingers.

Correct position of the hands and body

- While at the computer, sit straight (see the picture above) Always remember to keep your back straight.
- Keep your elbows bent at the right angle.
- Face the screen with your head slightly tilted forward.
- There should be at least 50-80 cm of distance between your eyes and the screen. In other words, your outstretched arm should barely touch the screen.
- The optimum height of the tabletop or under-desk keyboard drawer is 68 to 73 cm from the floor.
The chair and table height should be chosen so as to expose the shoulder, arm, and wrist muscles to the least possible strain. The wrists can touch the tabletop in front of the keyboard. Never shift even a portion of your body weight to the wrists by resting on them.

**Advice for successful touch typing practice**

- **Do not rush at the early stages of learning.** High speed makes sense only when the fingers can hit the right keys by force of habit. Take your time when typing to avoid mistakes. The speed will pick up as you progress.
- **You should establish and maintain a rhythm while typing.** This means that keystrokes should come at equal intervals.
- **Hit keys only with the fingers for which they have been reserved.**
- **Limit your hand and finger movement only to what is necessary to press a specific key.** Keep your hands and fingers close to the base position. This improves typing speed and reduces stress on the hands.
- **Don’t look at the keys when you type.** Just slide your fingers around until they find the home row marking.
- **Don’t hammer on the keys.** Try using the minimum force possible.
- **To switch between upper/lower case always use the opposite hand.**

Be patient and practice as often as possible. Despite the simple touch typing rules, it takes some time to gain high speed. By following the rules, you will see your speed and accuracy improve over time.

**Exercise**

1. Sit high enough so that your elbow are approximately 90 degree angle as you type.
2. Place the fingers on the keys correctly i.e., you fingers should be on the home row keys – A, S, D, and F with the left hand and J, K, and L with the right hand.
3. Avoid looking at the key board while typing.
4. Use your thumbs for pressing the space bar after each pattern/word or sentence.
5. To repeat a line click at the end of your typed line and then hold the back space key till it deletes what you have typed. Now retype the line.
Practice the following:

<table>
<thead>
<tr>
<th>Practice Items</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fjdk sla ghty</td>
</tr>
<tr>
<td>Vmbn ruei woqp</td>
</tr>
</tbody>
</table>
| C,x. z/\"\'
~-=[] |

Shift Keys – FJKD SLA: GHTY

Shift Keys VMBN RUEI WOQP

Shift Keys – C<X> Z/”~+{} |

Numeric Pad – 4560 789 123 + - &* / .

Digits, Symbols – 56473 28190 %^$# @*() |

**SESSION 2: USER EXPERIENCE**

**Relevant Knowledge**

Once you’ve configured settings in Wizard, RapidTyping’s main window will appear as shown below.
The window is composed of the following controls:

- **Taskbar** lets you set or change on the fly some basic options to start a lesson (keyboard layout, level, lesson, and background).

- **Three horizontal buttons** in the top-right corner (Options, About and Help) can display the corresponding dialogs.

- **Three vertical buttons** in the top-left corner (Lesson, Statistics and Lesson Editor) are used for switching between current lesson, User Statistics and Lesson Editor.

- **Text Panel** is the area where the text to be typed is displayed. You can easily edit it in Lesson Editor, if necessary.

- **Lesson Control Panel** includes several controls to pause/resume the current lesson, enable/disable sounds, and adjust the sound volume.

- And **Keyboard** is the virtual keyboard that will help you to learn touch typing with all ten fingers. You can customize its appearance in the ‘Lesson’ section.

When you’re familiar with the **Typing Tutor** interface, go through how to start your first lesson. Remember to check our shortcuts also. They’ll make your interaction with **Typing Tutor** even more quick.

**SESSION 3: BEGIN LESSONS**

**Relevant Knowledge**

To start your first lesson in **Typing Tutor**, you have to select the keyboard layout, level and lesson category on the Taskbar shown below.
There are four drop-down lists in the top-left corner of the screen. Therefore, moving from left to right, the procedure will be as follows:

- Choose the layout (i.e. the language of your keyboard); it’s “EN” on the picture above.
- Then, select a level (there are three levels available — Beginner, Intermediate and Expert); it’s “Beginner” on the picture above.
- Specify lesson category (depending on the level chosen, the available categories may vary); it’s “Basics” on the picture above.
- And finally, choose the lesson you’d like to study.
- When everything is ready, press any key, then put your fingers in the initial position shown on the keyboard and start typing the text.

There’s also the Lesson Control Panel just above the Keyboard from where you can suspend/resume the current lesson or adjust the sound effects:
To start/resume a lesson, click the ▶ button just above the top-left corner of the keyboard.

To pause a lesson, click the ■ button that is displayed instead of the ▶ button.

To restart the current lesson, click the ▷ button, which is the far right button on the Taskbar.

To enable/disable sounds in the current lesson, click the ♫ button located above the top-right corner of the keyboard and set the sounds volume using the vertical slider.

**Notes:**

- You can also set the background image for the Text Panel by choosing an option (Animation, Wallpaper or Plain) from the drop-down list on the Taskbar in top-right corner of the window.

- While making your way through the lessons, you’ll probably mention two progress bars (one in green and another in yellow) on the Lesson Control Panel.

The green progress bar (upper) shows you the percentage of completion for the current lesson, and the yellow progress bar (lower) reflects the acceptable time period for typing a single character.

When the yellow progress bar runs out at least once, **Typing Tutor** records that you’ve broken the rhythm at this character (see How to View and Analyze Your Statistics for details).

Upon the completion of each lesson, the Results window appears. Learn how to estimate your typing progress.

**How to Interpret Your Results**

Each time you complete a lesson, the Results dialog window displays your achievements in this lesson.

The Results dialog window consists of two tabs called Rating and Errors. The first one looks like this:

Here, you can review your metrics: overall skill level between *Beginner* and *Champion* (upper slider indicator) as well as words per minute, characters per minute and accuracy in percent (three remaining sliders below).
In the text area, you can check your mistakes that occurred during the lesson. The color indication is as follows:

- **Green** letters denote right inputs.
- **Yellow** letters stand for right inputs exceeding the acceptable timeframe.
- **Red** letters denote wrong inputs within the acceptable timeframe.
- **Orange** letters indicate wrong inputs that also exceed the acceptable timeframe (it’s the worst result).

**Error window**

On the Error tab you can view your detailed statistics for the current lesson:

This tab shows your errors and delays percentage both in the graphical and table view. This will help you to better understand which letters are still hard for you to type. You can switch between the Errors in percent chart (by clicking the button just below the tabs) and Delay in percent chart (by clicking the button).
On the bar chart, the X-axis corresponds to the letters used in the lesson, while the Y-axis shows you the errors/delays related to each letter. If there aren’t any errors and delays for a certain character, it won’t show up on the chart. The table below represents the same data with the exact numbers.

**Note:** When you select a row in the table, the corresponding bar on the chart will be highlighted. When you select a column in the table, the chart will show either errors or delays.

Then, you can click the Next button below to proceed to the next lesson, Repeat to go through this lesson once again, or Records to check whether your results are great enough for *Typing Tutor*’s Hall of Fame.

**SESSION 4: VIEWING STATISTICS**

**Relevant Knowledge**

To view the results of all the lessons that you’ve already completed (not only the current one), go to the Statistics section.
How to view and analyze your statistics

To open the Statistics section, choose the button in the top-left corner of the main window. The Statistics screen will open as shown below.

Here, you can review your overall statistics and progress both in graphical and table view. The following options are available:

- Click the button in the top-left corner of the window (or press Ctrl+1 on your keyboard) to see your CPM speed (characters per minute) progress.
- Click the button (or press Ctrl+2 on your keyboard) to see your WPM speed (words per minute) progress.
- Click the button (or press Ctrl+3 on your keyboard) to see how your typing accuracy changes in the different lessons.
- To remove a metric from your statistics, select a lesson in the right table and click the button (or press Delete on your keyboard).

On the Taskbar in the upper part of the window, you can choose keyboard layout, level and course for which you’d like to see statistics.
You can also switch between the **Lesson Group** (that is, statistics by lessons) and **Day Group** (statistics by days) options in the far right drop-down on the Taskbar.

**Detailed Lesson Statistics**

To review the statistics for a particular lesson, choose this lesson in the right table and click the Lesson tab in the top-right corner. The Lesson tab contains the same data that are displayed upon completion of every lesson. For details, see How to Interpret Your Results section.

---

**SESSION 5: WORKING WITH LESSON EDITOR**

**Relevant Knowledge**

To open Lesson Editor, click the button in the top-left corner of the Rapid Typing window. The screen will appear as shown in the picture below.
Lesson Editor window is composed of the following controls:

- **Taskbar** lets you select the keyboard layout and level of the lesson you’d like to edit.
- **Toolbar** includes buttons for adding a new lesson, inserting text from file and saving changes.
- **Navigation Tree** shows the existing courses and lesson hierarchy.
- **Text Panel** is the area where you can edit the text of the lesson currently selected in the Navigation Tree.
- **Lesson Metrics** displays the number and percentage of words, characters, spaces and specific characters in the lesson.
- **And Keyboard** is the virtual keyboard that highlights the characters used in the currently selected lesson. You can customize its appearance in the ‘Lesson’ section.

Lesson Editor makes all the lessons fully customizable. You can add, insert, change, and delete lessons, group them in courses, and review the corresponding metrics.

**New Lesson**

To add a new lesson, perform the following:
Choose the keyboard layout and level from the drop-down list on the Taskbar.

In the Navigation Tree, choose the course where you want to add the lesson.

Click the button on the Toolbar (or press Ctrl+N on your keyboard). The following dialog box will appear:

![New Lesson dialog box]

- Fill out the fields in this dialog: specify the name of the lesson in Lesson Title, verify the course where the lesson should be added, select Lesson Type from the drop-down list and click OK. A new lesson will be added to the selected course and will show up in the Navigation Tree.

Then, you can either type or copy and paste the lesson text manually, or insert it from an external file. If you prefer the latter, there are two buttons available to you:

- If you want to simply insert a text from a single file into a single lesson, click the button (or press Ctrl+I on your keyboard) and choose the corresponding text file (txt and rtf files are supported).

- If you want to insert a text from multiple files into a multi-section lesson, click the button (or press Insert on your keyboard) and in the dialog box that appears specify a section, length of each subsection (in characters) and lesson type. All imported text will be split into several sections of nearly the same length. This function does NOT support RTF files.
Notes: If a text that is being imported contains unsupported characters (such as special Word symbols or foreign-language symbols), RapidTyping will display a dialog box suggesting you to skip them. It’s recommended that you click Yes.
To delete a lesson, select it in the Navigation Tree and click the \( \text{\textbf{x}} \) button on the Toolbar (or simply press the Delete key on your keyboard).

You can also view and/or change properties of the current lesson by clicking the \( \text{\textbf{}} \) button on the Taskbar.

**New Course**

To add a new course, perform the following:

- Click the \( \text{\textbf{+}} \) button on the Taskbar. The following dialog box will appear:

![New Course Dialog Box](image)

- Specify the name of your course, then choose the level from the drop-down list and click OK. The new course will be opened, and you’ll be able to add lessons in it as described above.

To delete a newly created course, click the \( \text{\textbf{x}} \) button on the Taskbar. You can also view and/or change properties of the current course by clicking the \( \text{\textbf{}} \) button on the Taskbar.
Notes:

- Characters used in the current lesson are highlighted in black on the virtual keyboard.
- You can scale the text of the lesson by choosing the scale value in the drop-down list just above the numeric pad of the virtual keyboard.
- Borders of Navigation Tree, Text Area and Lesson Metrics are movable, so you can adjust the width of these sections, if required.

Practice the following:

Practice Items

Fjdk sla ghty
Vmbn ruei woqp
C,x. z\"\-\[-\[ ]

Shift Keys – FJDK SLA: GHTY
Shift Keys VMBN RUEI WOQP
Shift Keys – C<X> Z/"\-\-\+\{ }

Numeric Pad – 4560 789 123 + - &* /.

Digits, Symbols – 56473 28190 %^$&# @*!()
Type using the basic keys as shown below:

Type using the Shift keys as shown below:
Information Technology – Class IX

Type using the Numerical Keypad and Digits/Symbols
Type basic syllables as shown below:

Type basic words as shown below:

Keep practicing till you achieve the goal of typing at a speed of 60 words per minute.
Exercise

Using your left hand type

asdf asdf asdf asdf asdf asdf asdf asdf asdf asdf
fdsa fdsa fdsa fdsa fdsa fdsa fdsa fdsa fdsa fdsa

Using your right hand type

jkl; jkl; jkl; jkl; jkl; jkl; jkl; jkl; jkl; jkl; jkl; jkl;

Using your both hand type

fd fdsa jk jk jkl; fd fdsa jk jk jkl; fd fdsa jk jk jkl;

Using your both hands type

gh gh gh gh gh gh gh gh gh gh gh

Stretch your Left index finger up/out to T (look on the keyboard) and type:

th th th th th th th th th th th th ght ght ght ght ght ght

Using your left hand type

deed frrf deer reed red deed frrf deer reed red deed frrf deer reed red free freed fred feed fed free freed fred feed fed

Using your right hand type

juuj kiik juj kik juuj kiik kiik juu juuj kiik kiik juj kik

Using you both hands type

juut jut jute kiit kit kide juut jut jute kiit kit kide jud judder juug jugger judge judged juuu juudd judder juge juge juge judge judged igh high thigh ight fright right fright fright
UNIT 4

Word Processing
SESSION 1: GETTING STARTED WITH A WORD PROCESSOR

Word processors help us deal effectively with most of such issues. Let us understand how word processors have an edge over using the traditional paper and pen. Using word processors, you can create and use a Word document. Word processors provide flexibility, ease, neatness and speed. You can use it for writing documents such as, articles, letter, resume, report, poem and also making posters. To sum up, a word processor can help you to:

• Correct any spelling mistakes made and also prompt you when you make spelling error.
• Insert or overwrite a word or sentence or paragraph, anywhere in the word document. This helps to maintain the neatness of the document. This task is called editing the document.
• Print a document created by you and also store it for future use, without a worry of it getting misplaced/ fading. You can also print multiple copies of the document in a single command.
• Change the appearance of different portions of a document, by changing the size of the words, make them bold or italic or underlined etc.
• Insert, headers and footers and page numbers (which increment automatically, if you so desire!).
• Present information in a tabular form as a part of the document.
• Insert pictures, and images into the document.

Relevant Knowledge

Some of the most popular Word Processing software are:

• OpenOffice – Write (desk top based)
• MS-Word (desk top based)
• Google Documents(Internet based)
• Notepad(limited features)

Though you can choose any of the above listed software to start creating documents, it is preferable that you start learning word processing by using either the OpenOffice–Write
or MS-Word. Make sure that this software is already installed in your computer. You can start using MS-Word software, by performing any one of the following steps:

a) Double Click on a shortcut key of the MS-Word icon, if available, on the desktop; OR


*If you are using any other word processor, the steps to start that word processor would be almost identical to what is given above.*

Once you start MS-Word, the following screen (Figure 1) is displayed. The components of the screen displayed are as shown in Figure 1.

**Opening or Creating a Document**

To begin with, let us create a simple document. Before creating the document, create a folder “D:\IT Class IX\WP_Practice” where you shall store all the documents that you create.
Open: Start the word processor as learnt in the exercise 1. Write the following paragraph in the work area of your screen.

Listening is an art. God gave us two ears and one mouth, so that we speak less and listen more. Only by listening carefully can we understand what the other person is saying and the meaning behind the words being spoken. This helps us understand the facts and opinions of the other person. This also helps us to improve the quality of the questions we can ask the other person.

Saving a Document

Save: Till now this paragraph that you have written is present in the internal memory of the computer, which is also called RAM (Random Access Memory). You need to save this document as a file on the hard disk of your computer.

You can do so by doing the following steps:

- In the Quick Access bar, click the symbol for the floppy OR
  2. A Save As dialog box appears.
  3. Choose the Directory (Drive and Folder) by clicking on the one that you want in the list shown on the left hand side. You will see the path on the D:\IT Class IX\WP_Practice displayed as you select the path.
  4. Enter the name which you would like to give to this document in the File name box. For example, you can give the name Listening to this file.
  5. Click Save.

Now this word document would be saved in MS-Word with the name Listening.docx, in the directory specified by you. The first part of the filename—Listening—is the name you gave to this file and .docx is the extension name for any document created under MS-Word.

Closing a Document

Close: You can close this document by following one of the following steps:

- Click on the cross symbol “X”, that you see on the top right hand corner of the screen.
  OR
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>Sl. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Start a word processor</td>
</tr>
<tr>
<td>2.</td>
<td>Identify various toolbars</td>
</tr>
<tr>
<td>3.</td>
<td>Create a new document</td>
</tr>
<tr>
<td>4.</td>
<td>Save and close a document</td>
</tr>
</tbody>
</table>

SESSION 2: EDIT AND SAVE A DOCUMENT

What happens if you want to take an existing document and want to add a paragraph or some words in it or edit it? Here in this exercise you from where you left it in the previous exercise. In this exercise, you will be opening the file saved in exercise 2 (D:\IT Class IX\WP_Practice\Listening.docx), editing it and then saving it under a different file name.

Relevant Knowledge

To begin, start the word processor.

a) Open: You can open a document only if it had been created earlier and saved on the hard disk / any other storage device. In the previous exercise, you had created a document and saved it with the name Listening.docx. To open this word document:
   - Select the drive and folder, select filename and click the Open button. The saved document opens.

b) Edit: After you open Listening.docx you can make changes to it, by adding another paragraph, or modifying any words or sentences which you had already written. Add one more paragraph in this document on” The Art of Listening”. You can add material on your own or use the follow paragraph:

   When we listen to another person, do not start judging what the other person is saying. Just listen and seek to understand the other person. This will help us to listen and seek to understand the point of view of the other person, without trying to judge whether you agree/disagree with what the other person is saying. By doing this you will become a more effective listener.
Information Technology – Class IX

c) **Save As:** Do remember that having made further changes; you need to save the changes by saving this modified document once again. You can save it with the same name *Listening.docx*, in which case the older file saved earlier will get overwritten by the changes which you made. Alternatively, you may like to keep the earlier file *Listening.docx* as it is, and save the modified document using a new file name, e.g. *Listening2.docx*.

- To save it with a different name, use the following steps:
  - Click the [1] **File** → [2] **Save As**
  - A **Save As** dialog box appears. Choose the Directory (Drive and Folder) by clicking on the one that you want in the list shown on the left hand side. You will see the path on the D:\IT Class IX\WP_Practice displayed as you select the path.
  - Enter the file name which you would like to give to this document. For example, you may give the name *Listening2*, to this file.
  - Click **Save**

b) To practice once again what you have learnt, repeat the above three steps by opening any other existing document in your computer, making changes to the contents of that file and saving this file with another name.

**EXERCISE**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Open a document from the specified location</td>
</tr>
<tr>
<td>2.</td>
<td>Type text and make insertions in an existing document</td>
</tr>
<tr>
<td>3.</td>
<td>Save an existing document with a new file name</td>
</tr>
</tbody>
</table>

**Additional Practice Exercises:**

1. Open a new document and write one paragraph about your favourite leader. Save the document with the name of the leader.

2. Pick up one paragraph from an English newspaper or magazine or your English text book and write that paragraph and save it as a file, with an appropriate name.
SESSION 3: IDENTIFY ELEMENTS OF USER INTERFACE

By now you would have observed that word processing software has very simple interface using menus in the Ribbon. Most of the commonly used functions have a graphical symbol or icon in the Ribbon. This kind of user interface is called Graphical User Interface or GUI (commonly pronounced 'gooey'). GUI is a type of user interface that allows users to interact with electronic devices using images rather than text commands. This section will familiarize you with the elements of the user interface.

Relevant Knowledge

In this session, you will take a short tour of the different tabs and some of the options under this tab, in the presentation software.

As shown in Figure 2 the Ribbon has eight Tabs; namely, File, Home, Insert, Page Layout, References, Mailings, Review, and View. Each tab further consists of the groups, and the groups contain icons. Icons are a pictorial representation for a command. Each Tab is self-explanatory; for example, if you want to insert any item into the document, click on the Insert tab. The groups and icons related to Home tab are displayed. Select the icon for the command which you want to use. The different tabs in MS-Word and the groups within them are as follows:

1. **Home**: Clipboard, Font, Paragraph, Styles, Editing
2. **Insert**: Pages, Tables, Illustrations, Links, Header & Footer, Text
3. **Page Layout**: Themes, Page Setup, Page Background, Paragraph, Arrange
Home Tab

Let’s understand the Home tab in more detail. The Home tab contains commands for formatting of text, selecting a new slide and drawing of objects. The Home tab is also used for editing content of documents (find and replace, and to perform clipboard operations such as cut, copy and paste. You will learn about these functions later in the course).

- The Clipboard group contains commands to cut, copy and paste text. The Format Painter is also present here.

- Font group commands allows change of the Font – font face, style, size, effects (Strikethrough, Shadow etc.), color and character spacing. These options can be changed, before or after typing the text. If case of after, select the text first.

- Paragraph group is used to change paragraph settings – alignment, indents, spacing, and pagination like Spacing 1.5, Double Spacing, Indentation, Spacing Before and After a Heading. Move the cursor to the line which needs to be changed.

- The Styles group allows quickly choosing a style and applying the style.

- Editing group contains commands to select, find and replace text.

In more detailed description of the different options available under each of the groups is given in the table below.
<table>
<thead>
<tr>
<th>Home Tab Groups</th>
<th>Description</th>
</tr>
</thead>
</table>
| Clipboard       | Paste the cut or copied information in Clipboard at the location where cursor is pointing right now (Paste Special - To paste in a particular format. Paste as Hyperlink - Used with copy to paste the copied information as a hyperlink)  
  - Cut the selected text from the document and put into Clipboard for later retrieval.  
  - Copy the selected item or text to the Clipboard.  
  - Format painter copies formatting from one place and apply to another (To apply same formatting to many places, double-click the format painter button)  
  - Bold, Italics, Underline |
| Font            | Change Font face, change font size  
  - Grow Font, Shrink Font  
  - Clear formatting (Clear all formatting from selection, leave only plain text)  
  - Strikethrough (draw a line through middle of selected text), Subscript, Superscript  
  - Change case. You can change the case – sentence, lower, upper, title, or toggle. Select the text and click on an option  
  - Font color, Text highlight color |
| Paragraph       | Bullets (choose from different styles)  
  - Numbered list (choose different formats)  
  - Multilevel list (Choose from different styles)  
  - Increase or decrease indent of the paragraph  
  - Sort alphabetically or numerically  
  - Show paragraph markups  
  - Align text left, right, centre, margins  
  - Change spacing between lines  
  - Color background behind selected text  
  - Customize the borders of selected text. Add borders and shading. There are options to select for setting, style, color, width, fill color, and pattern. You will see a preview at the right. To remove a border or shading, select None. |
| Styles          | Format titles using different styles like Caption, Emphasis etc.  
  - Change style, color and font used in the document |
| Editing         | Find text in the document  
  - Replace text in the document (The user can go to a page, section etc. when using find and replace)  
  - Select text or objects in the document |
SESSION 4: FORMAT A DOCUMENT – BOLD, ITALICS AND UNDERLINE

When you create a document, you may want some words/phrases/sections to immediately catch the reader’s eye. As a student you have done that by underlining text in your textbooks.

**Relevant Knowledge**

A word processor enables you to select and make parts of the documents **bold** or **italics** or **underlined**.

a) Open a new document in word processor and type in the following paragraph:

```
What is A Team?

“A team is a number of persons associated together in work or activity: as a group on one side (as in football or debate).” A Team is a group of people working together “or” come together as a team to achieve a common shared goal. In other words, when one person cannot complete a job alone and several individuals must cooperate to fulfill a mission, you need a team. The better the cooperation, communication, and coordination among team members, the more efficient the team.

“Individually, we are one drop. Together, we are an ocean.”
```

Now to make this paragraph to look better, you may need to format it like the paragraph shown below. You will notice that some words of this paragraph are in bold, some are in Italics and some are underlined.
What is A Team?

“A team is a number of persons associated together in work or activity: as a group on one side (as in football or debate).” A Team is a group of people working together or come together as a team to achieve a common shared goal. In other words, when one person cannot complete a job alone and several individuals must cooperate to fulfill a mission, you need a team. The better the cooperation, communication, and coordination among team members, the more efficient the team.

“Individually, we are one drop. Together, we are an ocean.”

b) Selecting a text: Before you can make “What is A Team?” bold, you need to select this text. Use the following steps to do so:

- Move your cursor, so that it is on or just before the capital W at the beginning of “What”.
- Press and hold down the left button of your mouse, then drag the cursor, to the right, going over the words “What is a Team?”, and then release the left mouse button.
- What is a Team? will appear. The shaded background and highlighted letters indicates that these words have been selected.

Note: To select just a single word, you need to double click on it.

Bold: A band on top has been marked as Ribbon. Towards the left side of the Ribbon, on the Home tab, you will see B I U (Figure 3). Click on the Alphabet B in the Font group, and you will see that the words “What is A Team?” is now bold. Go ahead use the same steps and make the required words bold.

Underline: The steps for underlining, any word or a group of words is exactly the same as for Bold, except that after selecting the text, instead of clicking B, you need to click U in the Font group.

Italics: The steps for italicising, any word or a group of words is exactly the same as the above two, except that after selecting the text, you need to click I in the Font group.
You may like to enter some more text from your English text book and practice making words Bold, Italics or underlined.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Mark text as <strong>Bold</strong></td>
</tr>
<tr>
<td>2.</td>
<td>Underline the text</td>
</tr>
<tr>
<td>3.</td>
<td>Convert text to <em>Italics</em></td>
</tr>
</tbody>
</table>

**Additional Practice Exercises**

1. Write a paragraph about the sports activities in your school. Give a heading to this paragraph. Bold and Underline the heading. Save this document in your computer.

2. Write a Notice for your notice board saying you have lost your English Textbook. Give it a heading “**Lost English Textbook**”. Underline the name of the textbook in the main body of the notice.

**SESSION 5: CHECK SPELLING**

**Relevant Knowledge**

The word processor also helps us create flawless documents by checking the spellings. In case we have typed wrong spellings, the processor can highlight the words that have been spelt wrongly.
Information Technology – Class IX

a) Open a new document in word processor and type in the following paragraph. You would notice that some words given in this paragraph have spelling mistakes. Type the paragraph along with these mistakes.

We spend years learning hwo to read and write but not even a class or two on listening! People think that listening is nattural and that they do not have to learn it. It’s like breathing.

This is sad since listening is primarily responsible for the many problems we have with each other. We speak at an average of 150 words per minute but our mind with its billions of cells can process almost a thousand words per minute. Managing this excess brain capacity is the clue to effective listening.

b) You would notice that the words which have spelling mistakes are highlighted with a wavy red line (for example: hwo). This is done automatically by the word processor.

1. Click on the Review tab on the Ribbon.
2. Click on the option Spelling & Grammar in the Proofing group, as shown in Figure 4.

![Fig. 4: Review Tab Options](image)

3. The Spelling and Grammar dialog box appears. You can see that it is suggesting that the correct spelling is “how”. You can click on the suggestion “how” and the spellings will be automatically corrected and the dialog box will proceed to show you the next spelling mistake and give you multiple options through the dialog box. You can choose the applicable suggestion or option and move ahead.

**Note:** Though the word processor may suggest changes, you need to use your own discretion whether to change / not to change the spelling; or, which spelling to choose from the list provided. Also, the word processor automatically runs through your entire
document suggesting corrections for spelling and grammar. If you have selected some
text, it will first check the selected text and then prompt you for checking the rest of the
document.

A word processor also provides another way to change a spelling mistake. The steps are
listed below:

3. Position the cursor on any part of the misspelt word (the word with a wavy red line
below it).
4. Right-click the mouse.
5. A pop-up menu box appears (Figure 5).
6. You can select the correct spelling option on the top (given as “natural”) and the
spelling will be corrected automatically in the text.

Go ahead and correct the spelling mistakes in the paragraph (Figure 6).

Fig. 5: Pop-up menu box (Spelling)
Information Technology – Class IX

Fig. 6: Spelling and Grammar dialog box

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Identify spelling errors in a document</td>
</tr>
<tr>
<td>2.</td>
<td>Run spell check for correcting spelling errors in a document</td>
</tr>
<tr>
<td>3.</td>
<td>Add words to the dictionary of the word processor</td>
</tr>
</tbody>
</table>

**SESSION 6: CHECKING GRAMMAR AND USING THESAURUS**

As you create a document, you sometimes make grammatical mistakes or are looking for a different word to explain what we mean. Word processors help us in these corrections.
Relevant Knowledge

Check Grammar

The word processor can also check and point out grammatical mistakes in the sentences we have typed.

a) Open a new document in word processor and type in the following paragraph. You would notice that each of these sentences have some grammatical mistakes. Type the paragraph along with these mistakes.

I will went to the market tomorrow.
She will be very sad to left us.
She finish making breakfast.

b) You will notice that the spelling mistakes are automatically underlined by red color and grammatical mistakes by a wavy green line.

c) The method of correcting grammatical mistakes is exactly the same as that for correcting the spelling mistakes.

1. Click on the **Review** tab on the **Ribbon**.
2. Click on the option **Spelling & Grammar** in the Proofing group

The Spelling and Grammar dialog box appears. It will prompt you with suggestions. You can select the suggestion and the text will be automatically corrected and the dialog box will proceed to show you the next error with suggested changes. You can choose the applicable suggestion or ignore it and move ahead.

**Note:** Though the word processor may suggest changes, you need to use your own discretion whether to change / not to change the text

A word processor also provides another way to change a grammatical mistake. The steps are listed below:

1. Position the cursor on any part of the word with a wavy green line below it.
2. Right-click the mouse.
3. A pop-up menu box appears (Figure 7).
4. On the menu, you may be given a suggested correction. You can choose to ignore the error or click About This Sentence to see why the processor considers the text to be a mistake.
So go ahead and correct the above grammatical mistakes.

Practice more by writing text with spelling and grammatical errors and then correct them.

**Using Thesaurus**

Sometimes while creating a document, you search for a word similar in meaning to the word you have in mind. A word processor helps you to look up synonyms (different words with the same meaning) and antonyms (words with the opposite meaning) in the thesaurus.

How is it different from a dictionary? A dictionary contains definitions and pronunciations, whereas thesaurus will have words with similar meanings or opposite meanings.

Let’s check the thesaurus for words which have similar meanings to *market*.

- Select the text “market”.
- Click on the *Review* tab. You will see the various options as listed in the Proofing group.
- Position the *cursor* anywhere on the word “market” and click the Thesaurus option. A box opens up on the right side of the screen. This is the *Research* task pane where the
result of your search is displayed. In this pane, you will see a list of words similar to the one you had selected. The selected word is displayed in the small box at the very top of this pane and possible replacements are displayed in the longer list.

You can see that some of the similar words are: marketplace, souk, bazaar, shop, arcade, fair etc.

- To use one of the words in the list of results or to search for more words, do one of the following:
  
  ♦ To use one of the words in the list, place your cursor on it, click the down arrow that appears on doing so, and then click on one of the three options.
    
    - To replace the word in your document, click on Insert.
    - Click on Copy to copy the word, but not replace anything in your document. You can paste the copied word in your document, using the Home tab Paste option.
    - Click on Look Up to see other possible replacement words. Note: If you click on the listed word instead of the down arrow, you will replace the word in the small box at the very top of the research pane.
  
  ♦ To look up additional related words, click a word in the list.

Practice more by entering the words like school, cinema, communication, etc.
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Identify grammatical errors in a document</td>
</tr>
<tr>
<td>2.</td>
<td>Run spelling and grammar check for correcting grammatical errors in a document</td>
</tr>
<tr>
<td>3.</td>
<td>Run Thesaurus for inserting synonyms in the document</td>
</tr>
</tbody>
</table>

SESSION 7: COPY - PASTE AND CUT - PASTE

Relevant Knowledge

In a handwritten document to repeat a paragraph, or, if a paragraph was to be moved elsewhere, you would need to write the whole document all over again! However, using word processor, this can easily be done using the Copy/Cut and Paste feature.

Copy and Paste

You can copy text from the document to a different position in the same document or to a new document. The original text is not altered. Enter the following text in a new document.

Some good manners to keep in mind are:
- Not interrupting others while they are talking;
- Not carrying on side conversations while someone is talking;
- Considering other’s feelings and concerns when making decisions or comments;
- Being respectful of the instructor and classmates; your peers and superiors at the workplace;
- Avoiding arguments and disagreements;
- Providing assistance when asked;
- Using terms such as “please” and “thank you.”

To copy the first point “Not interrupting others while they are talking;” and paste it at the end of the last line, follow the steps given below:
Note:

*Copy* means to *Select* text and then *Copy* that text onto your “clipboard”. The “clipboard” is a temporary short-term data storage area in your computer where the text is temporarily placed.

*Paste* means to place the text that is on the “clipboard” into your document.

1. Select the text that is to be copied.
2. Right-click the mouse anywhere on the selected text. A pop-up menu appears (Figure 10).
3. Click *Copy*. The menu goes away.
4. Click at the end of the last line in the document and press **Enter**. The cursor moves down to the next line.
5. Right-click, then click *Paste*. The selected sentence is copied below the last sentence.

Notice that the original sentence is still at the same place, it has been duplicated at the end of the last sentence.

**Cut and Paste**

There is a minor but very important difference between “*Copy and Paste*” and “*Cut and Paste*.”

- In “*Copy and Paste*” the original set of text remains where it was and it is also pasted to another place in the document.
- In “*Cut and Paste*” the original set of text gets deleted and it pasted to another place in the document.

You can now try the “Cut and Paste” feature by cutting the line “Avoiding arguments and disagreements”, and pasting it as the first line of your document. To do so, use the following steps:

Note:

1. *Cut* means to *Select* text and then *Copy* that text onto your “clipboard”.
2. Select the text that is to be copied. (You have learnt to select text in Exercise 4.)
3. Right-click the mouse anywhere on the selected text. A pop-up menu appears. Click *Cut*. The menu goes away.
4. Click at the beginning of the first line in the document and press Enter.
5. Right-click, then click Paste. The selected sentence is copied below the last sentence.

Notice that the original sentence has been deleted.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Select, copy and paste text in a document</td>
</tr>
<tr>
<td>2.</td>
<td>Select, cut and paste text in a document</td>
</tr>
</tbody>
</table>

**SESSION 8: FIND AND REPLACE TEXT**

**Relevant Knowledge**

The documents that we create in a word processor are not always small paragraphs of a few sentences. Mostly these documents are multi-page. Study notes are a good example of such documents. Suppose you have created Social Science notes using word processor. You notice that at some places in the document the word Delhi has been misspelled as Dlehi. Now to correct it you have to go each specific location in the document where
correction is to be made. You can use the **Find and Replace** feature of word processor to easily do this task. Using this feature, you can find all the occurrences of a specific word or group of words in a document and also replace them with a new word or a group of words.

Enter the following text in a new document and save the file with the name *Global Warning*.

**What is Global Warning?**

Global warning is when the earth heats up (the temperature rises). Global **warning** happens when greenhouse gases (carbon dioxide, water vapor, nitrous oxide, and methane) trap heat and light from the sun in the earth’s atmosphere, which increases the temperature. This hurts many people, animals, and plants. Many cannot take the change, so they die. Global **warning** is a very important issue for the survival of life on earth.

In the above text you would notice that four words have been highlighted. You have entered the word “Warning” instead of “Warming.” You will now learn how to find the “warning” at each of the places it occurs in the document and replace the word with “warming”. Follow the steps given below:

- Click **Find** in the Home tab, **Editing group** or press CTRL+F keys together.

  ![Find in Home Tab](Fig. 11: Find in Home Tab)

  - **A Find and Replace** dialog box appears.
  - To just Find the word, click **Find**. Enter text you want to search in the **Find what** box. To find one such word, or phrase, click **Find Next**. To find all occurrences of the word or phrase, click **Find in**, then click **Main Document**.
  - To find and replace, click **Replace** tab. Enter text to find in **Find what**. Enter text to replace in **Replace with**.

---

**Information Technology – Class IX**

---
Choose the action to be taken by clicking on – *Replace, Replace All, Find Next*, buttons accordingly.

### What is Global Warming?
Global warming is when the earth heats up (the temperature rises). Global warming happens when greenhouse gases (carbon dioxide, water vapor, nitrous oxide, and methane) trap heat and light from the sun in the earth’s atmosphere, which increases the temperature. This hurts many people, animals, and plants. Many cannot take the change, so they die. Global warming is a very important issue for the survival of life on earth.

**Note:**
You need to be careful while using *Replace All*. *Replace All* is a global function. It replaces the *selected* text with the *specified* text all over the document. There may be an instance where a word needs to be retained, but in a global replace, it gets overwritten. For example, if in the text you had typed, there was a sentence “We must pay heed to the warning signals of nature.”, and you used a global replace (*Replace All*), the word warning would also be replaced as warming!

### Exercise
Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Replace text in a document using Find option</td>
</tr>
</tbody>
</table>

### SESSION 9: CREATE LIST OF ITEMS USING BULLETS AND NUMBERING

**Relevant Knowledge**
Very often, you need to create a list of items. This can be neatly done by using the features described below:
You need to create a document as given below in the box.
Every interaction starts with some form of greeting. Given below are some statements we generally make whenever we greet someone.

**Greeting a friend:**
- Hi! How are you doing?
- Hey! It has been a long time since we last met!
- Hi! What are you doing now?
- Hey! How’s life?

**Greeting an acquaintance:**
- Hello! How are you?
- Hello! How have you been?
- Good morning/afternoon/evening! All’s well?

**Greeting a stranger:**
- Hello!
- Good morning/afternoon/evening!
- How do you do?
- My name is Aarti. May I know your name?

Enter the above text in the document. Now do the following steps:

1. Select the text of the group of first four statements below the heading “Greeting a friend”.
2. On the Home tab, in the Paragraph group, click the Bullets icon. You will see that the bullets appear at the beginning of each of the four sentences.
3. Repeat this process by clicking on the down arrow next to the Bullets icon. You can select a bullet shape from here.

Repeat the above given step 1 and 2 with the other two headings.

Now create another document and create a bulleted list of items you would pack, when you for a family holiday. Try numbering this list, with the Numbering icon.

![Bullets and Numbering Icons](Fig. 12)
**When is it better to use bullets than numbers?**

Use numbered lists when you’re working with instructions to be done in a sequence i.e. steps to be followed, and the numbers suggest a hierarchy. The same applies when you refer to specific items by number. Numbered and unnumbered lists are more commonly used in scholarly publications. If numbers aren’t essential (very necessary), use bullets, especially in business documents.

**When to capitalize the first letter in a bulleted item?**

In most cases, it is recommended that you start each bulleted item with a capital letter. Till now, you have capitalized only proper nouns and the first word of a complete sentence, so it almost seems wrong to capitalize single words and phrases. However, for the sake of a good presentation, you need to do it anyway.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a bulleted list of the items in a document</td>
</tr>
<tr>
<td>2.</td>
<td>Create a numbered list of the items in a document</td>
</tr>
</tbody>
</table>

**SESSION 10: FORMAT FONT STYLE**

**Relevant Knowledge**

We have learned some of the formatting options available in word processors, in some of the previous exercises. In this exercise you will learn to change the font style of the selected text in a document.

Font refers to the style of writing i.e. how the characters look in the document. The look of characters can be changed using the Font face (name), Font Size, and Font Color.

Create the document shown below:

- This is Cambria font.
- This is Times New Roman font.
- This is Bookman Old Style font.
- This is Courier New font.
- This is Book Antiqua font.
- This is Algerian font.
In this exercise, you will learn to change the font in two ways; using the icons on the Ribbon and using the shortcut menu.

I. Using the Icons on the Ribbon

Select the text “This is Cambria font.”

Now on the Home tab, left click on the small arrow. A screen displaying a list of Font types appears.

Click on the *Cambria* font. The font of the selected text will change to *Cambria*.

![Fig. 13: Font Selection](image-url)
Now go ahead and follow the same steps for changing the font style of others sentences, to what is written in the text.

This is Cambria Font.
This is Times New Roman font.
This is Bookman Old Style font.
This is Courier New font.
This is Book Antiqua font.
This is Algerian font.

Fig. 14: Font

Fig. 15: Font changed in line-1

Fig. 16: Different fonts
II. Using Short cut menu and the dialog box

We will restart with the original document above.

Select the text “This is Cambria font” and right click the mouse button. A Short cut menu appears.

![Fig. 17: Short Cut Menu](image)

Click on the option *Font*... A Dialogue box appears with the *Font* tab selected by default.

Choose the font *Cambria* from the given font list. If needed use the scroll bar.

Now go ahead and follow the same steps for changing the font style of others sentences, to what is written in the text.
Create the document as shown in left side of the figure 19. Then change the font size of each of the sentences, as shown in the right side of Figure 19.

- The steps to do this are similar to what you followed for changing the font style.
- The only difference is that now you need to use the option of changing the font size, instead of the font style.

This is font size 8. This is font size 9. This is font size 10. This is font size 11. This is font size 12. This is font size 13. This is font size 14.

Fig. 18: Dialogue Box for changing Font

Fig. 19

Fig. 20
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Change the Font style of text using the ribbon</td>
</tr>
<tr>
<td>2.</td>
<td>Change the Font style of text using a short cut menu</td>
</tr>
<tr>
<td>3.</td>
<td>Change the Font size of text using the ribbon</td>
</tr>
<tr>
<td>4.</td>
<td>Change the Font size of text using a short cut menu</td>
</tr>
</tbody>
</table>

Additional Practice Exercise

Create a new document on any topic. Now change both the font style and font size of the contents of different parts of this document.

SESSION 11: ALIGNING THE TEXT

Relevant Knowledge

Now that we have seen some different capabilities of a word processor, let us see how this can be useful. A common usage or example of a document is a letter. We can use a Word Processor to type a letter in the proper form. You need to write the following letter in a document.

Tagore Public School
Ambala Cantt

M/s New Star Sports Company
Kalkaji
New Delhi -1100

5th January 2012


Dear Sir,

Kindly send the following Sports material at the above address through transport with proper cash bill.
1. Foot Ball (10 Nos).
2. Cricket Balls. (20 Nos).
3. Tennis Balls (20 Nos).

All the items should be in good condition and packed properly. Any damage to these items during transportation will be your responsibility. The items should reach the school within 10 days after the receipt of the letter; otherwise the order shall stand cancelled.

Thanking you
Yours sincerely
Nitish
(Head Boy)

• Now save the above document in the computer.
• The date in the above letter is on the right hand side. This is called Right Alignment of a text.
• Similarly, the subject line in the above letter is in the middle. This is called Centre Alignment of the text.

**Fig. 20: Align Text**

• On the Home Tab you would notice the set of icons
• To Right Align the date, select the date. Then click the icon for Align Text Right. Similarly, you can Centre Align the Subject line in the above letter.
• Do remember to save the above letter.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Align text to the left</td>
</tr>
<tr>
<td>2.</td>
<td>Align text to the centre</td>
</tr>
<tr>
<td>3.</td>
<td>Align text to the right</td>
</tr>
<tr>
<td>4.</td>
<td>Align text to both left and right margins</td>
</tr>
</tbody>
</table>
SESSION 12: VIEWS OF A DOCUMENT

Relevant Knowledge

Word Processors provide options to work on a document in different formats/layouts – Print Layout, Full Screen Layout, Web Layout, Outline and Draft.

Each of these layouts gives a different look to the document. You can use a particular view depending on what you want to do with the document. For example, if you want to print a document, use Print Layout view. If you want to create a web page, use Web Layout view.

Open a new document and write the following text.

<table>
<thead>
<tr>
<th>Leadership Qualities</th>
</tr>
</thead>
<tbody>
<tr>
<td>Leadership can be defined as one’s ability to get others to willingly follow. Every organization needs leaders at every level. Leaders can be found and nurtured if you look for the following character traits.</td>
</tr>
<tr>
<td>A leader with <strong>vision</strong> has a clear, vivid picture of where to go, as well as a firm grasp on what success looks like and how to achieve it. But it’s not enough to have a vision; leaders must also share it and act upon it. Jack Welch, former chairman and CEO of General Electric Co., said, “Good business leaders create a vision, articulate the vision, passionately own the vision and relentlessly drive it to completion.”</td>
</tr>
<tr>
<td>A leader must be able to communicate his or her vision in terms that cause followers to buy into it. He or she must communicate clearly and passionately, as passion is contagious.</td>
</tr>
<tr>
<td>A good leader must have the discipline to work toward his or her vision single-mindedly, as well as to direct his or her actions and those of the team toward the goal. Action is the mark of a leader. A leader does not suffer “analysis paralysis” but is always doing something in pursuit of the vision, inspiring others to do the same.</td>
</tr>
</tbody>
</table>

Click on the **View tab**, on the Ribbon. The icons in the **Document Views** group are as shown in Figure 21.

The commonly available views are:

- **Print Layout**: It is the default document view setting. You will be able to see how the document will look when it gets printed.
Full Screen Reading: This view provides the maximum space available for reading the document. It hides the ribbon and provides a full screen view of the document in two (side-by-side) frames, similar to a book. This gives more text on the screen and makes it easier to read a multi-page document.

Web Layout: It shows how the document will appear in a web browser. In this view, the document looks like a web page.

Outline: This view displays the document as an outline and shows only the headings present in the document. This enables you to see the structure of the document and move to different parts of your document easily. This view is useful when you are looking at a document which has a large number of pages and sections.

Draft: This view is used for quick editing of the document. You would normally not use this view. It is helpful for proofreading of the document.

Click on the icons for different layouts and see how the different view looks like. Look for differences between different views. In each of the views, a toolbar opens with tools for editing the document depending on the view. When you have been through all the Views, save and close the document.

Note: You can’t set a default for all documents that you view in Word, because the view setting is stored with each individual document as a document property. You can save your document in the view with which you want to open. Documents that you receive from others will open with the view in which they were previously saved.
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>View the document as it will appear on the Printed Page</td>
</tr>
<tr>
<td>2.</td>
<td>View the document in Full Screen</td>
</tr>
<tr>
<td>3.</td>
<td>View the document as it will look as Web Page</td>
</tr>
<tr>
<td>4.</td>
<td>View the document as Outline</td>
</tr>
<tr>
<td>5.</td>
<td>View the document as Draft</td>
</tr>
</tbody>
</table>

SESSION 13: PRINT A DOCUMENT

Relevant Knowledge

A copy of a saved document is accessible on the computer using the word Processor. However, after is completed, it needs to be printed to be read by others who are not using a computer.

*Good to Know:* In IT jargon, a document saved on the computer is called a *Soft Copy* and one that is printed is called *Hard Copy*.

Open a new document and write the following text.

**Integrity** is the integration of outward actions and inner values. A person of integrity is the same on the outside and on the inside. Such an individual can be trusted because he or she never veers from inner values, even when it might be expedient to do so. A leader must have the trust of followers and therefore must display integrity.

Honest dealings, predictable reactions, well-controlled emotions, and an absence of tantrums and harsh outbursts are all signs of integrity. A leader who is centred in integrity will be more approachable by followers.

**Dedication** means spending whatever time or energy is necessary to accomplish the task at hand. A leader inspires dedication by example, doing whatever it takes to complete the next step toward the vision. By setting an excellent example, leaders can show followers that there are no nine-to-five jobs on the team, only opportunities to achieve something great.

You will now take a print out of this document. Make sure that there is a printer connected with your computer and has paper in it. Do the following:
Click [1] **File** → [2] **Print**. A *Print* dialog box appears. There are many settings available in this dialog box, which you can use, as required. Make settings as per the following:

- **Print Range**: You can select what you want to print:
  - **All**: Whole document
  - **Current Page**: Page on which the cursor is currently placed.
  - **Selection**: Only the selected text is printed.
  - **Pages**: Specify the selected page numbers that need to be printed. For example, 2-6 means, print page numbers 2, 3, 4, 5 and 6 while 1,3 means, print page numbers 1 and 3.
- **Copies**: You can select the number of copies of the document to be printed.
- **Properties**: If you click on the Properties, a dialog box appears (Figure 22), with many more options which can be set. We will not discuss them right now. You will learn about them later (in advanced levels).

![Print Dialog Box](image)

**Fig. 22: Print Dialog Box**

- Click **OK** to print the document.
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Print the whole document</td>
</tr>
<tr>
<td>2.</td>
<td>Print current page</td>
</tr>
<tr>
<td>3.</td>
<td>Print selected text</td>
</tr>
<tr>
<td>4.</td>
<td>Print selected pages</td>
</tr>
</tbody>
</table>

SESSION 14: CREATE A TABLE

Relevant Knowledge

Like a list, information often needs to be presented in a tabulated, organized manner. You will learn to present tabulated information in this exercise.

A table is an arrangement of rows and columns, as shown in Figure 23.

```
<table>
<thead>
<tr>
<th></th>
<th></th>
<th>Height (cm)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Mohan</td>
<td>13</td>
</tr>
<tr>
<td>2.</td>
<td>Mehul Kapoor</td>
<td>14</td>
</tr>
<tr>
<td>3.</td>
<td>Parampreet Ghuman</td>
<td>13</td>
</tr>
<tr>
<td>4.</td>
<td>Thomas Matthews</td>
<td>15</td>
</tr>
<tr>
<td>5.</td>
<td>Ashfaq Ali</td>
<td>14</td>
</tr>
<tr>
<td>6.</td>
<td>Venkat Subrmaniam</td>
<td>13</td>
</tr>
<tr>
<td>7.</td>
<td>Vijay Mandke</td>
<td>14</td>
</tr>
<tr>
<td>8.</td>
<td>Mary Kom</td>
<td>15</td>
</tr>
</tbody>
</table>
```

Fig. 23: A Table and its components

A table helps you to present information in an organized form. Each of the rows given in the above table may also be called a Record. Now you need to create the above table, which has 4 columns and 9 rows.
• Click on your document where you want to create a table.
• Select the **Insert** tab. Select **Table** from the Tables group. An **Insert Table** drop down menu appears
• Take your mouse pointer to the first left-hand upper-corner empty box in this menu. A single column, single row table appears on your document (at the position where you had last left your drag and select four boxes for 4 columns and a few boxes for rows. (You can see the table being created on your document.)

![Insert a Table](image)

**Figure 24: Insert a Table**

• To complete the process click the left button of the mouse.
• An empty table having the selected number of rows and columns is inserted in the document. Enter the data (refer sample above) in the table by clicking on each cell.

Note: You can move from cell to cell row-wise using the **Tab** key. When you reach the last cell (right hand bottom corner) of a table, and you press **Tab** key once again, a fresh row is added at the bottom.
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Insert table in a document with specified rows and columns</td>
</tr>
<tr>
<td>2.</td>
<td>Insert rows to a table</td>
</tr>
</tbody>
</table>

Additional Practice Exercises

a) Create a table in which you list down all the books in your school bag. You can have serial number, name of the book, subject name, no. of pages in the book etc.

b) Create a table in which you list down; name, address, phone number of ten of your friends or relatives.

SESSION 15: FORMAT A TABLE

Relevant Knowledge

By formatting a table, you can improve the appearance of a table and make it more presentable and attractive.

Create a table with the following headers: Serial Number (S.No.), Teacher’s Name and Subject (the subject taught by the teacher). A sample is given below:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Teacher’s Name</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Ms.Radhika Madan</td>
<td>Hindi</td>
</tr>
<tr>
<td>2.</td>
<td>Mr.Subramaniam Reddy</td>
<td>Maths</td>
</tr>
<tr>
<td>3.</td>
<td>Mr. Austin Thomas</td>
<td>English</td>
</tr>
<tr>
<td>4.</td>
<td>Ms.Sudipta Roy</td>
<td>Science</td>
</tr>
<tr>
<td>5.</td>
<td>Dr.Pritam Singh</td>
<td>Social Studies</td>
</tr>
<tr>
<td>6.</td>
<td>Ms.Vibha Goel</td>
<td>Computer</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Science</td>
</tr>
</tbody>
</table>
1. Formatting the table

1. Click anywhere on the table which you have created. A Design tab and a Layout tab appear in the ribbon, as shown in the figure below.

![Fig. 25: Format a Table](image)

2. Click on the Design tab.

3. Experiment with the different styles given in the ribbon and the various options, on the created table. Using some of these options, the above table can be formatted in the following manner:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Teacher’s Name</th>
<th>Subject</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Ms. Radhika Madan</td>
<td>Hindi</td>
</tr>
<tr>
<td>2.</td>
<td>Mr. Subramaniam Reddy</td>
<td>Maths</td>
</tr>
<tr>
<td>3.</td>
<td>Mr. Austin Thomas</td>
<td>English</td>
</tr>
<tr>
<td>4.</td>
<td>Ms. Sudipta Roy</td>
<td>Science</td>
</tr>
<tr>
<td>5.</td>
<td>Dr. Pritam Singh</td>
<td>Social Studies</td>
</tr>
<tr>
<td>6.</td>
<td>Ms. Vibha Goel</td>
<td>Computer Science</td>
</tr>
</tbody>
</table>

You can go ahead and try some more options on the same table and format it in different ways.

2. Layout of the Table

More settings are available under the Layout tab as shown in Figure 26. Click on the Layout tab to view them. You can go ahead and click on different icons to experiment with varying ways of changing the layout of the table.

![Fig. 26: Table layout icons](image)
Some of the tasks you can do are as follows:

- Add one more teacher for the third language. Do this by keeping the cursor on the last row of the table and clicking on the icon for Insert Below. This inserts a blank row below the current row, where the cursor is positioned.

- Add one more column to this table. Position the cursor anywhere on the last column. Click on the icon Insert Right. This inserts a column on the right hand side. In this column you can add the educational qualifications of the teacher.

- Now add one more row on top of the table. Merge all the cells in the new row added by using the icon Merge Cells. Note: Before clicking on this icon, you should select all the cells in the first row.

### List of Teachers in Standard IX-A

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Teacher’s Name</th>
<th>Subject</th>
<th>Qualifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Ms. Radhika Madan</td>
<td>Hindi</td>
<td>MA, B.Ed</td>
</tr>
<tr>
<td>2.</td>
<td>Mr. Subramaniam Reddy</td>
<td>Maths</td>
<td>M.Sc., B.Ed.</td>
</tr>
<tr>
<td>3.</td>
<td>Mr. Austin Thomas</td>
<td>English</td>
<td>MA, M.Phil.</td>
</tr>
<tr>
<td>5.</td>
<td>Dr. Pritam Singh</td>
<td>Social Studies</td>
<td>MA, Phd</td>
</tr>
<tr>
<td>6.</td>
<td>Ms. Vibha Goel</td>
<td>Computer Science</td>
<td>BCA, B.Ed</td>
</tr>
<tr>
<td>7.</td>
<td>Mr. Sharanjit Singh</td>
<td>Sanskrit</td>
<td>MA, B.Ed</td>
</tr>
</tbody>
</table>

### Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Change the design of a table</td>
</tr>
<tr>
<td>2.</td>
<td>Add rows to a table</td>
</tr>
<tr>
<td>3.</td>
<td>Add columns to a table</td>
</tr>
</tbody>
</table>
SESSION 16: CONVERT TEXT TO TABLE AND TABLE TO TEXT

Relevant Knowledge

In most of the word processors, there is a feature to convert a normal text data into a table. In this exercise you will convert the text data into a table. Create a document with the following details:

<table>
<thead>
<tr>
<th>Name</th>
<th>Phone</th>
<th>City</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ajay</td>
<td>991049644</td>
<td>Delhi</td>
<td>Delhi</td>
</tr>
<tr>
<td>Anita</td>
<td>9891262366</td>
<td>Noida</td>
<td>UP</td>
</tr>
<tr>
<td>Sudha</td>
<td>8089942315</td>
<td>Hissar</td>
<td>Haryana</td>
</tr>
<tr>
<td>Gautam Sen</td>
<td>7467698234</td>
<td>Guwahati</td>
<td>Assam</td>
</tr>
<tr>
<td>Rajshekhar</td>
<td>9234987492</td>
<td>Coimbatore</td>
<td>Tamil Nadu</td>
</tr>
</tbody>
</table>

Note: Commas have been inserted between the different data. This indicates where you want to divide the text into columns. Use paragraph marks (Press Enter key) to indicate where you want to begin a new row.

- Select the text that you want to convert from the document.
- On the Insert tab, in the Tables group, click Table, and then click Convert Text to Table. This is shown in below.
- A Convert Text to Table dialog box appears as shown in Figure 27.

![Fig. 27: Text to Table Conversion](image-url)
In the Convert Text to Table dialog box, under Separate text at, click the option for the separator character that is in your text (Commas in this case).

In the Number of columns box, check the number of columns. If you don’t see the number of columns that you expect, you may be missing a separator character in one or more lines of text.

Select any other options that you want.

The table created will look like the following:

<table>
<thead>
<tr>
<th>Name</th>
<th>Phone</th>
<th>City</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ajay</td>
<td>991049644</td>
<td>Delhi</td>
<td>Delhi</td>
</tr>
<tr>
<td>Anita</td>
<td>9891262366</td>
<td>Noida</td>
<td>UP</td>
</tr>
<tr>
<td>Sudha</td>
<td>8089942315</td>
<td>Hissar</td>
<td>Haryana</td>
</tr>
<tr>
<td>Gautam Sen</td>
<td>7467698234</td>
<td>Guwahati</td>
<td>Assam</td>
</tr>
<tr>
<td>Rajshekhar</td>
<td>9234987492</td>
<td>Coimbatore</td>
<td>Tamil Nadu</td>
</tr>
</tbody>
</table>

You can also convert the table to text.
Select the entire table. You can do this by dragging your cursor over the table, or by going again to the menu bar, clicking on “Table” and then scroll down to “select table”. Once you have selected the entire table, go again the “Table” menu and scroll down to “convert table to text”. You will get another formatting dialog box, this time asking how you wish to separate the values. “Tab” is selected by default, so just click “OK”. Your table will be converted into a tabbed format, nicely and evenly spaced.

You may choose the option Tabs and here you go. Your table will get converted to text.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Convert text to table</td>
</tr>
<tr>
<td>2.</td>
<td>Convert table to text</td>
</tr>
</tbody>
</table>
Additional Practice Exercises:
Create a notice from the Headmistress informing all your class mates about the details of the school picnic planned for the next weekend. The notice should inform the date, departure and return time, place of departure, fees to be paid, place to be visited, a picture of the place. The notice can also have a few instructions for the students. For example, students who are not attending the picnic to stay back at home / students attending to wear I-Cards etc. You must use the following features of word processing, while creating the notice:

- Table
- Bold and underline
- Check the Spellings and Grammar
- Save the document

Now convert the table into text.

SESSION 17: ADD BORDERS TO PAGES, PARAGRAPHS AND TEXT

Relevant Knowledge
A border around text highlights the information and makes it look better. Word processors enable you to do that neatly for the entire document or part of it.

Part-1: Add borders to a Page
Follow the steps given below to add a border to the complete page:

- Open a new document.
- In the Borders and Shading dialog box, do one of the following:
  - To add a paragraph or text border, click the Borders tab.
  - To add a page border, click the Page Border tab. This tab has three sections.
- In the left most section, Under Setting, select the type of border you want.
- In the center section, you can modify the line style, border color, and width. You can even click Art to add a design to a page border.
Check *Preview* to see how the border will look. Click the buttons to add or remove borders along the sides, top, and bottom.

- Select the down arrow of *Apply to*, and select the parts of the document that you want the border to enclose, such as Text, Paragraph, or Section. Then, click OK.

### 2. Add borders to a paragraph or a text

Type the following paragraph in a document.

**ASSERTIVENESS is not the same as aggressiveness. Rather, it is the ability to clearly state what one expects so that there will be no misunderstandings. A leader must be assertive to get the desired results. Along with assertiveness comes the responsibility to clearly understand what followers expect from their leader.**

*Many leaders have difficulty striking the right amount of assertiveness, according to a study in the February 2007 issue of the Journal of Personality and Social Psychology, published by the APA (American Psychological Association). It seems that being under assertive or overassertive may be the most common weakness among aspiring leaders.*
Information Technology – Class IX

- Now select the text which you have typed.
- Follow exactly the same steps as specified for bordering a page, with only one difference. Choose the tab Borders in the Borders and Shading dialogue box.

**ASSERTIVENESS** is not the same as aggressiveness. Rather, it is the ability to clearly state what one expects so that there will be no misunderstandings. A leader must be assertive to get the desired results. Along with assertiveness comes the responsibility to clearly understand what followers expect from their leader.

Many leaders have difficulty striking the right amount of assertiveness, according to a study in the February 2007 issue of the Journal of Personality and Social Psychology, published by the APA (American Psychological Association). It seems that being under assertive or overassertive may be the most common weakness among aspiring leaders.

You can similarly create a border around a group of words, by selecting that group of words, and following the same steps as given above. An example is given below.

*A sense of humor is vital to relieve tension and boredom, as well as to defuse hostility. Effective leaders know how to use humor to energize followers. Humor is a form of power that provides some control over the work environment. And simply put, humor fosters good camaraderie.*

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Add borders to a page</td>
</tr>
<tr>
<td>2.</td>
<td>Add borders to a paragraph or text</td>
</tr>
</tbody>
</table>

**SESSION 18: ADD SHADINGS TO PAGES, PARAGRAPHS AND TEXT**

**Relevant Knowledge**

Similar to borders, shading highlights desired parts of the text. The steps to apply shading are almost the same as that for applying borders as given in figure 30.
• On the Page Layout tab in the Page Background group, click Page Borders. A Borders and Shading dialog box appears.

• Click on the tab Shading as shown in Figure 30.

![Borders and Shading dialog box](image)

**Fig. 30: Shading dialogue box**

There are three options in this box.

- **Fill:** By clicking on the down arrow on the Fill option, a colour palette is displayed. You can choose, which colour shading is to be used.
- **Style:** This option allows the changes in darkness of the shading and also different patterns of shading.
- **Apply to:** By clicking on the down arrow on this option, you can choose if you want to shade only the selected text or the entire paragraph.

Two sample shadings are shown below as examples.

**ASSERTIVENESS is not the same as aggressiveness. Rather, it is the ability to clearly state what one expects so that there will be no misunderstandings. A leader must be assertive to get the desired results. Along with assertiveness comes the responsibility to clearly understand what followers expect from their leader.**
**ASSERTIVENESS** is not the same as aggressiveness. Rather, it is the ability to clearly state what one expects so that there will be no misunderstandings. A leader must be assertive to get the desired results. Along with assertiveness comes the responsibility to clearly understand what followers expect from their leader.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Apply a shade to a paragraph</td>
</tr>
</tbody>
</table>

**SESSION 19: PREVIEW A DOCUMENT, ADJUST ITS MARGINS AND ORIENTATION**

**Relevant Knowledge**

After the document is typed and formatted, the last step is to adjust it so that it prints in the desired manner on paper.

**1. Margins**

Page margins are the blank space around the edges of the page. You can position some items in the margins such as headers, footers page numbers etc. A document has top, bottom, left and right margins. In a document there are default settings of the margins. You can change the margins in a document.

Typical process to adjust / change margins is as follows:

1. Select the *Page layout* tab, as shown in Figure 31.

   ![Fig. 31: Page Layout tab](image)

2. Click on *Margins* in the *Page Setup* group. A *Margins* drop down list appears.
3. You can select any one of the options shown, Narrow, Moderate, Wide or Mirrored. In case you want to customise and specify each of these margins, then click on the Customised Margins... option. A Page Setup dialogue box appears. You can individually adjust any of the margins.

Open a saved document (from one of your previous exercises), change the margins in it and see how the display changes on the screen. You can also do a Print Preview of the document, to see how it would be printed. Print Preview will be explained later in this exercise.

2. Orientation

Normally, when you open document will be in “Portrait Orientation.” Portrait means that the page is taller than it is wider. Portrait works for most documents, but sometimes you might want to put that page on its side or landscape, which is when the page is wider than it is taller.
To change the page orientation, click on the Page Layout tab on the Ribbon, and then click on the Orientation button. This will give you your two options, portrait or landscape.

To change to Landscape orientation, click on the Landscape icon.

Observe the effect of changing the orientation to Landscape as compared to Portrait.

3. Print Preview

Print Preview enables you to see what the document will look like when it is printed. You can Print Preview a document by selecting [1] File → [2] Print → [3] Print Preview. A Print Preview tab opens. Based on how you want the final printout to look, you can adjust the Margins, Orientation etc. A sample Print Preview of a page (Figure 35).

Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Set margins for a printable document</td>
</tr>
<tr>
<td>2.</td>
<td>Change the page orientation to portrait or landscape</td>
</tr>
<tr>
<td>3.</td>
<td>Preview a document before printing</td>
</tr>
</tbody>
</table>
SESSION 20: ALIGN TEXT USING TABS

Relevant Knowledge

Tabs are often used to format documents. To understand the concept of tabs, look at the text below.

<table>
<thead>
<tr>
<th>Left Aligned</th>
<th>Centre Aligned</th>
<th>Right Aligned</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sanjay Kapoor</td>
<td>Male</td>
<td>Blue</td>
</tr>
<tr>
<td>Senhlata Prem Kumari</td>
<td>Female</td>
<td>Red</td>
</tr>
<tr>
<td>Mehuil Mandke</td>
<td>Male</td>
<td>Violet</td>
</tr>
<tr>
<td>P R Subramanian</td>
<td>Male</td>
<td>Orange</td>
</tr>
</tbody>
</table>

A Left Tab stop sets the start position of text that will then run to the right as you type.

A Centre Tab Stop sets the position of the middle of the text. The text centers on this position as you type.

A Right Tab Stop sets the right end of the text. As you type the text moves left.

You can observe this by seeing how the tabs were set in the above table, by looking at the type of tab and its position on the ruler bar.

Note: If you do not see the horizontal ruler that runs along the top of the document, click the View Ruler button at the top of the vertical scroll bar.

Fig. 36: Type of tabs and their position
Information Technology – Class IX

To set Tabs, do the following:

1. Click the tab selector at the left end of the ruler until it displays the type of tab that you want and then clicking the ruler at the location you want. The tab selector is shown in Figure 37.

![Fig. 37: Tab Selector](image)

Use the tabs to create the text which was displayed above in this exercise.

Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Set left tab stop in a document</td>
</tr>
<tr>
<td>2.</td>
<td>Set centre tab stop in a document</td>
</tr>
<tr>
<td>3.</td>
<td>Set right tab stop in a document</td>
</tr>
</tbody>
</table>

Additional Practice Exercises:

Write a letter – to a shop manager – asking for a job. You must use the following features of a word processor to write the letter:

- Bold and Underline some parts of the text.
- Bullets
- Change the margins
- Save the document
- Take a Print out.

Create your resume (Bio data). It should have your name, address, email address, date of birth, nationality, languages known, where currently employed, employment history if any, educational qualifications, extracurricular activities you have participated in, awards won etc.
UNIT 5

Spreadsheet
SESSION 1: INTRODUCTION TO SPREADSHEETS

Have you seen your father or mother keep track of family expenditure in a diary? How do they keep track of the expenditure? Have you noticed how they calculate the total, categorise similar types of items, prioritize expenses and also track the changes in expenses from month to month. *A spreadsheet is an electronic document, very much like the way your parents maintain an expense sheet in a diary.*

**Relevant Knowledge**

The term *spreadsheet* was derived from a large piece of paper that accountants used for business finances. The accountant would *spread* information like costs, payments, taxes, income etc., out on a single, big, oversized *sheet* of paper to get a complete financial overview.

A spreadsheet provides much more flexibility, speed and accuracy, as compared to a manual expense sheet. It also has many features and functions built into it making it easy to use. For example, if you change one amount, the total is recalculated automatically. Spreadsheets are used for a variety of tasks, such as

- Maintaining records
- Analysing data
- Creating MIS (Management Information System) reports
- Generating graphs (for pictorial representation of data)
- Doing financial calculations
- Managing inventory
- Budgeting etc.

Some of the most popular spreadsheet software are:

- MS-Excel
- Open Office – Calc
- Google Documents

**Getting started with Spreadsheet:**

To start you can choose any of the above software to start creating a Spreadsheet. You may start learning to use Spreadsheet with either the Openoffice – Calc or Microsoft-
Excel. Make sure that this software is already installed in your computer. You can start using MS-Excel software, by performing any one of the following steps:

a) Double Click on a shortcut key of the MS-Excel icon, if available, on the desktop

OR

b) Click Start → All Programs → Microsoft office → Microsoft Office Excel

If you are using any other spreadsheet software, the steps to start it would be almost identical to what is given above.

Once you start the MS-Excel, the following screen would be displayed. The components of the screen displayed are shown in Figure 1.

![Fig. 1: Components of a MS-Excel Spreadsheet](image)
Some of the key components of a spreadsheet are:

- **Worksheet:** This is a grid of horizontal rows and vertical columns.
- **Workbook:** A workbook contains one or more worksheets.
- **Figure 1** has three worksheets, each named *Sheet1*, *Sheet2* and *Sheet3*. The *Sheet Tab* is pointing to *Sheet2*. The current sheet shown in Figure 1 is *Sheet1*.
- **Row:** A row is a horizontal arrangement of cells. The rows are named by numbers (1, 2, 3, 4,…). In Figure 1 the arrow points to *Row 15*.
- **Columns:** A column is a vertical arrangement of cells. The columns are named by alphabets (A, B, C, … , Y, Z, AA, AB, AC, …., AZ, BA, ….). In figure 1 the arrow points to *Column N*.
- **Cell:** A Cell is where the rows and columns intersect. Worksheet is also called an array of cells. A cell may contain text, number, date or a formula. A cell is the fundamental element of a worksheet. This is where numbers/text are entered. A cell address in a spreadsheet identifies location of the cell. It is a combination of column name and row number of the cell, such as A2 or B16 etc.
  
  Note: When identifying a cell by its address, the column name is always listed first followed by row number.
- **Active Cell:** This is the cell on which the cursor is currently placed. It is outlined by a dark border. Data is always entered in the active cell. In Figure 1 the Active Cell is *H7*.
- **Formula Bar:** This is located below the Ribbon. It displays the contents of the active cell. It can also be used to enter and edit data.
- **Scroll Bar:** These helps to scroll through the content and body of the worksheet. There are two scroll bars – horizontal and vertical.

When an OpenOffice-Calc spreadsheet is opened, it looks like Figure 2 shown below. Notice that the look and feel of MS-Excel and OpenOffice-Cal spreadsheet is quite similar. Also observe differences in the icons on the Ribbons. Most of the spreadsheet software have similar functions and features, with minor differences in the way, the tabs, icons, dialogue boxes and functions are arranged. If you learn to use one, it is fairly easy to use any other similar software.
Session 2: Open, Save and Close Spreadsheet

Let us start with understanding how to create a spreadsheet and save it for later use. To begin with, let us create a simple spreadsheet. Before creating the spreadsheet, create a folder “D:\IT Class IX\WP_Practice” where you shall store all the spreadsheets that you create.

Relevant Knowledge

a) **Open**: Start the spreadsheet as learnt in the previous exercise. When you create a spreadsheet, a default name is given by the software. MS-Excel names it *Book1*, whereas OpenOffice names it as *Untitled1*. 

### Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Identify the key components of spreadsheet</td>
</tr>
<tr>
<td>2.</td>
<td>Open a spreadsheet</td>
</tr>
</tbody>
</table>

Fig. 2: Components of an OpenOffice-Calc Spreadsheet
Information Technology – Class IX

a. When a new spreadsheet is opened in MS-Excel, the sheet tab usually has three worksheets – Sheet1, Sheet2 and Sheet3.

b) Enter the data shown in Figure -3in the spreadsheet.

a. To go to cell B2, move cursor to the cell and then left click the mouse. Now type the word Hello World and press enter key. You would notice that after pressing enter, automatically cell B3 becomes the active cell.

b. You can move to cell B4 by using down arrow key of keyboard and type 423 and press enter.


Fig. 3: Entering Data

c) Save this workbook and give it the name First. To do so, the steps are the same as the ones you used for saving a document file in a MS-Word. To quickly review the steps again:

• In the Quick Access bar, click the symbol for the floppy

OR

2. A Save As dialog box appears.

3. Choose the Directory (Drive and Folder) by clicking on the one that you want in the list shown on the left hand side. You will see the path on the D:\IT Class IX\WP_Practice displayed as you select the path.

4. Enter the name which you would like to give to this document in the File name box. For example, you can give the name First to this file.

5. Click Save.
   a. This workbook will be saved in MS-Excel with the name First.xlsx. The first part is the name given to this file and .xlsx is the extension name for any worksheet created under MS-Excel.
   b. Similarly if you are using OpenOffice, the file will get saved with the name First.ods. OpenOffice gives an extension name of .ods to a spreadsheet file.

d) Close: Now you can close this spreadsheet by following one of the sets of commands given below:
   a. Click on the cross symbol “X”, that you see on the top right hand corner of the screen.

   OR


e) Open: Now re-open the above spreadsheet; make some more changes to it. Write the names of your classmates in rows B7 to B12, and save it with a different name.

f) Save: Having made further changes, you need to save the changes. You can save it with the same name First.xlsx, in which case the older file saved earlier will get overwritten by the changes which you made. Alternatively, you may like to keep the earlier file First.xlsx as it is, and save this modified spreadsheet using a new file name, e.g. Second.xlsx. To save it with the same name, just follow the steps explained earlier. To save it with a different name, use the following steps:

   b. A Save As dialog box appears. Choose the Directory (Drive and Folder) by clicking on the one that you want in the list shown on the left hand side. You will see the path on the D:\IT Class IX\WP_Practice displayed as you select the path.
c. Enter the file name which you would like to give to this document. For example, you may give the name Second to this file.
d. Click Save

Now this spreadsheet would be saved in MS-Excel with the name Second.xlsx.

g) Close: You can close this document by following one of the sets of commands given below:
   • Click on the symbol of cross “X”, which you see on the top right hand corner of the screen
   OR

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open a spreadsheet</td>
</tr>
<tr>
<td>2</td>
<td>Save a spreadsheet with an appropriate name</td>
</tr>
<tr>
<td>3</td>
<td>Close a spreadsheet</td>
</tr>
</tbody>
</table>

To practice concepts learnt, repeat the above steps by opening a new spreadsheet, write the names of 10 of your classmates with their roll numbers and save the sheet.

**SESSION 3: ENTER DATA IN SPREADSHEET**

Spreadsheets enable us to work with different kinds of data for organizing, calculating and presenting information. We will start by entering data in a spreadsheet.

**Relevant Knowledge**

Open a new spreadsheet and enter the data as shown in Figure.
Observe three different kinds of data you have entered in the above spreadsheet. These are:

- **Text**: The names of the students are treated as *Text* type of data.
- **Number**: The roll numbers are treated as *Number* type of data.
- **Date**: The date of birth is treated as *Date* type of data (notice the entry in the formula bar when a cell with a date entry is active).

There is another kind of data which you can enter, which is called *Formula*. You will learn about this a little later. You can also observe that *text* data is automatically aligned to the left in a cell, the *Number* data is aligned to right and the *Date* data is also right aligned.

Note: You can do calculations using a *Number*, *Date* and *Formula* type of data, but you cannot do calculations using *Text* data (also referred as alpha numeric data).

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Make a list of five of your friends with their name, phone number and date of birth.</td>
</tr>
<tr>
<td>2</td>
<td>Save the spreadsheet with an appropriate name</td>
</tr>
<tr>
<td>3</td>
<td>Close the spreadsheet</td>
</tr>
</tbody>
</table>
Additional Practice Exercises

1. Open the workbook. Click on the tab Sheet2. You would see that a blank worksheet appears on the screen. If you click again on tab for Sheet1, the data you had entered earlier would appear. Why? Because these are separate sheets in the same workbook; just like pages on your notebook.

SESSION 4: BASIC CALCULATIONS – ADDITION

A spreadsheet helps you do many mathematical calculations – e.g. addition.

Relevant Knowledge

Open a new spreadsheet and enter the data as shown in Figure 4.

![Fig. 4: Adding Marks](image)

Now to total the marks of each of the students, do the following:

- Go to cell G3. In the cell G3 enter: +c3+d3+e3+f3 and press Enter. The total marks of Abhas appear in cell G3.
  - In a similar way, we calculate the total marks of Anita.
- In cell G5 enter: =sum(C5..F5) and then press Enter.
  - This is another way of entering a formula for addition, when the cells to be added are adjacent to each other. C5 is the address of the starting cell and F5 is the address of the last cell. C5..F5 is also called a Range of cells.
  - In a similar way, calculate the total marks of Subbu, Priya and Gautam.
- You have totaled the marks by entering formula in two different ways. The cell does not display the formula, but it displays result of the calculation i.e. the
total marks in the above example. When G7 is made the active cell, you will see formula displayed in *formula bar* (just below the Ribbon).

Now change marks of one of the students in one or more subjects. The total marks of that student will get calculated automatically. *Automatic calculation* of formulas is one of the most powerful features of electronic spreadsheets.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a list of all your personal expenses made during the month and calculate the total expenses</td>
</tr>
<tr>
<td>2</td>
<td>Create a list of names of the month and holidays in that month. Add and calculate the total number of holidays in a year.</td>
</tr>
</tbody>
</table>

**Additional Practice Exercise**

Design a mark sheet for a student as shown in figure below:
Information Technology – Class IX

a) Calculate percentage of marks in each subject.
b) Calculate total marks and total percentage.
c) Depending on the total percentage write the following in remarks
   • Excellent – 90% or more
   • Very Good – 80%-less than 90%,
   • Good – 70%- less than 80%,
   • Fair – 60%-less than 70%,
   • Poor – less than 60%
d) Use cell style to show colored cells
e) Use thick outline border
   Use Font size, color and alignment for the text.

SESSION 5: BASIC CALCULATIONS – SUBTRACTION

Relevant Knowledge

Another math operation that can be done using the spreadsheet is subtraction.

Open new spreadsheet and enter data as shown in Figure 6.

![Fig. 5: Adding Marks](image-url)
Now to calculate savings in each month:

- Go to cell E3. Enter: \( +C3-D3 \text{<Enter>} \). Note that as you are entering the formulae in the cell E3, the cells C3 and D3 automatically get highlighted. The savings for January will be displayed in cell E3. Now calculate savings for February.

You would observe that you have been entering formula one by one in each cell. In a spreadsheet, you can copy a formula entered in one cell to many other cells, where you need to do exactly the same calculation. This feature of a spreadsheet is called *copying formula*. To do so:

- Go to cell E3.
- While in the *Home Tab*, click on the icon for *Copy*.
- Go to cell E5 and click on the icon for *Paste*.
- The formula gets automatically pasted in the cell E5. You can also observe in the *Formula Bar* that the address of the cells referred to in the formula automatically changes when *Copy – Paste* function is used.
Now *Copy* the formula in other cells for calculating savings for April, May and June.

There is an alternate and easier way to paste formula: *Copy – Click and Drag – Paste*. The method of *Copy-Paste* formula which you just learnt can become very time consuming, if the same formula has to be pasted in large number of cells, say one hundred cells. Spreadsheet has a faster way of *Pasting* the formula that you have copied.

In the same worksheet add six more records for the months July to December. Enter data for Income and Expense. The spreadsheet will look like Figure 8.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Month</td>
<td>Income</td>
<td>Expense</td>
<td>Saving</td>
</tr>
<tr>
<td>3</td>
<td>January</td>
<td>10,000</td>
<td>8,500</td>
<td>1,500</td>
</tr>
<tr>
<td>4</td>
<td>February</td>
<td>12,600</td>
<td>9,100</td>
<td>3,500</td>
</tr>
<tr>
<td>5</td>
<td>March</td>
<td>7,900</td>
<td>8,700</td>
<td>-800</td>
</tr>
<tr>
<td>6</td>
<td>April</td>
<td>10,600</td>
<td>10,000</td>
<td>600</td>
</tr>
<tr>
<td>7</td>
<td>May</td>
<td>11,250</td>
<td>8,523</td>
<td>2,727</td>
</tr>
<tr>
<td>8</td>
<td>June</td>
<td>12,900</td>
<td>14,200</td>
<td>-1,300</td>
</tr>
<tr>
<td>9</td>
<td>July</td>
<td>12,500</td>
<td>10,200</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>August</td>
<td>13,000</td>
<td>11,500</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>September</td>
<td>14,000</td>
<td>12,100</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>October</td>
<td>11,200</td>
<td>12,500</td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>November</td>
<td>11,100</td>
<td>11,300</td>
<td></td>
</tr>
<tr>
<td>14</td>
<td>December</td>
<td>11,900</td>
<td>11,400</td>
<td></td>
</tr>
</tbody>
</table>

*Fig. 8: Subtraction*

- Do the following steps:
  - Take cursor to cell E8. *Copy* formula, as you did earlier. You will see that the box around cell E8 starts blinking.
  - Observe that the blinking box in cell E8 has a small dark rectangle in the bottom right hand corner.
  - Take the cursor over this rectangle. The cursor will take the shape of +. Now click the left button of your mouse and drag the cursor with your mouse,
while keeping the left button pressed, and *drag* the cursor up to cell E14. Now release the left button. You will see that the formula has been automatically pasted to the entire range specified.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the above worksheet calculate the total savings across the twelve months and display the result in cell E15.</td>
</tr>
</tbody>
</table>

**SESSION 6: BASIC CALCULATIONS – MULTIPLICATION**

**Relevant Knowledge**

Another math function that is frequently used is multiplication and in this exercise you will learn to multiply in a spreadsheet. Create the spreadsheet shown in Figure.
You will need to use the *Multiplication* function here. It is used in the same way as addition and subtraction.

- The formula for calculating amount is: Unit Price \* No. of Units Sold
- To calculate the amount in cell G3, enter: 
  \[ +E3*F3 <Enter> \]
- Use the Copy – Paste command to enter formula in all the other cells.
- Calculate the Total Sale Value in cell G14.
- Cells B14 to F14 have been merged and the contents centered.
- Note that Unit price and Amount has values displayed up to 2 decimal places.

Hint: You can do this by using the *Increase Decimal and Decrease Decimal* under the *Home* tab, in the Number group. You can see them in Figure 10.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Change any of the numbers in the above spreadsheet and see how the amounts change automatically</td>
</tr>
</tbody>
</table>

**SESSION 7: BASIC CALCULATIONS – DIVISION**

**Relevant Knowledge**

Another basic mathematical function is Division. In this exercise you will learn how to divide using spreadsheets. Open the spreadsheet created as *marks.xlsx* and calculate...
the percentage of marks obtained by each student. The final spreadsheet should look as shown in Figure 12.

<table>
<thead>
<tr>
<th>S.No</th>
<th>Name</th>
<th>English</th>
<th>Hindi</th>
<th>Maths</th>
<th>Science</th>
<th>Total</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Abhas</td>
<td>89</td>
<td>76</td>
<td>93</td>
<td>91</td>
<td>349</td>
</tr>
<tr>
<td>2</td>
<td>Anita</td>
<td>92</td>
<td>82</td>
<td>98</td>
<td>91</td>
<td>363</td>
</tr>
<tr>
<td>3</td>
<td>Raja</td>
<td>95</td>
<td>81</td>
<td>76</td>
<td>82</td>
<td>334</td>
</tr>
<tr>
<td>4</td>
<td>Subbu</td>
<td>84</td>
<td>72</td>
<td>99</td>
<td>94</td>
<td>343</td>
</tr>
<tr>
<td>5</td>
<td>Priya</td>
<td>94</td>
<td>93</td>
<td>100</td>
<td>97</td>
<td>384</td>
</tr>
<tr>
<td>6</td>
<td>Gautam</td>
<td>78</td>
<td>89</td>
<td>69</td>
<td>72</td>
<td>308</td>
</tr>
</tbody>
</table>

Fig. 11: Adding Marks

Fig. 12: Division

- You will need to use the Division function here. It is used in the same way as addition, subtraction and multiplication.
- The formula for calculating %age of marks is: (Total Marks) / (4 * 100)
- To apply the %age symbol, use the % button under the Home tab, in the Number group, as shown in Figure 13.
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Change any of the numbers in the above spreadsheet and see how the marks change automatically</td>
</tr>
</tbody>
</table>

SESSION 8: INSERT COLUMN AND ROW

Relevant Knowledge

Using a spreadsheet, you can modify a worksheet or report created earlier. While working on a spreadsheet you may realize that you need to insert some information between two columns. Now do you re-create the sheet all over again? In this exercise, you will use the same stock register saved as StockRegister.xlsx and learn the solution to such a problem. You will add a column which has the Unit Value of each item, after column C.

a) Inserting a Column: You will add a column which has the Unit Value of each item, after column C in Figure 25.

- Position the cursor near the Column D, as shown in Figure 14, the cursor changes into an arrow shape. Click the left button of your mouse. The entire column gets selected.

![Fig. 14: Insert Column](image)
Click the Right Button of your mouse. A menu box appears. Select the **Insert** option (Figure 15).

A blank column is inserted in this place. There is a ripple movement of data, i.e. the contents of Column D move rightwards into Column E and so on.

This is called *inserting a column*.

You can now enter data in this column and update the worksheet. Note: The cell addresses in formulas have changed automatically.

---

**b) Inserting a Row:** Similarly a row can be inserted in a spreadsheet. Position the cursor on the Row number on the left hand side, where you want to insert a row. The whole row gets highlighted. Right click and insert a row!

Add one more item in this spreadsheet by adding a row at row number 8.
The spreadsheet will now look like the figure given below:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Item Code</th>
<th>Item Name</th>
<th>Opening Balance</th>
<th>Receipts</th>
<th>Sold</th>
<th>Closing Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>A001</td>
<td>Pencils - HB</td>
<td>800</td>
<td>200</td>
<td>700</td>
<td>300</td>
</tr>
<tr>
<td>3</td>
<td>A002</td>
<td>Pencils - 1H</td>
<td>102</td>
<td>175</td>
<td>100</td>
<td>177</td>
</tr>
<tr>
<td>4</td>
<td>A003</td>
<td>Copy - English</td>
<td>176</td>
<td>0</td>
<td>105</td>
<td>71</td>
</tr>
<tr>
<td>5</td>
<td>A004</td>
<td>Copy - Maths</td>
<td>213</td>
<td>0</td>
<td>176</td>
<td>37</td>
</tr>
<tr>
<td>6</td>
<td>A005</td>
<td>Registers</td>
<td>112</td>
<td>50</td>
<td>128</td>
<td>34</td>
</tr>
<tr>
<td>7</td>
<td>A006</td>
<td>Geometry Box</td>
<td>35</td>
<td>32</td>
<td>10</td>
<td>57</td>
</tr>
<tr>
<td>8</td>
<td>A007</td>
<td>Set of 6 sketch pens</td>
<td>75</td>
<td>52</td>
<td>0</td>
<td>127</td>
</tr>
<tr>
<td>9</td>
<td>A008</td>
<td>Fountain Pens</td>
<td>79</td>
<td>36</td>
<td>0</td>
<td>115</td>
</tr>
<tr>
<td>10</td>
<td>A009</td>
<td>Ball point pens</td>
<td>231</td>
<td>176</td>
<td>100</td>
<td>309</td>
</tr>
<tr>
<td>11</td>
<td>A010</td>
<td>Staplers</td>
<td>12</td>
<td>9</td>
<td>5</td>
<td>16</td>
</tr>
</tbody>
</table>

Fig. 16: Insert a Row

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Practice by inserting more rows and columns in the spreadsheet above</td>
</tr>
</tbody>
</table>

**SESSION 9: FORMAT CELL AND ITS CONTENTS**

**Relevant Knowledge**

Just as in a list that you create on paper or a report you may read, the information in a spreadsheet can be made more readable by formatting (bolding, shading, etc.) a cell and its contents.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>1</td>
<td>Abhas</td>
<td>89</td>
<td>76</td>
<td>93</td>
<td>91</td>
<td>349</td>
</tr>
<tr>
<td>4</td>
<td>2</td>
<td>Anita</td>
<td>92</td>
<td>82</td>
<td>98</td>
<td>91</td>
<td>363</td>
</tr>
<tr>
<td>5</td>
<td>3</td>
<td>Raja</td>
<td>95</td>
<td>81</td>
<td>76</td>
<td>82</td>
<td>334</td>
</tr>
<tr>
<td>6</td>
<td>4</td>
<td>Subbu</td>
<td>84</td>
<td>72</td>
<td>99</td>
<td>94</td>
<td>349</td>
</tr>
<tr>
<td>7</td>
<td>5</td>
<td>Priya</td>
<td>94</td>
<td>93</td>
<td>100</td>
<td>97</td>
<td>384</td>
</tr>
<tr>
<td>8</td>
<td>6</td>
<td>Gautam</td>
<td>78</td>
<td>89</td>
<td>69</td>
<td>72</td>
<td>308</td>
</tr>
</tbody>
</table>

Fig. 20: Adding Marks
Open a new spreadsheet. Create the spreadsheet as given in Figure 21. It shows a partial list of items in a stationery shop. It shows the opening balance and closing balance for a month.

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Item Code</th>
<th>Item Name</th>
<th>Opening Balance</th>
<th>Closing Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A001</td>
<td>Pencils - HB</td>
<td>800</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>A002</td>
<td>Pencils - 1H</td>
<td>102</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>A003</td>
<td>Copy - English</td>
<td>176</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>A004</td>
<td>Copy - Maths</td>
<td>213</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>A005</td>
<td>Registers</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>A006</td>
<td>Geometry Box</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>A007</td>
<td>Set of 6 sketch pens</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>A008</td>
<td>Fountain Pen</td>
<td>79</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>A009</td>
<td>Ball point pens</td>
<td>231</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>A010</td>
<td>Staplers</td>
<td>12</td>
<td></td>
</tr>
</tbody>
</table>

Fig. 21: Items in a stationery shop

We will now change the appearance i.e. format the data as shown in Figure 17.

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Item Code</th>
<th>Item Name</th>
<th>Opening Balance</th>
<th>Closing Balance</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A001</td>
<td>Pencils - HB</td>
<td>800</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>A002</td>
<td>Pencils - 1H</td>
<td>102</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>A003</td>
<td>Copy - English</td>
<td>176</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>A004</td>
<td>Copy - Maths</td>
<td>213</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>A005</td>
<td>Registers</td>
<td>112</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>A006</td>
<td>Geometry Box</td>
<td>35</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>A007</td>
<td>Set of 6 sketch pens</td>
<td>75</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>A008</td>
<td>Fountain Pens</td>
<td>79</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>A009</td>
<td>Ball point pens</td>
<td>231</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>A010</td>
<td>Staplers</td>
<td>12</td>
<td></td>
</tr>
</tbody>
</table>

Fig. 17: Formatted Spreadsheet

Notice that the above sheet has some additional effects to format it. What are adjustments and settings which have been done in the formatted spreadsheet? These are:
Information Technology – Class IX

a) **Wrap Text:** The text in row number 1 in Figure does not completely fit in the cell, as the cell width is smaller than the length of the text.

- Go to cell A1 and press the left button of the mouse and drag the mouse till cell E1 and release the left button. You will see that the cells A1 to E1 have been selected.

Note: When a cell entry overlaps into adjacent cells and there is no entry there, the contents are visible. However, the moment and entry is made in the adjacent cell, the text gets truncated, i.e. It is there on the sheet but not visible. An alternate is to automatically make text appear on multiple lines in a cell. This means that you can format the cell so that the text wraps automatically using the *Wrap Text* function.

- Click on *Home* tab, and then *Wrap Text* in the *Alignment group* as shown in Figure -1822.

![Fig. 18: Alignment Group](image)

b) **Change Font:**

You have learnt to use *Bold*, *italics* and *Underline* in a word processor. The same functions are found in a spreadsheet too. The text in row number is *Bold*.

- Go to cell A1 and press the left button of the mouse and drag the mouse till cell E1 and release the left button. You will see that the cells A1 to E1 have been selected.

![Figure 19: Font Group](image)
• Now press the icon B under the *Home* tab.
• The contents of the selected cells will change to **Bold** font.
  Similarly you can change the contents of any cell or a group of cells by selecting them and using the appropriate icon, B, I or U.

c) **Change Column Width**: The text in column number C in Figure does not fit into the width of the column. The width of the column C can be increase to ensure that the entire text entered is visible.
• Take the cursor to the column numbers on top. Position it on the line between Column C and D, (refer adjacent figure). The shape of the cursor changes to a +symbol.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td>S.No.</td>
<td>Item Code</td>
<td>Item Name</td>
<td>Opening Balance</td>
<td>Closing Balance</td>
</tr>
<tr>
<td>2</td>
<td></td>
<td>2</td>
<td>A001</td>
<td>Pencils - HB</td>
<td>800</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td>3</td>
<td>A002</td>
<td>Pencils - 1H</td>
<td>900</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
<td>4</td>
<td>A003</td>
<td>Copy - English</td>
<td>176</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
<td>4</td>
<td>A004</td>
<td>Copy - Maths</td>
<td>213</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td></td>
<td>5</td>
<td>A005</td>
<td>Registers</td>
<td>112</td>
<td></td>
</tr>
</tbody>
</table>

Fig. 20: Change Column width
• Click the left button of the mouse and with the left button pressed, drag the + symbol to the right. You will notice that the width of the column starts increasing. Once you have the desired width, release the left button of the mouse.

b) **Cell Content Alignment**: The numbers in Cells A2 to A11 are right aligned in that they are center aligned. To achieve this effect, do the following:
• Go to cell A2. Press the left button of the mouse, keeping it pressed, drag the mouse till cell A11 and then release the left button. You will see that the cells A2 to A11 have been selected.
• Under the *Home* tab, in the Alignment group, click the symbol for *Center alignment* as shown in Figure 21.
To align position of the contents of a cell, you need to select that cell or the group of cells and then click on the appropriate symbol for Left, Center or Right alignment of text.

b) **Create a Border:** The data in Figure 27 has **Borders** around each cell. To achieve this effect, do the following:

- **Select** cells A1 to E11. Under the **Home** tab, in the Font group, click on **down arrow** next to the icon for borders, as shown by the arrow in Figure 22. A list of types of borders appears.
- From this list select the option for **All Borders**. You will observe that each of selected cells get a border.
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open a new spreadsheet. Create the spreadsheet given in Figure 28</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
<th>I</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>1</td>
<td>Abhas Kumar</td>
<td>89</td>
<td>76</td>
<td>93</td>
<td>91</td>
<td>349</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>2</td>
<td>Anita Goel</td>
<td>92</td>
<td>82</td>
<td>98</td>
<td>91</td>
<td>363</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>3</td>
<td>Rajshekhar Reddy</td>
<td>95</td>
<td>81</td>
<td>76</td>
<td>82</td>
<td>334</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>4</td>
<td>Kailash Sankar Iyer</td>
<td>84</td>
<td>72</td>
<td>99</td>
<td>94</td>
<td>349</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>5</td>
<td>Bijender Dalal</td>
<td>94</td>
<td>93</td>
<td>100</td>
<td>97</td>
<td>384</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>6</td>
<td>Geentanjali Sharma</td>
<td>78</td>
<td>89</td>
<td>69</td>
<td>72</td>
<td>308</td>
<td></td>
</tr>
</tbody>
</table>

Figure 23: Formatted Cells

- Note the following:
  - Marks are displayed center aligned.
  - Total marks are in Bold Font
  - Names of the students are in italics.
  - Contents in row 2 are in Bold and Italics. They are also center aligned.
  - Cells B1 to H2 have been merged and center aligned.

Hint: For merging the cells and center aligning the contents of the merged cell, use Merge & Center shown in Figure 24.

Figure 24: Merge & Center cells

- Save the spreadsheet with the name *Marks*. 
SESSION 10: STOCK REGISTER

Relevant Knowledge

A common usage of a spreadsheet is to maintain lists of items along with quantities. A stock register is a good example of the same. You will create a simple stock register, which is used to keep track of number of units of different items kept in a shop or a store. Create the sample shown in Figure 30.

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
<th>F</th>
<th>G</th>
<th>H</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
<td></td>
<td>S.No.</td>
<td>Item Code</td>
<td>Item Name</td>
<td>Opening Balance</td>
<td>Receipts</td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>A001</td>
<td>Pencils - HB</td>
<td>800</td>
<td>200</td>
<td>700</td>
<td>300</td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>A002</td>
<td>Pencils - 1H</td>
<td>102</td>
<td>175</td>
<td>100</td>
<td>177</td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>A003</td>
<td>Copy - English</td>
<td>176</td>
<td>0</td>
<td>105</td>
<td>71</td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>A004</td>
<td>Copy - Maths</td>
<td>213</td>
<td>0</td>
<td>176</td>
<td>37</td>
</tr>
<tr>
<td>6</td>
<td>5</td>
<td>A005</td>
<td>Registers</td>
<td>112</td>
<td>50</td>
<td>128</td>
<td>34</td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>A006</td>
<td>Geometry Box</td>
<td>35</td>
<td>32</td>
<td>10</td>
<td>57</td>
</tr>
<tr>
<td>8</td>
<td>7</td>
<td>A007</td>
<td>Set of 6 sketch pens</td>
<td>75</td>
<td>52</td>
<td>0</td>
<td>127</td>
</tr>
<tr>
<td>9</td>
<td>8</td>
<td>A008</td>
<td>Fountain Pens</td>
<td>79</td>
<td>36</td>
<td>0</td>
<td>115</td>
</tr>
<tr>
<td>10</td>
<td>9</td>
<td>A009</td>
<td>Ball point pens</td>
<td>231</td>
<td>178</td>
<td>100</td>
<td>309</td>
</tr>
<tr>
<td>11</td>
<td>10</td>
<td>A010</td>
<td>Staplers</td>
<td>12</td>
<td>9</td>
<td>5</td>
<td>16</td>
</tr>
</tbody>
</table>

Figure 25: Stock Register

- The formula for closing balance is: Opening Balance + Receipts - Sold
  - Enter the formula in cell G2, using a combination of *Addition* and *Subtraction*.
  - Use *Copy – Paste* to paste the formulas in all the cells. Format the cells as shown in the sample.
  - Change the name of the sheet to Stock. Save the File as *StockRegister.xlsx*.

Exercise

Perform the following activities till you are confident:
S. No. | Activity
---|---
1 | Prepare a stock register of the grocery items purchased at your home. Create the spreadsheet as given below:

<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Item</td>
<td>Quantity</td>
</tr>
<tr>
<td>2</td>
<td>Student Chairs</td>
<td>123</td>
</tr>
<tr>
<td>3</td>
<td>Student Tables</td>
<td>93</td>
</tr>
<tr>
<td>4</td>
<td>Stools</td>
<td>196</td>
</tr>
<tr>
<td>5</td>
<td>Teacher Chairs</td>
<td>35</td>
</tr>
<tr>
<td>6</td>
<td>Teacher Tables</td>
<td>45</td>
</tr>
<tr>
<td>7</td>
<td>Computer Tables</td>
<td>211</td>
</tr>
</tbody>
</table>

a) Calculate the total amount for each item (Quantity* Price per unit) and also the total amount for all items.
b) Apply appropriate formatting to currency entries (Rs.) and numbers.
c) Adjust the column widths where needed. Insert blank rows between column labels and data.
d) Use alignments, fonts, borders and colors to format the “Furniture Details” worksheet. For example, put a border around the title, change the color of column headings to red and center all the entries in Column B.
e) Create a header that includes your name and a footer that includes current date. Change page orientation to Landscape.
f) Preview and print the worksheet.

**SESSION 11: CUSTOMIZING THE INTERFACE**

**Relevant Knowledge**

An interface is provided by the software vendor. There is a limited amount of customization possible. In this exercise, you will learn to customize the Quick Access Toolbar at upper-left corner of the screen. The Quick Access Toolbar is shown in Figure 26.
Note: The Ribbon, which is part of the user interface, is designed to help you quickly find the commands that you need to complete a task. Commands are organized in logical groups that are collected together under tabs. Because each tab relates to a type of activity, such as writing or laying out a page, it is not possible to customize the Ribbon without using XML and programming code.

Things you can’t do

- Add to or rearrange the commands on the Ribbon.
- Change or remove a command or group on the Ribbon.
- Add tabs to the Ribbon, unless you use programming code.
- Change the font or font size used on the Ribbon.

Things you can do

- Minimize the Ribbon to make more space available on your screen.
- Move the Quick Access Toolbar to position it below or above the Ribbon.
- Customize the Quick Access Toolbar to add buttons that represent the commands that you frequently use.

On the right side of the Office Button, there is the Quick Access Toolbar, as shown in Figure 32. Like a normal toolbar, the Quick Access displays some buttons. You can right-click the Quick Access toolbar. A menu would appear, as shown in Figure 32. If you want to hide the Quick Access toolbar, you can right-click it and click Remove Quick Access Toolbar. To know what a button is used for, you can position the mouse on it. A tool tip would appear. Once you identify the button you want, you can click it.
Adding a Button to the Quick Access Toolbar

By default, the Quick Access toolbar is equipped with three buttons: Save, Undo, and Redo. If you want to add more buttons or more options, you can right-click the Quick Access toolbar and click Customize Quick Access Toolbar. This would display the Excel Options dialog box shown in Figure 28.
Fig. 28: Adding a Button to Quick Access Toolbar

To add a button to the Quick Access toolbar, on the left list of Add, click an option and click Add. After making the selections, click OK.

To remove a button from the Quick Access toolbar, right-click it on the Quick Access toolbar and click Remove From Quick Access Toolbar.

The Quick Access Button

On the right side of the Quick Access toolbar, there is the Customize button with a down-pointing arrow. If you click or right-click this button, a menu would appear.

The role of this button is to manage some aspects of the top section of Microsoft Excel, such as deciding what buttons to display on the Quick Access toolbar. For example, instead of using the Customize Quick Access Toolbar menu item as you used previously, you can click an option from that menu and its corresponding button would be added to the Quick Access toolbar. If the options on the menu are not enough, you can click either Customize Quick Access Toolbar or More Commands... This would open the Excel Options dialog box.

Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Minimize the Ribbon to make more space available on your screen</td>
</tr>
<tr>
<td>2.</td>
<td>Move the Quick Access Toolbar to position it below or above the Ribbon.</td>
</tr>
<tr>
<td>3.</td>
<td>Customize the Quick Access Toolbar to add buttons that represent the commands that you frequently use</td>
</tr>
</tbody>
</table>

SESSION 12: USE CURRENCY SYMBOLS

Relevant Knowledge

When spreadsheets are used in accounting, we often need to show money and cash balances using currency symbols. Create the spreadsheet shown in Figure 29 Figure 34.
The price given in this sample spreadsheet does not indicate whether it is in Dollars or Rupees or in Euros. If you want to display numbers as amounts, you need to format the numbers as currency. To do this, apply the Currency format to the cells. A currency symbol can be inserted in two ways. These are:

1. Use the Accounting Number Format button

The currency formatting option is available within the Accounting Number Format button under the Home tab, in the Number group.

- Select Cell E1.
- Click on the down arrow next to the Accounting Number Format button (refer Figure 30).
- A list appears showing some of the popular currency symbols. Select Rs. Option.
The amount 40 would be displayed as shown in Figure 315.

Repeat this procedure for other cells containing the price.

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Item Name</th>
<th>Unit</th>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sugar</td>
<td>Kg</td>
<td>Rs. 40.00</td>
</tr>
<tr>
<td>2</td>
<td>Rice</td>
<td>Kg</td>
<td>35</td>
</tr>
<tr>
<td>3</td>
<td>Ghee</td>
<td>Kg</td>
<td>165</td>
</tr>
<tr>
<td>4</td>
<td>Mustard Oil</td>
<td>Litre</td>
<td>60</td>
</tr>
<tr>
<td>5</td>
<td>Butter</td>
<td>100 Gm</td>
<td>24</td>
</tr>
</tbody>
</table>

2. **Use the right click**

- Select the Cell in which currency symbol is to be applied
- Right click the mouse. A short cut menu as shown in Figure 36 appears.
- Click on the option **Format Cells**. A **Format Cells** dialogue box as shown in Figure 32 appears.
- From the **Category** list provided, choose **Currency**.
- Now click on the down arrow on the **Symbol** box. Available currency symbols are displayed. Choose the desired symbol. This symbol will get displayed in the cell.

**Fig. 36: Short cut menu**

**Fig. 32: Dialogue box**
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a spreadsheet with the quantity and price of items purchased at your home</td>
</tr>
</tbody>
</table>

**SESSION 13: FORMAT CELL CONTENTS – FONT STYLE AND SIZE**

**Relevant Knowledge**

We have already learnt to apply some formatting options. In this exercise we will learn some more formatting options.

Create the spreadsheet given in Figure 33.
You can change the font (style of writing), for a cell or a group of cells. You will learn to do it in two ways, in this exercise.

1. **Using the Icons on the Ribbon**
   - On the Home tab, in the Font group, click on the down arrow on the Font box (refer Figure 33). A list with various font options appears as shown in Figure 34.

   ![Figure 34](image)

   - Select **Arial** font. You would observe the font (style) of the text in cell C2 changes (refer Figure 35).

   ![Figure 35: Arial Font in Line-1](image)
Now go ahead and follow the same steps for changing the font style of other cells, to what is written in the text. The spreadsheet will appear as in Figure 36.

<table>
<thead>
<tr>
<th>C</th>
</tr>
</thead>
<tbody>
<tr>
<td>This is Arial font</td>
</tr>
<tr>
<td>This is Times New Roman Font</td>
</tr>
<tr>
<td>This is Bookman Old Style Font</td>
</tr>
<tr>
<td>This is Courier Font</td>
</tr>
<tr>
<td>This is Book Antiqua Font</td>
</tr>
<tr>
<td>THIS IS ALGERIAN FONT</td>
</tr>
</tbody>
</table>

Figure 36: Different Fonts

2. Use Short cut menu and the dialog box

- We will restart with Figure 35
- Position the cursor in cell C2 and right click the mouse button. Short cut menu shown in Figure 37 will appear.

Figure 37: Short Cut Menu
Click on **Format Cells**... A Format Cells dialogue box appears with the Number tab selected by default.

Click on the **Font** tab (refer Figure 38).

Choose the font **Arial**. If needed, use the scroll bar.

Repeat this for changing the font of text in all the other cells.

You have learnt how to change cells. In a similar way it is possible to change **font size** of contents of a cell.

Create the spreadsheet as shown in Figure 40. Then change **font size** of the contents of the individual cells, as shown in Figure 39.
• The steps to do this are similar to what you followed for changing font style
• The only difference is that now you need to use the option of changing font size, instead of the font style

Exercise
Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create any spreadsheet. Now change both the font style and font size of the contents of the individual cells.</td>
</tr>
</tbody>
</table>

SESSION 14: DELETE – COLUMNS AND ROWS

Relevant Knowledge
You had learnt to insert a row and a column in an existing spreadsheet. In a similar way, you can delete any row or column in a spreadsheet.

• Select the row or the column to be deleted.
• Right click the mouse. A short cut menu as shown in Figure 41 appears.
• Choose the option Delete. The selected row or column will be deleted. (Note: The data contained in that row or column will also get deleted.)
1. Select the row / column / cell / cells that you want to delete.
2. On the Home tab, in the Cells group, click on the arrow next to Delete.
3. You will see the options as shown in adjacent figure.

![Delete Cells Menu](image)

**Figure 41: Short Cut Menu**

4. Select *Delete Cells*… to delete selected cells.
5. Select *Delete Sheet Rows* to delete the selected row.
6. Select *Delete Sheet Columns* to delete the selected column.

- Create a spreadsheet as shown in Figure 42.

<table>
<thead>
<tr>
<th></th>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
<th>E</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>S.No.</td>
<td>Name</td>
<td>Roll No.</td>
<td>Date of Birth</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>1</td>
<td>Ravi Kaul</td>
<td>23</td>
<td>13-Aug-99</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>2</td>
<td>Bijender Dalal</td>
<td>13</td>
<td>15-Jan-99</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>3</td>
<td>Radha Swami</td>
<td>7</td>
<td>02-Jan-00</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>4</td>
<td>Vikas Maheshwari</td>
<td>32</td>
<td>17-Nov-98</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>5</td>
<td>Vimla Rani</td>
<td>14</td>
<td>23-Sep-99</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>6</td>
<td>Sandhya Reddy</td>
<td>26</td>
<td>19-Dec-98</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 42**

- Delete the column containing the Roll No.
- Delete the row containing the record of Vikas Maheshwari.
- Once you have done this, the spreadsheet would look like as shown in Figure 43.
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a spreadsheet. Select two adjacent rows together and delete them. Now select two adjacent columns together and delete them.</td>
</tr>
<tr>
<td>2.</td>
<td>Create a spreadsheet. Insert three columns together in this spreadsheet. Now insert four rows together in this spreadsheet.</td>
</tr>
</tbody>
</table>

SESSION 15: SPELL CHECK

Relevant Knowledge

Like a word processor, you can check spelling mistakes in a spreadsheet. Create a spreadsheet as shown in Figure 49. This spreadsheet has some spelling errors. Make sure that the text you enter has the same or more mistakes.

Fig. 44: Spreadsheet with spelling errors
Select the **Review** tab. In the **Review** tab there is an option for **Spelling**, as shown in Figure 50.

![Fig. 50: Review Tab](image)

Click on this option and the spreadsheet software will start checking the spellings. If it finds a spelling mistake, it will show the **Spelling: English** dialogue box, as in Figure 451.

You can accept the suggestion by clicking on the **Change** option.

Or, you can type in the correct spelling in the box on top in this dialogue box.

![Fig. 45: Spelling Dialogue Box](image)

Once you have corrected this mistake, it will continue checking the rest of the worksheet.
SESSION 16: BORDER THE CELLS

Relevant Knowledge

Under the Home tab, there is an option of applying borders to the cells, as shown in Figure 46.

If you click on the down arrow, as shown above, a further list of options for borders appears, as shown in Figure 47.
Information Technology – Class IX

- To apply the borders to a particular cell of a group of cells, first select those cells and then apply the border, using this option.
- Create a spreadsheet as shown in Figure 48.
- Use formulas to calculate quarterly totals and profit.

![Fig. 48: Spreadsheet with Borders](image)

Use another method to border the cells, as given below:
- Select the cell of the group of cells (Range), on which you want to apply the Border.
- Right Click. A short cut menu appears, as shown in Figure 49.

![Fig. 49: Short Cut Menu](image)
• Choose the option *Format Cells*…
• Choose the tab for *Border* in Figure 50.

**SESSION 17: COLOUR THE CELLS**

**Relevant Knowledge**

The method for *Coloring* cells is similar to that for bordering the cells. Under the *Home* tab, in the *Font* group, there is an option of applying *Colour* to the cells, as shown in 57.
Use the same spreadsheet which you created for bordering the cells. Use the Colour option and apply grey colour to some of the cells, so that it looks like the spreadsheet in Figure 528.

![Fig. 52: Some cells with Colour (Different shades of grey)](image)

You can now use other colors also, to further improve the appearance of the spreadsheet.

![Fig. 53](image)
SESSION 18: MANAGING WORKSHEETS IN A WORKBOOK

**Relevant Knowledge**

When you open a new workbook, it has three *worksheets* as shown in Figure 540. The default names given to them is; *Sheet1, Sheet2*, and *Sheet3*. Each of these worksheets can have data entered in them. When you save the workbook in a file, the complete workbook with all the sheets in it get saved.

![Fig. 54: Workbook with three worksheets](image)

- If you click on *Sheet2* tab, it gets displayed, as shown in Figure 51.

![Fig. 55: Sheet2 displayed](image)

**Renaming a worksheet**

You can change the name of the worksheet, to give it a meaningful name. For example if the name of *Sheet2* is changed to *Attendance*, and name of *Sheet3* is changed to *Marks*, it is more meaningful.
If you double click on the Sheet tab, it becomes dark. Now you can type in the new name. (Note: single click makes the sheet active and double click for renaming).

Add a worksheet

You can add more worksheets in a workbook. Click the symbol, as shown in Figure 57. It adds one sheet. Each time you click it, one sheet gets added.
Remove a worksheet

You can delete (remove) any worksheet from a workbook. Select the worksheet to be deleted by right-click on its name. A short-cut menu pops up. Select the **Delete** option. In the workbook, **Sheet1** has been deleted by following these steps, as shown in Figure 584.

![Fig. 58: Workbook after Sheet1 is removed](image)

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Rename a worksheet</td>
</tr>
<tr>
<td>2.</td>
<td>Add a worksheet</td>
</tr>
<tr>
<td>3.</td>
<td>Remove a worksheet</td>
</tr>
</tbody>
</table>
SESSION 19: PRINT A WORKSHEET

Relevant Knowledge

The method for printing a worksheet is almost similar to the one you used for printing a document in a word processor.

1. Print a worksheet - with default settings

Open any of the workbooks created by you in the earlier exercises.

1. Select the [File → Print]

2. The worksheet will be printed. Do make sure that you have a printer connected to your computer.

Note: To print just a selected portion, select the cells to be printed and then follow step 1.

2. Print a worksheet – Using Page Layout

This above specified method of printing is useful, when the data in the worksheet is not large and can easily fit into one page. In case the file has large amount of data, which will get printed on multiple pages, then you can adjust the Page Layout and Print settings, using the options available in Page Setup under the Page Layout tab in the ribbon.

![Page Layout Ribbon](image)

Fig. 59: Page Layout Ribbon

a) **Margins:** This option allows you to change the margin settings for Top, Bottom, Left and Right Margins in the printed page.
b) **Orientation:** Using this option you can change the orientation of printing between *Portrait* and *Landscape*. In portrait mode, the height of the paper is more than the width.

c) **Size:** This option allows you to change the size of the paper to be used for printing. Most of the normal printing is done using either *A4* or the *Letter* sized paper.

d) **Print Area:** This option is used, when you do not want to print the complete worksheet, but want to print only a part of the worksheet. In this case:
   - First select the *Range* of cells from the worksheet which have to be printed.
   - Select the option *Print Area*. Then Select the option *Set Print Area*.

b) **Page Setup:** The *Page Setup* dialog box (refer Figure 606) can also be opened by clicking on the Dialog Box Launcher symbol on the bottom right hand corner of the *Page Setup* group in the *Page Layout* tab (refer Figure -59). You can then select the appropriate options for setting.

![Page Setup Dialogue Box](image)

**Fig. 60: Page Setup Dialogue Box**
## Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create your class time table using a spreadsheet. Apply borders, appropriate font style, font size, column widths, content alignment, etc. to make it appear attractive. Print this time table.</td>
</tr>
</tbody>
</table>
UNIT 6

Digital Presentation
SESSION 1: INTRODUCTION TO DIGITAL PRESENTATION

Imagine a scenario - you want to make a presentation on a particular topic to your class along with text, images, figures, drawings, etc., - how would you go about doing it? You could have a choice of using a blackboard, posters, whiteboard, pamphlets, chart-paper, hand-outs or overhead transparencies.

Presentations made using presentation software provides an alternative to the older kind of visual aids. Presentation software can be used to present a formal display of information organised onto slides.

By now you would have observed that word processor, spreadsheet and presentation software, have a simple interface using menus on the Ribbon. Most of the commonly used functions have a graphical symbol or icon in the Ribbon. This kind of user interface is called Graphical User Interface. This section will familiarize you with the elements of the user interface.

A digital presentation is a useful method to show or explain a concept to an audience. A presentation program (also called a presentation graphics program) is actually a computer software package used to display information; normally in the form of a slide show. It typically includes three major functions:

1. An editor that allows text to be inserted and formatted
2. A method for inserting and manipulating graphic images
3. A slide-show system to display the content.

Presentations can be used for a variety of tasks. For example:

- Creating slides to display information. Slides may contain text, pictures, shapes, sound and video. A collection of slides is called a presentation.
- Present the information in an attractive manner.
- Show the presentation using a computer, or display it using a data projector or take paper printouts.

Why would you create a presentation vs. using a word processed document? It depends, but typically you would use a presentation under the following circumstances:

- When you want a large group of people to view what you are talking about on a projected screen you would use presentation software. But when you want to share information with a couple of people, you might use a document. In other words, if the material is to be viewed by others in a meeting, you may use presentation...
software. If it is to be viewed by the other readers on a screen or through print, use documents.

- When you want to make the material more interesting with graphics, tables, pictures and other media, you may use presentation software. Word processors have limited multi-media capabilities.
- When you have a lot of information that needs to be written down, use word processor documents. When shorter point-wise information (like a summary) would be sufficient, you may use presentation software.

**Relevant Knowledge**

After having learnt the basics of a word processor and spreadsheet software, you are now familiar with selecting the tabs on the Ribbon and also choosing different options by clicking on the appropriate icon. In this exercise, you will take a short tour of the different tabs and some of the options under the tabs, in presentation software.

![Fig. 1: Graphical User Interface](image)

- The **Tabs** (Home, Insert etc.) on the Ribbon contain the buttons needed to edit characters, text, and layout, as well as additional tools that you may need (Design, Animation etc).
- Each **Tab** consists of different groups, for example the Home tab has six groups namely, Clipboard, Slides, Font, Paragraph, Drawing and Editing.
- Each **group** has Icons for different functions. To know the function of an icon or button (or command), keep the pointer on it for a few seconds and, the function of that button will appear in a small box below the pointer. For example, leaving the icon on **B** displays “Bold (Ctrl+B). It makes the selected text bold.”.
Home Tab

Let’s understand the Home tab in more detail. The Home Tab has commands for formatting of text, selecting a new slide and for drawing of objects. The Home Tab is also used for editing the content of a presentation with functions such as find and replace, cut, copy and paste etc.

The Clipboard group has options to cut, copy and paste text. The Format Painter is also present here.

- **Slides group** enables you to select a theme and layout for a slide, reset a slide or delete a slide.
- **Font group** has options that enable you to change of the Font – font face, style, size, effects (Strikethrough, Shadow etc.), color and character spacing. These options can be changed, before or after typing the text. If case of making changes after entering text, you need to select the text first.
- **Paragraph group** is used to change paragraph settings – alignment, indents, spacing, and pagination like Spacing 1.5, Double Spacing, Indentation, Spacing Before and After a Heading. Move the cursor to the line which needs to be changed.
- **The Drawing group** enables a quick selection from in-built shapes; arranging the order and grouping objects; filling, outlining and adding effects to a selected shape.
- **Editing group** has options to select, find and replace text.

A detailed description of the different options available under each of the groups is given in the table below.

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
</table>
| Clipboard | - **Paste** the cut or copied information in Clipboard at the location where cursor is positioned.  
- Paste Special - To paste in a particular format.  
- Paste as Hyperlink - Used with copy to paste the copied information as a hyperlink.  
- Duplicate – To duplicate a slide).  
- **Cut** removes the selected text from the presentation and puts into Clipboard for later retrieval.  
- **Copy** copies the selected item or text and puts it on the Clipboard.  
- **Format painter** copies formatting from a selected position and applies it to another (Note: To apply same formatting to many places, double-click the format painter button). |
<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
</table>
| Slides  | • Add a *new slide* to the Presentation.  
          • Change the *layout* of the selected slide.  
          • *Reset* the position, size and setting of the slide to default values.  
          • *Delete* the selected slide from the presentation. |
| Font    | • Change Font face, change font size.  
          • Increase Font size, decrease Font size.  
          • *Clear formatting* (Clear all formatting from selection, leave only plain text).  
          • Bold, Italics, Underline.  
          • *Strikethrough* (draw a line through middle of selected text).  
          • *Shadow* adds a shadow behind the selected text.  
          • Adjust the spacing between characters.  
          • *Change case*. Changes the case – sentence, lower, upper, title, or toggle. Select the text and click on an option.  
          • Change the *Font color*. |
| Paragraph | • Bullets (choose from different styles).  
           • Numbered list (choose different formats).  
           • Increase or decrease indent of the paragraph.  
           • Change spacing between lines.  
           • Change the direction of the text to vertical, stacked or rotate the text.  
           • Align the text – change how the text is aligned within the text box.  
           • Align text left, right, centre, margins.  
           • Split text into two or more columns.  
           • Convert text into Smart Art graphics. |
| Drawing | • Insert readymade shapes like circle, rectangles, arrow lines, flowchart etc.  
          • Arrange objects on the slide by changing their order, position and rotation.  
          • Quick styles enable selecting a visual style for the shape or line.  
          • Fill the selected shape with a solid color, gradient, picture or texture.  
          • Specify the color, width, and line style for the outline of the selected shape.  
          • Apply a visual effect to the selected shape like glow, shadow, reflection and 3-D rotation. |
Some of the most popular presentation software are:

- MS-PowerPoint
- Open Office – Impress
- Google Documents

**Getting started with Presentation software:**

To start you can choose any of the above software to start creating presentations. We would encourage you to start learning presentations by using either the OpenOffice – Impress or MS-PowerPoint. Make sure that this software is already installed in your computer.

You can start using MS-PowerPoint software, by performing any one of the following steps:

a) Double Click on a shortcut key of the MS-PowerPoint icon, if available, on the desktop; or


*If you are using any other presentation software, the steps to start it would be almost identical to what is given above.*

After you start the MS-PowerPoint, the following screen (Figure 2) would be displayed. Some of the components of the screen displayed are given below.

*Fig. 2: Components of MS-PowerPoint*
If an OpenOffice-Impress spreadsheet is opened, it looks like the following figure 3. You would notice that the look and feel of the MS-PowerPoint and OpenOffice-Impress presentation software is quite alike. You would also observe the differences in the icons and layout. Most of the presentation software have similar functions and features, with minor differences in the way the tabs, icons, dialogue boxes and functions are arranged.

![Fig. 3: OpenOffice-Impress](image)

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Identify the icons on the user interface and describe their uses</td>
</tr>
<tr>
<td>2</td>
<td>Start digital presentation application</td>
</tr>
</tbody>
</table>

**SESSION 2: CREATE, SAVE AND CLOSE PRESENTATION**

This exercise begins with creating a new file in the presentation software and then saving it. To begin with, let us create a simple presentation. Before creating the presentation, create a folder “D:\IT Class IX\PPT_Practice” where you shall store all the files that you create.
Relevant Knowledge

a) **Open:** Start the presentation. When you start a file with a default name is given by the presentation software. MS-PowerPoint names it *Presentation1*, whereas OpenOffice names it as *Untitled1*.

   a. After starting PowerPoint, you will see a screen with two text boxes.
   b. Enter the text in each of the text boxes, as shown in Figure 1 & 2. This first slide of a presentation referred to as *Title Slide*.
   c. Click on the *New Slide* icon under the *Home* tab, in the *Slides* group. A new slide is added. Enter the text.

   ![My First Presentation](image)

   **Fig. 1: Title Slide**

   ![Exercise -1](image)

   **Exercise -1**
   
   - Open and Save a file
   - Edit a file and save it
   - Add a slide
   - Format a slide

   ![Fig. 2: New Slide with Text Added](image)
Hint: Bullets are available by default. You have learnt to use them while creating documents. Use your knowledge to work with them here. Observe the Ribbon in MS-PowerPoint. Do you see any similarities?

b) Save this file and give it the name First. Follow the same steps as you used for saving a file in word processor or spreadsheet.
   a. Now this file will be saved in MS-PowerPoint with the name First.pptx. The first part is the name of the file and .pptx is the extension name.
   b. Similarly if you are using OpenOffice, the file is saved with the name First.odp. OpenOffice gives an extension name of .odp to a presentation file.

c) Close: Now close this file by one of the following sets of commands:
   a. Click on the cross symbol “X”, that you see on the top right hand corner of the screen.
   OR

d) Open: Now re-open the above file. Add one more slide to it and also add some text in the new slide. Save it with a different name – e.g. Second.

Exercise
Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Open a template to create a new presentation</td>
</tr>
<tr>
<td>2.</td>
<td>Select the design layout and style</td>
</tr>
<tr>
<td>3.</td>
<td>Change the background of the slides</td>
</tr>
<tr>
<td>4.</td>
<td>Enter the text in the title slide</td>
</tr>
<tr>
<td>5.</td>
<td>Add a new slide</td>
</tr>
<tr>
<td>6.</td>
<td>Type the text in the new slide</td>
</tr>
<tr>
<td>7.</td>
<td>Save the presentation</td>
</tr>
</tbody>
</table>
SESSION 3: CREATE A SIMPLE PRESENTATION

Relevant Knowledge

In this exercise you will create a simple presentation, using the default slide design provided by the presentation software.

To make creating slides a simple task, each new slide comes with a pre-formatted template for you to enter your information. You can change this format to suit the type of information you want to display. In the earlier exercises, when you added a new slide in a presentation, it had two boxes, as shown in Figure 1. The box on the top is where you write the title of the slide. In the bigger box, you enter the main content. It is also possible to create a slide, as shown in Figure 2. This has two boxes for writing the content.

The steps to add one more text box in the slide are as follows:

- Click anywhere inside the text box. Eight small rectangles will appear along the edges of the box.

![Fig. 1: Default Text Boxes](image)

![Fig. 2: Two Text Boxes](image)
• Click on the rectangular box, (refer place pointed by the arrow in Figure 3), and drag the side of the box to the left, to reduce the width of the box to approximately half. The slide will look like as shown in Figure 3.

\[\text{Fig. 3: Text Box with reduced width}\]

• Enter one or two words in this text box.

• Select this box. Under the Home tab, in the Clipboard group, select Copy and then Paste. You will see that a duplicate copy of the text box has been created.

• Now select this second (copied) text box, drag it and position it at the appropriate place. Now you can text in each of these two boxes.

• In fact, you can create three of even four text boxes in a slide (Refer Figure 4).

\[\text{Fig. 4: Slide with three Text Boxes}\]
Open a new file using presentation software. Create the following presentation.

- **Manners & Etiquette**
  - Write your name here

- **Meaning of Manners & Etiquette**
  - Rules of General Behaviour, Habits and Customs
  - Enhances your personality
  - Ensures smooth relationships

- **Good Manners & Etiquette: Traits**
  - Disciplined & Decent Outlook
  - Exhibits Humility
  - Shows concern for others
  - Healthy State of Mind & Body
  - Good Grooming
  - Pleasant Personality

- **Disciplined Outlook**
  - Minding one's own business
  - Not to cause hardship to others
  - Maintaining order
  - Maintaining good relationships

- **Humility**
  - Enhances Personality
  - Display of Respect
  - Brings Goodwill

- **Concern for Others**
  - Respect Others
  - Don't hurt their feelings
  - Be grateful to parents, teachers, friends and elders
  - Show kindness

- Save the presentation with the name *Manners*.
- Close the presentation software
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a simple presentation</td>
</tr>
<tr>
<td>2</td>
<td>Create a presentation with text box</td>
</tr>
</tbody>
</table>

SESSION 4: VIEW A PRESENTATION – SLIDE SHOW VIEW

After you have created all the required slides in the presentation, you need to view the slides. You can project the presentation on the full screen of the computer. Your presentation can also be viewed a projection device or an LCD screen if your computer is connected to it.

Relevant Knowledge

There are three primary ways in which you can view the presentation on your computer. The selection of a particular view is based on the purpose for which you want to view the presentation. The three primary views are:

a) **Normal**: You are already familiar with this view. You used this view while creating the slides in the previous exercises. In this view, you can see the Slide pane, notes pane and a left pane having slides / outline tab (refer Figure 1).

b) **Slide Sorter**: This view enables you to easily arrange, move, delete, and reorder slides.

c) **Slide Show**: This view is used to show the presentation to other people, either directly on your computer / computing device or by connecting it with a projector.

In addition to these views, there are some more views, such as *Notes Page, Slide Master, Handout Master, Notes Master, Print Preview* etc. You will learn about some of these in subsequent exercises.

**Slide Show view**

Open the presentation which you had created in the previous exercise (*Manner.pptx*). When you open any presentation, the default view is the *Normal View*. On the right hand bottom of the screen, you will see the icon for slide show.
To show the presentation in a slide show view, follow the steps given below:

1. Open the presentation.
2. Click on the Slide Show icon, positioned in the right hand bottom side of the screen.
3. The current slide is shown the entire screen. You can move to the next slide by clicking your mouse or using the Enter key.
   a. You can also move across slides by using the keys:
      1. Pgup and Pgdn.
      2. Up Arrow and Down Arrow.
      3. Right-click the mouse. A short-cut menu appears which provides further options. Use these options and see what happens.
4. To exit the Slide Show view:
   a. Use the Esc key.
   b. Right-click the mouse. A short-cut menu and select the End Show… option.

The view automatically moves to Normal mode, once you click on the last slide.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>View a presentation using slide show view</td>
</tr>
<tr>
<td>2</td>
<td>Close the presentation</td>
</tr>
</tbody>
</table>
SESSION 5: EDIT TEXT - FONT SIZE, STYLE AND COLOUR

In this exercise you will learn to change and customise the font sizes, style and colour, to make the presentation clear, eye-catching and meaningful.

Relevant Knowledge

Use the presentation you created in Manners.pptx. Change the font colour of the titles of each of the slide, to your favourite colour. To do this:

1. Select the text, whose colour has to be changed.
2. Use the Font Colour option to select the colour.
3. Change a) Colour b) Style and c) Size of the fonts.
4. Save your presentation.

Make this presentation as attractive as you can make by using your creativity.

Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Change the font size of the text</td>
</tr>
<tr>
<td>2.</td>
<td>Change the font style of the text</td>
</tr>
<tr>
<td>3.</td>
<td>Change the colour of the text</td>
</tr>
</tbody>
</table>
SESSION 6: EDIT TEXT IN A PRESENTATION

Relevant Knowledge

In this exercise you will apply some of the options available under the *Home* tab to edit the slides. You need to edit this presentation and make it look like as shown in Figure 1.

---

**Manners & Etiquette**

*Write your name here*

*Exercise-6*

---

**Meaning of Manners & Etiquette**

*Rules of General Behaviour, Habits and Customs*

- That enhances your personality
- That ensures smooth relationships

*Manners Make a Man*

---

**Good Manners & Etiquette**

*Key Traits:*

- Disciplined & Decent Outlook
- Exhibits Humility
- Shows concern for others
- Healthy State of Mind & Body
- Good Grooming
- Pleasant Personality

---

**Disciplined Outlook**

A. Minding one’s own business
B. Not to cause hardship to others
C. Maintaining order
D. Maintaining good relationships

*Success is nothing more than a few simple disciplines, practiced every day.*

---

**Humility**

✓ Enhances Personality
✓ Display of Respect
✓ Brings Goodwill

*Every person that you meet know something you don’t; learn from them*

---

**Concern for Others**

1. Respect Others
2. Don’t hurt their feelings
3. Be grateful to parents, teachers, friends and elders
4. Show kindness

*The good man is the friend of all living things – Gandhi*

---

Fig. 1
You would have used many options from the *Font* and the *Group* options under the *Home* tab.

Hint: You might have had difficulty adding quotations at the bottom of some of slides in the presentation. You can add a *Text Box* under the *Insert* tab, in the slide. You can then add the quotation in this text box which you have added.

![Fig. 2: Icon for inserting a Text Box](image)

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add a text box in a presentation</td>
</tr>
<tr>
<td>2</td>
<td>Enter text in the text box</td>
</tr>
<tr>
<td>3</td>
<td>Edit the text in the presentation</td>
</tr>
<tr>
<td>4.</td>
<td>Save and close the presentation</td>
</tr>
</tbody>
</table>

**SESSION 7: INSERT IMAGE IN A PRESENTATION**

**Relevant Knowledge**

It is said that “*A Picture speaks louder than a thousand words*”. Presentations can be enhanced substantially by adding images and pictures in it. In this exercise you will learn to add a picture in a slide. You will search for the picture from the internet and insert it in a slide.

- Open a new presentation file.
- Create the 2 slides as shown in Figure 11 & 2 and enter the text.
- Open any *Web Browser*. Search for an image of “Stephen Covey”. (*He is the author of the book “Seven habits of highly effective people”)
Copy any of the images of Stephen Covey. (Hint: This you can do by right clicking on the image and selecting the option Copy Image in the short-cut menu that appears.)

Go to Slide-2 in the file where you had entered the text.

In the Home tab, under the Clipboard group, select the option Paste.

The picture will get pasted on to the slide.

Re-size the picture. (Hint: Click on the picture. You will see small rectangular boxes on the edges of the picture. Click on any one of these boxes. Cursor shape changes to that of an arrow. Drag that box by left-clicking the mouse and keeping it pressed).

Re-size and position the picture properly on the slide.
For moving the image on your slide, keep the cursor in the middle of the image. The cursor shape turns into a plus symbol with four arrow head

- Drag the image by keeping the left button of the mouse pressed.
- Save the presentation file.

Create the slides shown in Figure 3. Insert at least two relevant pictures in each of the above slides. Re-size and position them appropriately to get the best output.

1. You may also like to use your creativity to make the slides look attractive, by changing the font size, font colours, or any other feature of the presentation software.
2. Save the file.
There is one more way to insert an image into a slide. Using this method you can insert and image or a photo stored in your computer. So go ahead, open a new file, locate some photos stored in your computer and insert it in a slide using the following steps:

- In the Insert tab, choose the option Picture.
- A dialogue box will appear. Select the folder in which this picture file is stored, select the file and click on it to insert it.
- Now you can re-size and position it appropriately.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Insert image in a presentation</td>
</tr>
<tr>
<td>2</td>
<td>Resize and rotate the image</td>
</tr>
</tbody>
</table>

**SESSION 8: ADD SHAPES IN A PRESENTATION**

**Relevant Knowledge**

Slides in a presentation can be enhanced by adding Shapes. There are many shapes available as a part of the presentation software. In this exercise, you will add a shape as shown in the slide in Figure 1.
- Open a new presentation file. Add a slide. Enter the text shown in the slide above.
- Under the Insert tab, in the Illustrations group, select the option for Shapes. (Refer Figure 2).
- A drop down list appears, as shown in Figure 3. Choose the appropriate shape (a cloud callout was selected in the figure above). In case the shape shown the slide is not available in the software you are using, select any other similar shape.
- The cursor changes to a + symbol when you move it on the slide. Left-click and drag the cursor and then, when you have the desired size, release the mouse button. The shape selected shape is created.
- Adjust the size of the shape added.
- You can enter the text “Do you know the origin of the term “Computer Bug”?” in this shape. To add the text:
Keep the cursor on the created shape. The shape of the cursor changes to a four headed arrow.

- Right-click and choose the option *Edit Text*.
- You can now write the above text.

- To format this shape, i.e. changing its colour, outlines etc., do the following:
  - Select the shape.
  - A *Format* tab will appear in the Ribbon. Some of the options in the *format* tab are as shown in Figure 4. Use these options to change the colour of the shape, its outline etc.
Shapes can be used to create diagrams in a presentation. In this exercise you will create a simple flow diagram using different kinds of shapes as shown in Figure 5.

**Input-Process-Output Concept**
- The concept of generating output information from the input data

```
Input → Process → Output
```

- **Storage**: Stores input data, instructions and output; permanently on disk

---

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create 6-7 slide presentation in any one of the following areas.</td>
</tr>
<tr>
<td></td>
<td>- A tourist place</td>
</tr>
<tr>
<td></td>
<td>- Your family</td>
</tr>
<tr>
<td></td>
<td>- Your favourite teacher</td>
</tr>
<tr>
<td></td>
<td>- Your favourite leader</td>
</tr>
<tr>
<td></td>
<td>- Your favourite actor / actress</td>
</tr>
<tr>
<td></td>
<td>- A country</td>
</tr>
</tbody>
</table>
SESSION 9: PRESENTATION THEMES

Presentation software helps in preparing attractive colourful presentations. When you open a new file in presentation software, the default design is simple black and white. It is possible to have different designs in a presentation. Most of the presentation software offer, pre-defined designs called Presentation Themes. You can use these to enhance presentations. They have different backgrounds, colours, designs and font types. Using a different “theme” can significantly change the way the presentation looks. Some examples of such Themes available in presentation software are shown in Figure 1.

Fig. 1: Different Themes
You can select an existing theme, by:

- The options: File, New. A box with various existing designs appears as shown in Figure 2.
- Select the option Themes. Another box opens, which has the existing themes. Select one of them.
- The blank file with the selected theme will open.
- You can use this file to create the presentation.

Use this file with the Theme selected by you and create a presentation with a title slide and four more slides, using the text given below.

<table>
<thead>
<tr>
<th>GREETINGS</th>
</tr>
</thead>
<tbody>
<tr>
<td>Every interaction starts with some form of greeting. Given below are some statements we generally make whenever we greet someone.</td>
</tr>
</tbody>
</table>

**Greeting a friend:**
- Hi! How are you doing?
- Hey! It has been a long time since we last met!
- Hi! What are you doing now?
- Hey! How’s life?

**Greeting an acquaintance:**
- Hello! How are you?
- Hello! How have you been?
- Good morning/afternoon/evening! All’s well?

**Greeting a stranger:**
- Hello!

Insert some appropriate pictures and/or shapes in the above presentation.

Open an existing presentation, which you made in one of the earlier exercises. Change the Theme of this presentation. You need to select the Design tab. You will see different themes available, as shown in Figure 3. You can select any one of them. Try applying different themes to the same presentation. Save the presentation.
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select theme and prepare a presentation</td>
</tr>
</tbody>
</table>

SESSION 10: CHANGE DESIGN OF A PRESENTATION

*Themes* are an inbuilt part of the presentation software. You can also make changes in the design of the presentation by using other features available in the presentation software. In this exercise, you will learn to make basic design and visual changes to the presentation that you made earlier. In fact, you can pick up any of the presentations which you have in the earlier exercises for doing this exercise.

Relevant Knowledge

The options for changing the design of a presentation are available in the *Design* tab. We will use the option *Themes* and *Background* groups.

- Format Background:
- Select the option *Background Styles*.
- A dialogue box appears.

![Fig. 1](image-url)
Click the option *Format Background*. A dialogue box as appears.

![Dialogue Box](image)
Information Technology – Class IX

• Select the options Fill → Solid fill → Colour (Click the down arrow and a color box appears.).
• Select the desired colour and select the option Apply All.
• All the slides in this presentation will get the selected background colour.
• Try changing the colour of the background to another colour.
• Also try out the option Transparency and observe what happens.
• Now try out the other options of Solid Fill, Gradient Fill, Picture Fill, and Pattern Fill. Observe what changes occur in the presentation.
• Click on Close to close this dialog box, or click on the “X” symbol.

Exercise
Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open a presentation and change the design of presentation</td>
</tr>
</tbody>
</table>

SESSION 11: ARRANGE, DELETE AND ADD SLIDES

Relevant Knowledge
So far you have learnt to view a presentation using the Slide Show view. Another view that is frequently used in presentations is the Slide Sorter view. Slide sorter view in MS-PowerPoint or OpenOffice-Impress is a window that displays thumbnail versions (small size) of all your slides, arranged in horizontal rows. This view is helpful when you want to:

• Make global changes to several slides at one time.
• Rearranging or deleting slides.
• Move, copy, or delete a lot of slides

However, there is a limitation that you cannot edit the contents of a slide in this view. To edit the contents of a slide you can use the Normal view. In Slide Sorter view, a presentation looks like the one in Figure 1.
Fig. 1: Slide Sorter View

- To see the slides in a Slide sorter view, under the View tab in the ribbon, select the option Slide Sorter.

Fig. 2: Slide Sorter Icon

- To add a slide in Slide Sorter view:
  - Position the cursor between the two slides, where you want to add the blank slide
  - Under Home tab, in the Slides group, select the New Slide option.

Note: If you position the cursor between slide 3 and 4 in the above presentation, a blank slide will be inserted after slide 3.

- To delete a slide in Slide Sorter view:
  - Select the slide to be deleted.
  - Press the Delete key on your keyboard or select the option under the Home tab, Clipboard group.
• The selected slide will be deleted.

• To move a slide in this view:

• Select the slide to be moved, and drag it with the left button of the mouse pressed, to the place, where you want to move the slide.

• You can also select multiple slides by using the combination of Shift key (for slides adjacent to one another) or Ctrl key (for slides at different positions in the presentations) and the left button of mouse.

• Try selecting multiple slides and deleting them together.

• Try selecting three slides and then moving them together into another place.

Exercise
Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Rearrange the slides using slide sorter</td>
</tr>
<tr>
<td>2</td>
<td>Add slides in between the slides</td>
</tr>
<tr>
<td>3</td>
<td>Delete the unwanted slides</td>
</tr>
<tr>
<td>4.</td>
<td>Move a slide</td>
</tr>
</tbody>
</table>

SESSION 12: PRINT A PRESENTATION

Relevant Knowledge

Normally a presentation is made for showing it on a computer or data projector to a big audience. Many presenters also provide a print copy of the presentation. In this exercise you will learn to print a presentation. The basic steps to print a presentation are quite similar to what you followed for printing text documents and Spreadsheets. These are:

• Click [1] File → [2] Print. A Print dialog box appears as shown in Figure 1.

• In the Copies box, enter the number of copies you want to print.

• In the Name box, select the printer that you want to use.

• To print all slides, select All in the Print Range.
• To print one or more slides that you selected, select *Selection*.
• To print only the slide that is currently displayed, select *Current Slide*.
• To print specific slides by number, click *Slides*, and then enter a list of individual slides, a range, or both. Use commas to separate the numbers and no spaces, for example, 1, 3, 5-12.

→ If you select *Handouts* in the *Print what* box, you can choose, how many slides you want to print on a page and click *OK*. 

![Print dialogue box](image)

**Fig. 1: Print dialogue box**

### Exercise

Perform the following activities till you are confident:
### Information Technology – Class IX

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create a “Birthday” card for your friend or brother or sister or teacher</td>
</tr>
<tr>
<td>2.</td>
<td>Design a poster on any one of the following topics:</td>
</tr>
<tr>
<td></td>
<td>• Invite all students of your school to the Computer Festival.</td>
</tr>
<tr>
<td></td>
<td>• Invite all students of class 11-12 for a blood donation camp.</td>
</tr>
<tr>
<td></td>
<td>• Inviting all students of your class to a picnic.</td>
</tr>
<tr>
<td></td>
<td>• Inviting all students for the Annual Sports day of your school.</td>
</tr>
<tr>
<td>3.</td>
<td>Print a handout of the presentation with 2, 4, 6 slides on a page</td>
</tr>
</tbody>
</table>
UNIT 7:

Email Messaging
SESSION 1: INTRODUCTION TO E-MAIL

In this session, you will be introduced to the concept of email and the steps to create an online email account.

Relevant Knowledge

Electronic mail (E-mail) is an electronic message transmitted over internet/computer network from one user to another. E-mail is a text based mail consisting of lines of text, and can include file attachments. These attachments could be pictures, documents, spreadsheets, audio files, video files etc. The key features of e-mail are as follows:

- E-mail can be sent to one person or more than one person at the same time.
- The recipient of e-mail can open the e-mail at his/her convenience.
- Since messages are transmitted electronically over internet, it is a faster way to communicate with the people. Persons could be located in the same office, home, building, or anywhere in the world.
- E-mail messages can be sent or received at any time and are typically sent over a network (office network or more likely internet).
- If so desired, a copy of the e-mail message that the sender has sent can be saved in the sender’s computer e-mail account for later reference.
- In addition to sending messages, e-mail is an ideal method for sending documents as attachments.
- E-mail has quite a few similarities as a regular postal service.
  - A postal letter is sent to a postal address. An e-mail is sent to an e-mail address. E-mail address is much shorter.
  - Just as in the case of a postal letter, the sender of e-mail composes the message and sends it to the e-mail address of the recipient.
  - The postal letter is normally put by the postman in the letter box outside the house. Similarly an e-mail is received by the recipient in the inbox of the e-mail application.
  - While postal letter travels from the sender’s post office via a postal bus / train / air / postman, the e-mail message travels electronically over the internet and computer network.
- The recipient of e-mail can read the mail, forward it to another person, or reply back. The recipient can also store the e-mail of delete it.
**E-mail Address:**

To use an e-mail, a user must have an e-mail address. The e-mail address contains all the information required to send or receive a message from anywhere in the world. An e-mail address consists of two parts separated by @ symbol (spelled as at) – the first part is the user name and the second part is host computer name. The e-mail address might look like:

- Ram962@gmail.com
- Preetha1a2b@outlook.com
- Sudipta123@yahoo.co.in

**E-mail Services:**

There are two kinds of e-mail services:

- **Application based e-mail** is installed on the user’s computer. The mail is stored on the user’s computer (as well as a central server, typically for that specific organization). Some of the examples of application based e-mail program are:
  - Microsoft Outlook
  - Mozilla Thunderbird
  - Opera
  - Foxmail etc.

  The user must have an e-mail account either from an internet service provider (ISP) or through one of the free e-mail service providers on the internet.

- **Web-based e-mail** can be accessed by the user from any Internet-connected computer anywhere in the world. Web-based email is not stored on the user’s computer. Many web-based e-mail services are available such as gmail.com, outlook.com, yahoo.com etc.

**E-mail Message Format:**

The e-mail message format in any e-mail software, whether application based or web based, has many common elements. Their arrangement on the user’s computer screen may have a different look and feel, but the purpose of each of these elements is same.
**Information Technology – Class IX**

- **From:** Sender’s email address
- **To:** Recipients’ email address
- **Date:** When the email was sent
- **Subject:** The topic of the message
- **Cc:** E-mail addresses of other people, who have been sent a copy of the email. The recipients of the email can see all of the e-mail addressed to which the copies have been sent. *(Note: The full form of CC is “Carbon Copy”)*
- **Bcc:** E-mail addresses of other people, who have been sent **blind carbon copies** of the email. The recipients of the email (in To and Cc) do not know that the same email has been sent to other e-mail address in Bcc.
- **Message body** The body consists of the text of the message and any attachments to be sent.

Some examples of the **message format** of commonly used email applications are given in Figure 1.

![Email Application Screenshots]

**Fig. 1**
SESSION 2: CREATING AN E-MAIL ACCOUNT WITH GMAIL.COM

Before you start using email, an email address is required. In this session you will learn to create an email address using Gmail. In the next session, you will learn to create an email account using Outlook. This would also help you understand the similarities and minor differences in different e-mail applications.

Relevant Knowledge

- To create your Gmail account you only need a web browser and an internet connection.
- Open the Web Browser.
- On the address bar type www.gmail.com. You should now get to a page that looks something like the one in Figure 1.

![Fig. 1](image)

- Click on Create Account and then proceed to the next step.
- After you click on the signup link, you shall be shown a form with several fields which need inputs. This is shown in Figure 2.
Fig. 2

- Choose a login name or username: Choosing a login name is part art and part common sense. Since it determines what your email address will be, we suggest you spend a little time over it. Email addresses need to be unique which means that no two people in the world can have the same address. There is no guarantee that your preferred login name would be available. The following are advice and suggestions on how to choose a login or username.
  - First check if you can get a login name of your name, first name, last name, or first name + last name. E.g. Shalini or dalal or shalinidalal or the more popular, firstname.lastname (e.g. shalini.dalal or dalal.shalini). Getting a Gmail email address of your name is indeed very fortunate because of the sheer number of subscribers to the service. Your login name needs to be catchy and at the same time describe you so people are able to recall it without much difficulty and associate it with you.
  - You can also opt to choose your first name and your birth date: for e.g. vicky15.
  - When you move the cursor to the next input field Password, in case the username is not available, a message is displayed. This is shown in Figure. You can go back to username field and change it.
• **Choosing a password for your email:** Securing your Gmail email account with a strong password is important. Think of the password as the key combination to your safe and give it the same amount of importance. A combination of uppercase and lowercase letters with some digits would be a strong enough password. *You need to enter the password twice.* You can leave the “Remember me on this computer” box unchecked.

• Enter your *birthday* and *gender* (Male / Female).

• *Current email address:* In case you already have an existing email address, you can enter that here, or leave this blank.

• *Prove you are not a robot:* Enter the characters displayed in the picture, above the field. This is required so that Gmail knows that the inputs are from a human being and not some automated program.

• Now that everything is set, you can go through the Terms of Service and click on the "I accept. Create my account." button which will create your very own free Gmail account!

• Click *Next.* You will be asked to *Add a profile photo.* You can for the time being skip this and select *Next Step.*

• Your Gmail account is now ready and the inbox will open as shown in Figure

• Note the email address and password in a secure place.
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open an email account with gmail</td>
</tr>
</tbody>
</table>

SESSION 3: CREATING AN E-MAIL ACCOUNT WITH OUTLOOK.COM

In the previous exercise you created an email account using Gmail. In this exercise you will learn to create an email account with Outlook. The steps are almost similar and even a little simpler.

Relevant Knowledge

- To create your Outlook account you only need a web browser and an internet connection. On the address bar of your browser type www.outlook.com. You will see a page that looks like the one shown in Figure 1.
- Choose the option “Sign up” (refer arrow in Figure 1).
After you click on the signup link, a form is displayed. It has several fields that need to be filled (refer Figure 2). Provide all the inputs and click on "I accept".

If all the inputs were provided correctly, the inbox of the outlook.com email will open. It looks like the one in Figure 3.
You have learnt to create an email addresses using two different free email providers on internet. Note that the details requested and the verification too is more or less the same. You can use any one of these email addresses for the exercises which follow.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open an email account with outlook</td>
</tr>
</tbody>
</table>

**SESSION 4: LINK EMAIL ADDRESS TO EMAIL APPLICATION**

In Figure 1 and 2, you created email address by using two different web based email applications. When you use web based email applications, you need to be connected to the internet, as all your emails and related data is stored on the computers of the email providers. It is not stored on your computer.

In rest of the sessions, you will use an application based email software, just like the way you used the word processing, spreadsheet and presentation software.

**Relevant Knowledge**

There are many email software available such as Microsoft Outlook, Mozilla Thunderbird, Opera, Foxmail etc. You need to have one of them installed on your computer. You can use these packages even if you aren’t connected to the network or internet, although the e-mail messages can be received or sent only when this internet connection is available. As an example this exercise uses MS-Outlook to help you learn to use email application software.

**Getting started with Email software:**

To start you can choose any of the above software. We would encourage you to start learning to email by using either the MS-Outlook or Mozilla Thunderbird. Make sure that this software is already installed in your computer. You can start using MS-Outlook software, by performing any one of the following steps:

a) Double Click on a shortcut key of the MS-Outlook icon, if available, on the desktop; or

If you are using any other email application software, the steps to start it would be almost identical to these.

Once you start MS-Outlook, you will see a screen as shown in Figure 1. Some of the components of the screen displayed are given below. The look may vary in different email software or different versions of MS-Outlook.

Fig. 1

Adding email address to the email software:

To start using email, you need to specify the email address (which you had created in previous exercises), to the software. The steps are as follows:


• The dialogue box shown in Figure 2 appears. Enter your name, email address, and password which you had given while creating the email account. Click on Next.

Fig. 2
- The dialogue box in Figure 3 appears. The email application connects with your email service provider. If the details entered are correct, it adds the email address to the email software. (Note: Please note that the computer needs to be connected to internet, while performing this step).

![Fig. 3](image-url)

- Now you are ready to start sending and receiving emails using this email software. At this stage the Figure 4.

![Fig. 4](image-url)
Exercise
Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add email address to email software</td>
</tr>
</tbody>
</table>

SESSION 5: WRITING AN EMAIL MESSAGE
You are now ready to start using email.

Relevant Knowledge
Start the email software on your computer (You learnt the steps in the previous exercise). Your screen will look similar to what is given in Figure 1.

Fig. 1

- Select the option New e-mail. A blank email screen will open. You can use this to write an email, as shown in Figure 2.

Fig. 2
Information Technology – Class IX

Components of the email screen are as follows:

- **“To”**: Write the email address of the person you want to send the email to.
- **“Subject”**: Write the topic or subject of the email here. Write the main message of the email in the message box.
- **“Send”**: Once you have completed writing the email, post the mail by clicking this button.

First the mail goes into the **Outbox** of email software. If you are connected to internet, the email is sent from the **Outbox** to the recipient, through the internet. The recipient would be able to read the email, when she / he opens the **inbox** of her email software and downloads all the emails. The recipient needs to be connected to internet to send / receive emails.

**TIPS FOR WRITING AN EFFECTIVE E-MAIL MESSAGE**

1. Since most e-mail programs have a —spam filter ||, make sure that the **Subject** of e-mail is **not just one word** such as —Thanks || or —Hello || as these are likely to find their way in the Spam Folder instead of the Inbox. The subject line should be meaningful, alerting the receiver of the message contained in the email.

2. Keep the message **short, simple, and straightforward**. Assume that the reader will not have the patience to go through a long message. Get to the point immediately.

3. **Do not use short forms** or SMS language (plz cud v meet dis Monday) in e-mail messages. Also, **do not use all CAPS** — in an e-mail, using all capitals is equivalent to shouting at someone!

4. For addressing the recipient, use the same formats as suggested in the sections on formal and informal letters. Dear Sir/Madam is acceptable in formal e-mails to people whose names are unknown. In informal emails, it is always better to use the first name of the person in your greeting.

5. Make sure you can be clearly identified by the reader. If you think the reader may not be able to identify you by your email address (for example, if you have an e-mail such as ms2012@gmail.com) make sure that you provide your full name (and even your location) at the bottom of the e-mail.

6. **Proofread!** Remember that once you press the —Send || button, the e-mail’s out of your hands! So before you go for this button, make sure that you have read your mail very carefully and have corrected any errors in it.

7. Distinguish between formal and informal situations. Between friends, it is okay to take a few liberties such as using —emoticons || or smileys such as 😊 or 😊. But in
a formal mail, you have to stick to the rules as we defined in the section on formal letters.

8. Politeness counts! Using —please ||, —thank youb ||, and polite expressions such as —May I please request you…|| is always helpful.

9. Be careful while using —cc ||. Add cc recipients only when you want your main recipient to know that others will also get a copy of the mail. If you want to send the same message to more than one person, it is best to put all the e-mail addresses in the —To: || line rather than in the —cc || line.

10. To end, you can use any of the following:
   - Best regards,
   - Regards,
   - Best wishes,
   —Yours sincerely || or —Yours faithfully || is not so common in e-mails, though accepted in letters.

Exercise
Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Write an email message</td>
</tr>
</tbody>
</table>

SESSION 6: RECEIVE AND RESPOND TO EMAIL MESSAGES

Relevant Knowledge
When you receive an email, you can take one or more of the following actions:
   - Read and close it. The email remains in the inbox.
   - Read and Delete it. The email is deleted from the inbox and is moved into a folder called Trash or Deleted folder.
   - Reply to the email, by choosing the Reply option. In this case, the email address of the sender, will automatically appear in the “To” field. You can write the email message and then send the email.
   - Reply All: In this case, the reply you send will go to the sender and all email addresses present in the To and the Cc field of the email received by you.
Information Technology – Class IX

- Forward: In this case, no email address will be selected. You can enter the email address to which you want to forward the email received by you.

![Email Ribbon](image)

- Go ahead and send at least 2-3 emails to your other classmates. Ask 2-3 of them to send you an email. And then use one or more of the above options. More you practice, more you will learn. Remember the old proverb, “Practice makes a man perfect.”

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Open the inbox and read the email messages</td>
</tr>
</tbody>
</table>

**SESSION 7: USING EMAIL RIBBON**

You have already become quite familiar with some of the common options on the email ribbon by now. This session will cover some commonly used options in email.

**Relevant Knowledge**

- Home Tab:
  - New Items: Using email software you also store Contacts (Address book), appointments, Tasks etc. This option is used for creating these items.
  - Delete: You can select an email and delete it by clicking on this option.
Unread / Read: New emails in the inbox have a bold font. Once you have opened the email, the font becomes normal. Using this option you can mark a read (normal font) email as unread (bold). Similarly an unread email can be marked as read email.

Some of the options for reply and forward have already been used by you. We will learn about the other options at a later stage.

View Tab:
- There are many options under this tab. At this stage, try out the three options given in Figure 2. Observe and see what each of them does.

The rest of the Tabs and options, are not being discussed here. You will learn about some of these in later stages.

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Identify home and view tab options</td>
</tr>
<tr>
<td>2</td>
<td>Demonstrate the use of home and view tabs</td>
</tr>
</tbody>
</table>
SESSION 8: FORMAT AND SPELL CHECK AN EMAIL MESSAGE

Email software has basic features for text formatting, spelling checks and grammar checks. You are already familiar with these features, and have used them while learning word processing and spreadsheets.

**Relevant Knowledge**

1. **Format an e-mail message:**

You would find the basic text formatting options in the ribbon. As seen in the adjacent figure, the icons for the format options are almost similar to that in a word processor.

![Format Options](image)

**Fig. 1: Format Options**

- Compose an email message and then use these options to format the message. A sample message to use is given below. However, you can create your own message.

```
Dear Didi,
Today in our English class, we learnt how to greet a stranger. I am sharing some of the questions, we can use while greeting a stranger.

**Greeting a stranger:**
- Hello!
- Good morning/afternoon/evening!
- How do you do?
- My name is Aarti. May I know your name?

*I am going to practice using these greetings with at least two strangers every day. I will do this for a full month. I will also share my experience with you at the end of the month.*

I hope you get good food in your hostel mess.

With love,
Shalini
```
2. Spell check an e-mail message:

The icon for spell check and grammar check is on the main ribbon or on Review tab, based on the email software you are using. The steps to perform this activity are exactly the same as you used in word processing.

- Compose an email message. Make sure that you deliberately make some spelling errors and some grammatical errors in this message. Then click on the icon for *Spelling & Grammar*, to correct the mistakes.
- A sample email message is given in Figure 2. You can write a message of your own also.

![Fig. 2](image)

- In case the grammar check is not done, the email software which you are using may require you to check the box for *Check Grammar*. This is shown in Figure 3 below.

![Fig. 3](image)
Exercise
Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S.No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Align the text in the email message using format options</td>
</tr>
<tr>
<td>2</td>
<td>Bold, underline and italicize the text</td>
</tr>
<tr>
<td>3</td>
<td>Check and correct the spelling errors using spell check</td>
</tr>
</tbody>
</table>

SESSION 9: ATTACH A FILE TO EMAIL MESSAGE

When you send a letter in a postal envelope along with the covering letter, necessary paper documents can also be stapled or attached with a paper clip. Similarly, in an electronic mail along with the email message, you can attach one or many files. When you send the email, the file goes along with it. The recipient can read the message and also the attached file.

Almost any type of file can be sent via email; videos, music, pictures, presentations and documents etc. However, some restrictions are placed on attachments, such as a file size and permissible file extensions.

Relevant Knowledge

1. Sending Attachments
   - In this exercise you will learn to send a file stored in your computer to a class mate, using email.
     1. Compose a new email message.
     2. Write the main message in the email, along with a relevant subject. An example is given in Figure 1.
3. Click on the button **Attach**, as shown in Figure 2. A dialogue box for selecting files appears. Browse to the location of the file you want to attach. This could be any file on your computer; it need not be the one shown in Figure 2.
4. Double the click on the file name or select the file. You can select more than one file to be attached by keeping the Ctrl key pressed and clicking on the files. Click Open. The selected files get attached to the email. (refer Figure 3)

![Fig. 3](image1)

You may have noticed that the design of Ribbon in Figure 1, Figure 2 and 3 is different from what you are familiar with. These figures are from Mozilla Thunderbird software. An equivalent of Figure in MS-Outlook is shown in F.

![Fig. 4](image2)

Note: The basic principle on which these two e-mail software operate is the same. The difference is only in the GUI appearance. Once you have used and are familiar with a particular software, you can use any of its alternatives available in the market.
2. Receiving Attachments

- The icon in the inbox (generally the sign of a paperclip) or within the message, tells you that there is an attachment along with the message. (Refer Figure 5.)
- You can *Open* the attachment by clicking on it.

As. Then select the Figure 5 appropriate folder location to save the file.

![Fig. 5](image)

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Attach a file to email message</td>
</tr>
<tr>
<td>2</td>
<td>Download attachment and save file(s) in a file with an appropriate name</td>
</tr>
<tr>
<td>3</td>
<td>View the document</td>
</tr>
</tbody>
</table>

**SESSION 10: USING HELP**

While working on email software, you may want to know, how to perform a specific task. Most of the GUI software provides a *Help* feature. So you do not have to open a book but can find help readily available.
Relevant Knowledge

- To start using Help in an email software:
  - In MS-Outlook, press F1 or click the symbol 🎨, type your question in the search box (refer arrow in Figure 1), and then press Enter.
  - In Mozilla Thunderbird, press F1 or Help icon on the ribbon.
  - A dialogue box appears. Enter the key words related to the task, for which you need help. For example:
    - If you want to find, how to attach a file, you can enter: "Attach File"
    - If you want to find, how to delete an email message, you can enter: "email delete".

![Outlook Help](image-url)
• As an exercise, enter the keywords: —Attach file ▶ in the search box of MS-Outlook (refer arrow in Figure 1.).

Fig. 1

• A list of all online topics that refer to the keyword you entered is displayed. (Refer Figure 2.)

Fig. 2
Click on the appropriate topic.
The topic page will appear and you will find the step by step instructions for performing that task. (Refer the help box in Figure 3.)

Note: Online is a great resource, but sometimes you are not connected to the Internet and need Help. When you are offline, the software searches your local Help files and displays the search results that it finds there. When you search offline Help, additional online content is not available.

- You can use the scroll bar on right to read the entire content in the window.
- You can also click on the maximise button to increase the size of the help box.

Now practice the use of Help feature by finding instructions for the following tasks:

- Sending BCC
- Formatting email
- Print an email message

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Use the various features of help by entering appropriate key word</td>
</tr>
</tbody>
</table>
SESSION 11: PRINT EMAIL MESSAGE

You can easily print an email message received by you. The steps to print an email are similar to those used for printing a document or a spreadsheet.

Relevant Knowledge

You will now print an email message received by you.

1. Open the email message, which you want to print.
2. Click [1] **File** → [2] **Print**
3. Select the printer, to print the email message.
4. Click **Print**

The email will be printed on the selected printer. It may look like the following in Figure 2.
In the exercise, we used the default (Standard) settings while printing the email. Print dialog box (Refer Figure 33) also provides options for print settings. For example, you can choose to print 5 copies of the same email.

Go ahead and use some of the print options, to become familiar with them.

Figure 3

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Print the email message using different style and options</td>
</tr>
</tbody>
</table>

**SESSION 12: ADDING AND MODIFYING A CONTACT**

You can also maintain an address book of people using email software. The address book may contain information like name, name of the company, designation, email address,
Information Technology – Class IX

phone number, mobile number, residential address, office address, website URL, birthday, marriage anniversary etc. In some email applications like MS-Outlook, it is called Contact; and in some others it is called Address.

Relevant Knowledge

1. Add a Contact

The steps to add a Contact in MS-Outlook are as follows:

- Under Home tab, choose the option New items. Then select Contact. A blank form appears (Figure 1), in which you can input the details. It is not necessary to fill all the fields.

After adding the details, click on to save and close the form. The contact is saved along with the information added.
Add contacts for one friend and one relative of yours. Do not forget to add one more contact with your own details.

2. **Modify an existing Contact**

The steps to modify a Contact in MS-Outlook are as follows:

- Suppose that you have an existing contact of Vibha Das.
- Under the Home tab, you will see icons as shown in Figure 2.

![Fig. 2](image)

- Enter the name —Vibha Das— in the search box, as shown, and click Enter key. A contact form with the existing details of Vibha Das will appear (refer figure 3).

![Fig. 3](image)

- You can change/edit any of the existing information or add information in the blank fields.
- **Save and Close** the contact.
3. Add and Modify a contact using Mozilla Thunderbird

Adding or modifying a contact using Mozilla Thunderbird follows the same basic steps. The icons and their names are slightly different.

- To add a new address, click Address Book, as shown in Figure below.

  ![Fig. 4](image_url)

- The Address Book form has a different format, but has similar fields as in MS-Outlook. (Refer Figure 4)
- To save the entered information, select Ok.
- To search for an existing contact, enter the name in the field shown in Figure 5.

  ![Fig. 5](image_url)

**Exercise**

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Add a contact to the contact list or address book</td>
</tr>
<tr>
<td>2</td>
<td>Modify the contact</td>
</tr>
<tr>
<td>3</td>
<td>Delete a contact</td>
</tr>
</tbody>
</table>
SESSION 13: USING FOLDERS TO ORGANISE EMAIL MESSAGES

In a manual system, people use different files to organise the letters received or sent by them. In a similar manner, email messages can be arranged for easy access by using Folders. A Folder is like a file in which related email messages can be stored.

Relevant Knowledge

In an email application, some default folders are automatically created, when an email account is linked to it. In Figure 1, you can see the existing default folders.

- **Inbox** contains the email messages which you receive. It is an electronic version of a letter box.
- **Trash** folder stores the email messages which have been deleted.
- **Sent Mail** folder contains the email messages sent by you to others.

You can also create a new folder.

1. **Create a folder**

   - Suppose you want to create a folder in which you want to keep all the emails received by you from your father. You may want to give the name —Father || to this folder.
1. On the Folder tab, in the New group, click New Folder.
2. A dialogue box appears (refer Figure 2).
3. Select the folder, under which you want to create this sub-folder.
4. In the Name box, enter a name for the folder.
5. A new folder is created called —Father || (refer Figure ).
2. Move an email to from Inbox to another folder

You can now move any email message, which you want to file in the folder—Father ||.

- Select the email (from the Inbox) that you want to move. (4)
- Left Click on it, and drag it to the folder —Father ||.

![Fig. 4](image)

- Release the left button of the mouse. The email will move from the Inbox to the folder Father.
- To verify, click on the folder Father. (Figure 5)

Note: Using the same steps it is possible to move emails from one folder to another.

![Fig. 5](image)

Additional tasks to manage folders

- You can create more than one folder.
- You can delete an existing folder, by right clicking it and choosing the option Delete Folder. It deletes the folder and its contents and moves them to the — Deleted Folder ||.
  
  Note: You cannot delete any of the Default Folders.
- You can rename a folder by right clicking it and modifying the existing name.
Exercise

Perform the following activities till you are confident:

<table>
<thead>
<tr>
<th>S. No.</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create and name a folder for sorting the mails</td>
</tr>
<tr>
<td>2</td>
<td>Move the folder</td>
</tr>
<tr>
<td>3</td>
<td>Move the messages to the folder</td>
</tr>
<tr>
<td>4</td>
<td>Rename the folders</td>
</tr>
<tr>
<td>5</td>
<td>Delete the folders</td>
</tr>
</tbody>
</table>